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Chapter 1
Routing Features

The Mentor PCB layout products provide a variety of routing capabilities that allow you to 
route the nets in a design. 

Routing Capabilities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Interactive Routing vs Autorouting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Comparison of Routing Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Strategies for Routing PCB Designs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Routing Capabilities
This section describes the major trace routing capabilities and other interconnect features that 
are available in the Mentor PCB layout products. 

Table 1-1. Routing Capabilities of Mentor PCB Layout Products 

Feature Description

Routing fanouts and 
escapes

The system automatically generates via fanout patterns 
and escape routing for BGAs and other high-density pin 
arrays.

For more information, refer to “Editing Predefined 
Fanouts in a Package Cell” on page 42.

Creating planes The designer interactively creates power and ground 
planes, and optimizes the connectivity to the planes. The 
designer may also create customized plane shapes, route 
traces on planes, and optimize the fill and hatching 
patterns.

For more information, see “Overview of Planes” on 
page 50.

Interactive routing The designer manually draws the traces and either 
completes the connections manually or allows the system 
to complete the connections.

For more information, see “Overview of Interactive 
Routing” on page 92.
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Related Topics

Recommended Routing Workflow

Sketch routing The designer indicates (“sketches”) the general flow that 
the connections for a group of netlines should follow, and 
the system automatically routes the pin-to-pin 
connections for all of the selected nets according to the 
sketched path.

For more information, see “Sketch Routing” on 
page 172.

Hug routing The system automatically connects nets that could not be 
routed by the Sketch Router. The new routes “hug” the 
nearest existing traces, using push-and-shove to open 
routing channels.

For more information, see “Routing with the Hug 
Router” on page 108.

Autorouting The system connects all of the netlines automatically 
according to the specified routing rules and constraints.

For more information, see “Autorouting Techniques” on 
page 215.

Tuning The designer interactively improves the routed 
connections to meet precise electrical requirements and 
manufacturing specifications.

For more information, see “Tuning Techniques” on 
page 239.

Optimizing the 
connections

The designer optimizes the routed connections to 
improve the manufacturability of the final PCB. This 
typically involves removing hanging trace segments, 
shortening trace runs, spreading traces, or widening 
traces.

For more information, see “Cleanup Techniques” on 
page 259.

Specialized routing Certain design requirements may involve the use of 
specialized routing such as curved traces, shield traces, 
teardrops for pads, or testpoints.

For more information, see “Special Routing Tasks” on 
page 271.

Table 1-1. Routing Capabilities of Mentor PCB Layout Products  (cont.)

Feature Description
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Interactive Routing vs Autorouting
Before you attempt to route the connections, you should understand the differences between 
interactive routing and autorouting so you can apply the most efficient routing methods for your 
design.

Interactive routing is the process of completing connections on a PCB layout by manually 
“drawing” the traces between pins, with the assistance of different auto-completion functions or 
other semi-automated functions that facilitate the routing process. The advantage of using 
interactive routing is that the designer has more control over the routing process and can 
complete connections in the most accurate way. The disadvantage is that this is mostly a manual 
process and is therefore time consuming.

Autorouting is the process of completing the connections on a PCB layout using software 
functions that automatically determine the trace patterns between pins. No human interaction is 
required. Autorouting generally completes all of the connections very quickly, but the resulting 
trace patterns and via placements may not be optimal. Successful autorouting requires careful 
attention to setting the routing rules (trace widths and clearances, via types and sizes, net rules) 
and specifying how the Autorouter attempts to make the connections (ordering of nets, layer 
pairing, fanouts, cleanup passes).

The Mentor PCB layout products offer a range of interactive and autorouting functions that 
allow you to complete the routing of a PCB design efficiently and with optimal results.

Related Topics

Routing Features

Recommended Routing Workflow

Comparison of Routing Tools

Comparison of Routing Tools
Layout provides a variety of tools for routing the connections on a PCB design. 

Each routing tool is optimized for a particular routing situation. Typically, using a single routing 
tool will not satisfy all the routing requirements for an entire design; you need to apply a 
combination of different routing tools for optimal routing results.

Table 1-2. Recommended Applications for Routing Tools 

Routing Tool Description

Interactive Router Achieves the most precise and accurate routing results for complex 
routing of individual nets.

Application: Best for routing critical nets or analog designs.

See “Interactive Routing Techniques” on page 91.
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Sketch Router Generally achieves good routing results that are comparable to 
interactive routing for large groups of nets.

Application: Best for routing groups of non-critical nets across the 
entire design in fairly open areas.

See “Sketch Routing Techniques” on page 171.

Hug Router Completes any remaining unrouted nets that the Sketch Router could 
not connect by hugging the path of nearby traces and applying push-
and-shove methods. 

Application: Use primarily in conjunction with the Sketch Router to 
complete unrouted nets.

See “Routing with the Hug Router” on page 108.

Topology Router Achieves good routing results for critical bus topologies. (Requires 
special license.)

Application: Use only for routing critical bus topologies.

See “Routing Bus Nets Interactively” on page 123 and “Routing 
Shield Traces with the Topology Router” on page 291.

BGA Fanout Router Generates fanout traces and vias and routes escapes on large pin 
count, high density BGA components. (Requires special license.)

Application: Use only for generating fanouts and escapes for large 
pin count BGAs and other dense pin array components.

See “Defining BGA Fanouts and Escapes” on page 31.

Autorouter Generally achieves good routing results and high completion rates 
for very large numbers of nets over the entire design.

Application: Best for fast routing of large numbers of non-critical 
nets across the entire design. Also best for routing fanout and escape 
patterns on BGAs and other pin array components.

See “Autorouting Techniques” on page 215 and “Fanout and Escape 
Routing Techniques” on page 27.

Reroute Router Achieves good results for rerouting existing traces in small areas of 
the design. 

Application: Best for improving existing routes and opening new 
routing channels during the cleanup and glossing stages.

See “Rerouting a Trace” on page 126.

Table 1-2. Recommended Applications for Routing Tools  (cont.)

Routing Tool Description
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Follow the recommended workflow for using the routing tools.

Table 1-3. Comparison of Features in Routing Tools 

Fanout 
and 
Escape

Push and 
Shove

Layer 
Bias

Auto-
complete

Gloss

Interactive Router manual no n/a yes yes

Sketch Router yes yes no yes n/a

Hug Router yes yes no yes yes

Topology Router yes no n/a yes no

BGA Fanout 
Router

yes n/a optional n/a n/a

Autorouter yes yes yes yes yes

Reroute Router yes yes yes n/a yes
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Figure 1-1. Recommended Routing Workflow for Xpedition
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Related Topics

Strategies for Routing PCB Designs

Strategies for Routing PCB Designs
Modern PCB designs demand multiple routing tools and strategies to achieve optimal routing 
results. 

You will probably not achieve acceptable routing results if you simply autoroute all of the nets 
in every design. Instead, you should become familiar with the capabilities of all of the routing 
tools at your disposal, and then determine the best mix of tools for routing a particular design.

For example, you may be able to route most of the nets in a typical digital design with the 
Autorouter after first using interactive routing techniques to connect the critical traces. For an 
RF analog design, you will probably have to route all of the nets manually. For layouts that 
contain several high-density BGAs, you must concentrate on routing the fanouts and escapes 
efficiently before proceeding with the general routing of the design. 

Table 1-4. Routing Tools in Layout 

Routing Tools Applications

Interactive Routing

See “Interactive Routing 
Techniques” on page 91.

Traditional method of manually routing individual nets 
one at a time. Use for routing critical nets, fanouts, and 
shield traces to achieve the best possible trace patterns.

Sketch Router

See “Sketch Routing 
Techniques” on page 171.

Quick and efficient way to route groups of nets that 
connect across large areas of the design. Achieves results 
that are comparable to manual routing. Use the Sketch 
Router for most routing needs.

Hug Router

See “Routing with the Hug 
Router” on page 108.

Use for semi-automated routing of traces that should 
follow along the path of (or “hug”) existing traces. The 
Hug Router works in conjunction with the Sketch Router 
to complete any unrouted nets.

BGA Fanout Router

See “Fanout and Escape 
Routing Techniques” on 
page 27.

Use for routing fanouts and escapes for BGAs and other 
high-density pin array components.

Topology Router

See “Special Routing 
Tasks” on page 271.

Use for automated batch routing of special nets such as 
buses, shield traces, and other special routing 
applications. Some manual cleanup may be required.

Autorouter

See “Autorouting 
Techniques” on page 215.

Fast and efficient batch routing of large groups of nets. 
Results may not always be satisfactory and could require 
manual cleanup. The Autorouter is useful for completing 
the routing of non-critical nets and for routing fanouts.
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Table 1-5. Recommended Routing Strategies 

Design Type Routing Strategy

RF Analog Use interactive routing techniques to route all of the nets.

Digital 1. Use the BGA Fanout Router or the Autorouter Fanout 
pass to route the fanouts and escapes. Fix them so 
they cannot be rerouted.

2. Use interactive routing techniques to route the critical 
nets. Fix them so they cannot be rerouted.

3. Use the Topology Router to route buses and shield 
traces, as needed.

4. Use the Sketch Router and Hug Router to route the 
majority of the non-critical nets.

5. Use the Autorouter to complete the remaining 
unconnected nets, as needed.

6. Use interactive routing techniques to clean up the 
routing.

Mixed Analog/Digital 1. Use the BGA Fanout Router or the Autorouter Fanout 
pass to route the fanouts and escapes. Fix them so 
they cannot be rerouted.

2. Use interactive routing techniques to route all of the 
analog nets and other critical nets. Fix them so they 
cannot be rerouted.

3. Use the Topology Router to route buses and shield 
traces, as needed.

4. Use the Sketch Router and Hug Router to route the 
majority of the non-critical digital nets.

5. Use interactive routing techniques to complete any 
remaining unconnected nets and clean up the routing.

High-Density Interconnect 1. Use the BGA Fanout Router or the Autorouter Fanout 
pass to route the fanouts and escapes. Fix them so 
they cannot be rerouted.

2. Use interactive routing techniques to route the critical 
nets. Fix them so they cannot be rerouted.

3. Use the Topology Router to route buses and shield 
traces, as needed.

4. Use the Sketch Router and Hug Router to route the 
majority of the non-critical nets. Alternately, use the 
Autorouter if the board is very dense.

5. Use interactive routing techniques to complete any 
remaining unconnected nets and clean up the routing.
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Related Topics

Setting up the Autorouter

Overview of Autorouting with Layout

Flex 1. Use the BGA Fanout Router or the Autorouter Fanout 
pass to route the fanouts and escapes. Fix them so 
they cannot be rerouted.

2. Use interactive routing techniques to route all of the 
analog nets and other critical nets. Fix them so they 
cannot be rerouted.

3. Use the Topology Router to route buses and shield 
traces, as needed.

4. Use the Sketch Router and Hug Router to route the 
majority of the non-critical digital nets.

5. Use the Smart Utilities Multiple Hug Trace Plus 
utility for routing buses along curving flex cables, 
and the Joint Trace utility to connect a pre-routed 
bus to a connector or component.

6. Use interactive routing techniques to complete any 
remaining unconnected nets and clean up the routing.

Table 1-5. Recommended Routing Strategies  (cont.)

Design Type Routing Strategy
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Chapter 2
Recommended Routing Workflow

To achieve the best routing results, you should follow a specific plan for routing a PCB design 
based on the connection characteristics of the layout.
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Figure 2-1. Typical Routing Workflow

Routing Checklist. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
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Routing Checklist
The following is a convenient checklist you can use to be sure you have performed all of the 
recommended tasks related to routing a PCB design. 

Related Topics

Recommended Routing Workflow

Table 2-1. Routing Checklist 

Completed Routing Task

Define the routing rules and routing restrictions.

(See “Routing Rules” on page 23.)

Optimize the netlines to improve routability.

(See “Custom Topologies in Layout” on page 273.)

Choose the routing methods that are appropriate to the design.

Plan the sequence you want to follow for applying the routing methods.

Generate fanout patterns and escape routes for any BGA or other high-
density components.

(See “Fanout and Escape Routing Techniques” on page 27.)

Create the power and ground planes. (See “Power and Ground Planes” on 
page 49.)

Preroute the critical nets interactively or with the autorouter.

(See “Interactive Routing Techniques” on page 91, “Sketch Routing 
Techniques” on page 171.)

Autoroute all of the remaining non-critical nets.

(See “Autorouting Techniques” on page 215.)

Clean up the routed connections to meet electrical and manufacturing 
specifications.

(See “Tuning Techniques” on page 239, “Cleanup Techniques” on 
page 259.)

Perform special routing tasks such as completing plane connections or 
adding testpoints.

(See “Special Routing Tasks” on page 271.)

Run a final design rule check (DRC) to verify the integrity of the routed 
connections.



Layout Routing Solutions Guide, X-ENTP VX.2.522

Recommended Routing Workflow
Routing Checklist

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.



Layout Routing Solutions Guide, X-ENTP VX.2.5 23

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Chapter 3
Routing Rules

You define most of the rules that control routing in Constraint Manager.

The rules are passed to Layout and are applied to the routing functions. You define other routing 
restrictions, for example keepout and keepin areas, within Layout. 

Creating Rule Areas  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Controlling Routing with Editor Control  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Creating Rule Areas 
Create a Rule Area to define custom trace widths or clearances for a region of the board. Rule 
Areas provide flexibility when routing dense areas of the design, or when conforming to special 
design requirements in an area of the layout. 

Each Rule Area has an associated scheme, defined in Constraint Manager, which you use to 
apply the rules to the Rule Area. The constraints you define in the Constraint Manager Scheme 
for the Rule Area override the general rules that would otherwise apply in that area. 

Note
If you route differential pair traces through a Rule Area, the trace widths and clearances may 
or may not change to match the constraint scheme of the Rule Area. This depends on which 

net classes are assigned to the diff pair nets and to the Rule Area. If net classes are assigned to 
both the diff pair nets and the Rule Area, the trace widths and clearances adhere to the rules 
defined in the net classes; however, if the Rule Area does not use the same net class, the Rule 
Area takes precedence over the rules assigned to the diff pair nets. Changes that occur within 
the Rule Area may have an impact on the required electrical characteristics of the routed diff 
pair.

Prerequisites

• The set of rules (Rule Area scheme) has been defined in Constraint Manager.

• You understand how Batch DRC interprets Rule Areas.

Procedure

1. Choose the Draw > Rule Area menu item.

2. Choose the View > Toolbars > Draw Create menu item to display the Draw Create 
toolbar, then click one of the closed shapes (Rectangle, Polygon, or Circle) on the 
toolbar.
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3. In the workspace, draw the closed shape around the area for the routing constraints.

Note
Planes must be totally enclosed within the Rule Area to use the Rule Area 
clearances.

Tip
You can create a Rule Area from any existing closed shape by selecting the shape 
and creating a copy (Ctrl-double-click), then changing the Type from “Draw Object” 

to “Rule Area” in the Properties dialog box.

4. In the Properties dialog box, set the following properties:

• Layer — Select “(All)” for all conductive layers or select a specific conductive 
layer. 

• Name — Select the Constraint Manager Scheme to associate with this Rule Area. 

Note
You can assign the same Rule Area scheme to multiple Rule Areas.

5. Set Display Control to show Rule Areas if they are not visible:

a. Choose the View > Display Control menu item to open Display Control. 

b. Click the Objects tab, check and expand the Route Areas section, then check “Rule 
Areas”. 

c. Click the Edit tab, expand the Global View & Interactive Selection section, check 
and expand Route Objects, then check “Route Areas”. 

Results

The Rule Area is created with the specified scheme.

Related Topics

Overview of Rule Areas [Layout Operations and Reference Guide]

Rule Area [Layout Operations and Reference Guide]

Routing Rule

Creating Rule Area Schemes [Constraint Manager User's Manual]

Net Class Creation [Constraint Manager User's Manual]
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Controlling Routing with Editor Control
Use Editor Control to set various routing parameters before you begin interactive routing, or to 
change settings as you route traces.

Procedure

1. Open Editor Control (Setup > Editor Control menu item) and click the Route tab.

2. Before you begin interactive routing, use any of the following methods to set up the 
initial routing conditions. While you are routing, you can also use the following methods 
to make “on the fly” adjustments to the routing controls to accommodate special 
localized routing conditions. 

If you want to... Do the following....

Define the layer bias and 
layer pairing rules

1. Expand the Dialogs section, then click Layer 
Settings.

2. Change the Bias settings and the Layer Pair 
assignments as needed.

Enable or disable routing on 
specific layers

1. Expand the Dialogs section, then click Layer 
Settings.

2. In the Enable Layer column, check the check 
boxes for the layers where you want to route. 
Uncheck the layers where you do not want to 
allow routing.

Define the pad entry rules 
for surface mount pads

1. Expand the Dialogs section, then click Pad 
Entry.

2. Select a pad type, then check the pad entry 
options you want to apply to that pad.

Set the default interactive 
routing style

1. Expand the Plow section.
2. Check the interactive routing styles you want to 

use as the defaults.
3. Select the default trace angles for Segment 

Plow.

Enable DRC 1. Expand the Plow section.
2. Check the “Prohibit Violations” check box.

Define the parameters for 
glossing and push-and-
shove

1. Expand the Edit & Route Controls section.
2. Check the appropriate options for Gloss mode 

and Push & Shove.
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Related Topics

Overview of Interactive Routing

Editor Control Dialog Box - Route Tab [Layout Operations and Reference Guide]

Enable the Sketch Router or 
the Hug Router

1. Expand the Edit & Route Controls section.
2. Choose Sketch Router or Hug Router from 

the Interactive router method dropdown list.

Note: Choose General Router if you want to 
route in Plow mode.

Define the angles and 
corners for the traces

1. Expand the Angles, Corners section.
2. Check the appropriate options to set the angles 

and corners of the traces.
3. Enter the appropriate radius values.

Allow vias under 
component pads and define 
fanout rules

1. Expand the Vias & Fanouts section.
2. Check the appropriate options to define how 

vias are placed during routing and fanout.
3. Enter the appropriate values for the maximum 

via count and trace length.

Override the default net 
rules for routing

1. Expand the Net Rule Overrides section.
2. Check the appropriate options to allow layer, 

via, and other net overrides during routing.

If you want to... Do the following....
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Chapter 4
Fanout and Escape Routing Techniques

You should create fanout patterns and escape routes for any large pin count, high density 
devices before you begin full routing of the PCB connections. 

Such devices include ball grid array (BGA), small outline integrated circuit (SOIC), and flat 
pack surface mount components that may be present in your design. Routing fanouts first 
assures that there is ample space for the fanout traces and vias before you attempt the bulk of the 
routing.

Tip
Routing fanouts first also improves the completion rates for the Autorouter. You can use the 
Fanout pass of the Autorouter to route fanouts automatically. See “Setting up the 

Autorouter” on page 217.

Fanout Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

BGA Breakouts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Defining BGA Fanouts and Escapes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Defining BGA Fanout Regions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Defining BGA Escapes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

Routing Fanouts with Defined Patterns. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

Routing Fanouts Interactively  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Editing Predefined Fanouts in a Package Cell  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Mutual Escapes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43

Routing Mutual Escapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44

Fanout Methods
Layout provides several fanout tools that apply to different design needs. 

Choose the most effective fanout method for your design characteristics or apply different 
fanout methods in sequence to achieve the best fanout results.
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Table 4-1. Comparison of Fanout Methods 

Fanout Method Automatic Interactive Application

Defined fanout patterns semi semi • Regular BGA, SOIC, QUAD, 
flat pack or surface mount 
components

• You specify the patterns you 
want to apply.

• You can fanout a selected group 
of pads, a single component or 
multiple components at one 
time.

• Use this method first to route 
fanouts for the majority of the 
components. 

See “Routing Fanouts with Defined 
Patterns” on page 40.

Custom BGA fanout yes no • Large pin count, high density 
BGAs

• You define and route special 
fanout patterns for each region 
of pads within the BGA.

• Use this method next to route 
fanouts for complex BGAs that 
you cannot route with defined 
patterns.

See “Defining BGA Fanouts and 
Escapes” on page 31.

Interactive routing no yes • Any component
• You route the fanouts manually 

one pad at a time.
• Use this method last for the 

most precise routing of fanouts 
that you cannot route with other 
methods.

See “Routing Fanouts 
Interactively” on page 41.
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BGA Breakouts
Use breakout patterns for BGA components to improve routing results.

For a large pin count, high density BGA component (typically with more than 1500 pins), 
routing the BGA pins without first defining a breakout pattern tends to require more routing 
layers. BGA breakouts consist of fanouts and escapes. Together, fanouts and escapes allow you 
to “break out” of the dense pin patterns of large BGAs so you can connect them successfully to 
the rest of the design.

Figure 4-1. BGA Breakouts 

Autoroute Fanout pass yes no • Any component
• You route fanouts for all of the 

components in a design at one 
time. 

• You cannot control the fanout 
patterns.

• Use this method as a quick fully 
automatic alternative to routing 
fanouts with defined patterns.

See “Setting up the Autorouter” on 
page 217.

Table 4-1. Comparison of Fanout Methods  (cont.)

Fanout Method Automatic Interactive Application
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The most effective breakout pattern for a particular BGA depends on balancing several design 
variables. You must define, manage, and coordinate the following factors when you define a 
breakout pattern:

• Layer stackup

• Via models and via spans

• Design rules

• Signal integrity

• Power integrity

Typically, you need to perform “what if” tests with different rules until you achieve the best 
breakout pattern for a particular BGA.

Fanouts

Fanouts are short stub traces that exit the BGA ball pads and connect to vias. The fanout vias 
may be a combination of blind, buried, or through vias with different layer spans. 

You can minimize the number of routing layers and achieve the best possible routing results for 
a large BGA by grouping the pads into regions. You then define different rule sets for each 
region that control the patterns and layer spans of the fanout vias. This method distributes the 
vias and extends the total fanout through all of the board layers, thus maximizing the number of 
routing channels through and to the BGA pads.

By experimenting with different rules in each region and changing the settings to accommodate 
the BGA pad pattern, you can create effective fanouts that will improve routing success. Once 
you generate fanouts, you can either route from them directly to the rest of the design or you can 
generate escapes that extend to the outer edge of the BGA to facilitate autorouting.

Escapes

Escapes are traces that route from the fanout vias to the outer boundary (escape outline) of the 
BGA. The escape traces conform to the rules you define for the rule area around the BGA pads. 
The escape router attempts to pack as many escape traces on as few layers as possible within the 
escape outline. 

Route Targets

You can generate escapes from the fanout vias or BGA pads to route targets that are added at the 
trace terminations along the escape outline. Route targets facilitate routing outside the rule area 
boundary of the BGA. The Autorouter does not connect to hanging traces; it uses the route 
targets as connection points.
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When you change the design rules across the rule area of the BGA, route targets enforce 
adequate spacing between the traces and other route targets at the boundary of the escape 
outline. This avoids clearance violations when you move or reroute traces.

If a trace ends on a route target, it is not considered a hanging trace. All of the cleanup routines 
that remove hanging traces ignore traces that end on route targets. This prevents the cleanup 
routines from accidentally removing escape traces.

Related Topics

Defining BGA Fanouts and Escapes

Defining BGA Fanout Regions

Defining BGA Escapes

BGA Fanout & Escape Dialog Box - Fanouts Tab [Layout Operations and Reference Guide]

BGA Fanout & Escape Dialog Box - Escape Routes Tab [Layout Operations and Reference 
Guide]

Defining BGA Fanouts and Escapes
You can define special via span, spacing, and clearance rules to control how the Autorouter 
generates fanouts and how it routes escapes for BGA parts. 

By separating the BGA pads into different regions, each with its own set of fanout via rules, you 
can optimize the routability of the BGA pads by distributing the fanout vias in regular patterns 
that span different layers.

The rules you define for the BGA fanouts and escapes are saved locally with your design.

Tip
Before defining the breakouts, you should check with the board manufacturer to be sure you 
have created the correct layer stackup for your design.

Generating successful breakout patterns for large BGAs is an iterative process. You should 
experiment with different fanout rules for each BGA region, performing “what if” tests with 
different rule settings, until you achieve the best fanout patterns for each region. 

When you have defined rules that optimize the fanouts for each region, you can then experiment 
with different rules for the escape routing to see what works best. 

This process should assure that you ultimately generate the best possible breakout patterns that 
minimize the number of required routing layers.
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Prerequisites

• The Layout 151 (or higher) license has been activated in the Available Licenses dialog 
box when you opened the design database.if you are routing High Density Interconnect 
(HDI) designs.

Note
An HDI design is any design that employs high connection density and microvia 
structures: laser-drilled vias, skip vias, blind/buried vias, or any other vias that 

require some form of multi-laminate process for via construction. You define these 
microvia structures in the Via Definitions tab of the Setup Parameters dialog box 
(Setup > Setup Parameters menu item, Via Definitions tab).

• The Assign single pin nets to unused pins option has been checked in the Project 
Integration dialog box during forward annotation if you intend to add traces or breakouts 
(fanouts) to unconnected pins or single pin nets. See “Forward Annotating Design 
Changes” in PCB Operations and Reference Guide.

Procedure

1. Define the BGA regions around the pads and the rules for fanouts in each region, then 
generate the fanouts. See “Defining BGA Fanout Regions” on page 32.

2. (Optional) Define the rules for escapes, then generate the escape routes. See “Defining 
BGA Escapes” on page 38.

3. Perform a batch DRC around the BGA to verify that there are no problems with the final 
fanouts and escapes.

Related Topics

Performing Batch DRC on a Subset of a Design [Layout Verification Guide]

BGA Breakouts

BGA Fanout & Escape Dialog Box - Fanouts Tab [Layout Operations and Reference Guide]

BGA Fanout & Escape Dialog Box - Escape Routes Tab [Layout Operations and Reference 
Guide]

Defining BGA Fanout Regions
Define a different set of fanout via rules for each of the four regions of the BGA pads to 
maximize routing success.

By shifting the position and span of the fanout vias in each region, you can maximize the 
potential for routing successfully to the BGA pads.
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Figure 4-2. BGA Fanout Regions Example for 14-Layer Design

Prerequisites

• The Layout 151 (or higher) license has been activated in the Available Licenses dialog 
box when you opened the design database if you are routing High Density Interconnect 
(HDI) designs.

Note
An HDI design is any design that employs high connection density and microvia 
structures: laser-drilled vias, skip vias, blind/buried vias, or any other vias that 

require some form of multi-laminate process for via construction. You define these 
microvia structures in the Via Definitions tab of the Setup Parameters dialog box 
(Setup > Setup Parameters menu item, Via Definitions tab).

Procedure

1. Area select all of the pads of the BGA.

2. Open the BGA Fanout & Escape dialog box, Fanouts tab (Route > BGA Fanout & 
Escape menu item). 

3. Enter appropriate values for:

• Via-Via Edge Clearance (recommended value: 4)

• Diagonal Via-Pad Spacing (recommended value: 0)

4. Define the fanout via rules for each region of BGA pads based on the following 
recommended settings and your own design configuration (layer stackup, via 
definitions, BGA pin count and density).
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Note
These recommended settings provide a good starting point for performing “what if” 
experiments with the fanout rules. They assume a 14-layer stackup. 

BGA Region Recommended Settings

Region 1 Region 1 covers the outer rows of BGA pads, typically the first 
four rows. The vias for Region 1 typically span from layer 1 to 
layer 4 (1:2, 2:3, 3:4).

Define blind vias that span layers 1 to 2 to bring the surface pad 
connections to layer 2. The connections will then route 
primarily on layer 2.

Mount Side Blind & Through Spans

• Rows: 4
• Via Span: 1-2
• Via Padstack: default via
• Via-Pad Spacing: 0
• Angle: 0

Define additional buried and opposite span vias for layers 2 to 3 
that are coincident with the vias spanning layers 1 to 2. This 
allows additional routing on layer 3.

Buried & Opposite Side Blind Spans

• Via Span: 2-3
• Via Padstack: default via
• Via-Via Spacing: 0
• Angle: 0
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Region 2 Region 2 covers the next group of inner rows of BGA pads. The 
vias for Region 2 may span from layer 1 to layer 12 (1:2, 2:3, 
3:12) to reach the core layers.

Define blind vias that span layers 1 to 2 to bring the surface pad 
connections to layer 2. The connections will then route 
primarily on layer 2.

Mount Side Blind & Through Spans

• Rows: 12
• Via Span: 1-2
• Via Padstack: default via
• Via-Pad Spacing: 0
• Angle: 0

Define additional buried and opposite span vias for layers 2 to 
12 that are coincident with the vias spanning layers 1 to 2. This 
allows additional routing on all of the other inner signal layers.

Buried & Opposite Side Blind Spans

• Via Span: 2-3, 3-12
• Via Padstack: default via
• Via-Via Spacing: 0, 15
• Angle: 0, 36

BGA Region Recommended Settings
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Region 3 Region 3 is a single row transition area between the inside rows 
(Region 2) and the center rows (Region 4). Use the same vias 
for Region 3 as you used for Region 2, spanning from layer 1 to 
layer 12 (1:2, 2:3, 3:12).

Define blind vias that span layers 1 to 2 to bring the surface pad 
connections to layer 2. The connections will then route 
primarily on layer 2.

Mount Side Blind & Through Spans

• Rows: 1
• Via Span: 1-2
• Via Padstack: default via
• Via-Pad Spacing: 0
• Angle: 0

Define additional buried and opposite span vias for layers 2 to 
12 that are coincident with the vias spanning layers 1 to 2. This 
allows additional routing on all of the other inner signal layers.

Buried & Opposite Side Blind Spans

• Via Span: 2-3, 3-12
• Via Padstack: default via
• Via-Via Spacing: 0, 15
• Angle: 0, 90

BGA Region Recommended Settings
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5. Click Apply to Selected Pins to apply the region rules and automatically generate the 
fanouts.

6. Examine the results and determine if the fanout pattern for each region is satisfactory. 
Click Undo to perform “what if” experiments with different rule settings until you 
achieve the optimal pattern for each region.

Tip
You can test your fanout pattern on a subset of the BGA pads to save time. With this 
method, you can only fanout one cell at a time.

7. Perform a batch DRC around the BGA each time you define a set of rules for a region to 
be sure there are no violations or problems.

Results

You are now ready to define rules for generating the escapes from the fanout vias. See 
“Defining BGA Escapes” on page 38.

Related Topics

Performing Batch DRC on a Subset of a Design [Layout Verification Guide]

BGA Breakouts

Region 4 Region 4 covers the remaining center BGA pads. These 
normally include the power and ground pins. The vias for 
Region 4 typically span all layers of the stackup from layer 1 to 
layer 14 (1:2, 2:3, 3:4).

Define blind vias that span layers 1 to 2 to bring the surface pad 
connections to layer 2. The connections will then route 
primarily on layer 2.

Mount Side Blind & Through Spans

• Via Span: 1-14
• Via Padstack: default via
• Via-Pad Spacing: 20
• Angle: <blank>

Define additional buried and opposite span vias for layers 2 to 3 
that are coincident with the vias spanning layers 1 to 2. This 
allows additional routing on layer 3.

Buried & Opposite Side Blind Spans

• Via Span: <blank>
• Via Padstack: default via
• Via-Via Spacing: <blank>
• Angle: <blank>

BGA Region Recommended Settings
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BGA Fanout & Escape Dialog Box - Fanouts Tab [Layout Operations and Reference Guide]

Defining BGA Escapes
Define BGA escapes to facilitate routing from the fanouts to the edges of the BGA rule area, 
marked by the escape outline. 

Include route targets with the escape traces if you plan to autoroute the design.

Prerequisites

• The Layout 151 (or higher) license has been activated in the Available Licenses dialog 
box when you opened the design database.if you are routing High Density Interconnect 
(HDI) designs.

Note
An HDI design is any design that employs high connection density and microvia 
structures: laser-drilled vias, skip vias, blind/buried vias, or any other vias that 

require some form of multi-laminate process for via construction. You define these 
microvia structures in the Via Definitions tab of the Setup Parameters dialog box 
(Setup > Setup Parameters menu item, Via definitions tab).

• A rule area has been defined around the BGA component as an escape outline.

Procedure

1. Select the escape outline to highlight it.

2. Open the BGA Fanout & Escape dialog box, Escape Routes tab (Route > BGA Fanout 
& Escape menu item).

3. Define the escape rules based on the following recommended applications and your own 
design configuration (layer stackup, via definitions, BGA pin count and density).

Note
These recommended applications provide a good starting point for performing “what 
if” experiments with the escape rules. 

If you want to... Do the following...

Route the BGA 
connections manually

Choose NSEW (North South East West) for Escape 
Style.

The escape router does not follow the layer bias. The 
escape traces are routed in all four directions on the 
same layer.
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Note
By default, the layers assigned to the escape outlines are chosen either by region or 
by the selections you make. If you select an escape outline, the layers that appear in 

Layers for Escape Routes reflect the layers assigned to the escape outline.

4. Click Route Escapes to apply the rules and automatically generate the escape routes.

5. Examine the results and determine if the escape pattern is satisfactory. Click Undo to 
perform “what if” experiments with different rule settings until you achieve the optimal 
pattern.

Route the BGA 
connections with the 
Autorouter

Choose Layer Bias for Escape Style. 

The escape router works the same as with the Layer 
Bias option and inserts route targets at the escape 
outline.

Route escapes for all of 
the pads and fanout vias in 
a region

Choose By Region for Pins To Escape, then specify 
the region. 

All of the pads and fanout vias within the specified 
region are automatically selected for escape routing.

See “Defining BGA Fanout Regions” on page 32.

Route escapes for selected 
pads inside an escape 
outline

1. Choose Selected pins & selected Escape 
Outline for Pins To Escape.

2. Select the escape outline.
3. Select the pads within the selected escape 

outline.
Note: You can only select the BGA pads, not the 
fanout vias.

Route escapes for all the 
pads and fanout vias 
inside an escape outline

1. Choose All pins inside selected Escape Outline 
for Pins To Escape. 

2. Select the escape outline.

All of the pads and fanout vias within the 
selected escape outline are automatically selected 
for escape routing.

The escape router starts from the mount side and 
routes on the layers closest to that first. For example, 
if the BGA is mounted on the top side, the escape 
router first routes on layer 1, trying to route as many 
pins as possible. It then continues to route traces on 
layer 2 and subsequent inner signal layers if 
necessary. 

If you want to... Do the following...
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Tip
Perform a batch DRC around the BGA each time you define a set of escape rules to 
be sure there are no violations or problems.

Related Topics

Performing Batch DRC on a Subset of a Design [Layout Verification Guide]

Defining BGA Fanouts and Escapes

Defining BGA Fanout Regions

BGA Breakouts

BGA Fanout & Escape Dialog Box - Escape Routes Tab [Layout Operations and Reference 
Guide]

Routing Fanouts with Defined Patterns
You can route fanouts for BGA, SOIC or flat pack devices based on specific patterns that you 
define.

Layout automatically routes the fanout traces and vias according to the pattern options you 
choose. Defining fanout patterns is an efficient way to generate fanouts when there is adequate 
room for routing the traces and vias.

Procedure

1. Select the components or the pads you want to fanout.

2. Choose the Route > Fanout Patterns menu item.

3. In the Fanout Patterns dialog box, click the appropriate SOIC/QUAD, BGA, or BGA 
staggered tab.

4. Choose the desired options from the dropdown lists for Alignment, Direction, and 
Spacing to define how the fanout pattern should be routed.

The preview window shows the fanout pattern you define.

5. Click Apply or OK to set the pattern you defined.

Note
You must click Apply each time you change the pattern definition to be sure the new 
pattern takes effect the next time you generate fanouts.

6. Click Fanout Selected to generate fanouts for the components or pads you selected.

Layout attempts to route the fanout pattern you defined for the selected components or 
pads. When finished, a message reports how many pads were routed successfully.
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7. If the results are not satisfactory, click Undo , change the fanout pattern settings to 
improve the routing results, then click Fanout Selected again.

8. When you have completed routing all of the fanouts, fix the traces and vias so they will 
not be rerouted accidentally later. See “Manipulating Traces and Vias” on page 128.

Related Topics

Defining BGA Fanout Regions

Defining BGA Escapes

Routing Fanouts Interactively

BGA Breakouts

Fanout Patterns Dialog Box [Layout Operations and Reference Guide]

Routing Fanouts Interactively
You can route fanout traces and vias for surface mount, BGAs or other high density pin array 
components with the interactive routing tools.

Routing the fanouts manually helps you achieve the best custom fanout results.

Tip
You can route fanouts interactively within a package cell definition. This allows you to use 
the same fanout pattern repeatedly when you place the component multiple times. See 

“Creating a Basic Package Cell” and “Adding Fanouts to Cells” in the Cell Editor User’s 
Guide.

Prerequisites

• If you intend to add traces or breakouts (fanouts) to unconnected pins or single pin nets, 
the “Assign single pin nets to unused pins” check box has been checked on the Project 
Integration dialog box during forward annotation. See “Forward Annotating Design 
Changes” in PCB Operations and Reference Guide.

Procedure

1. Set up Display Control for interactive routing. See “Setting the Display Control for 
Interactive Routing” on page 95. 

2. Use one of the following interactive methods to route the fanouts: 

If you want to... Do the following...

Route standard fanouts for 
selected pads or for all 
pads in a net

1. Select the pads you want to fanout, or select a 
netline to fanout all of the pads on that net.

2. Click the Fanout button (F2).
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3. When you have completed routing all of the fanouts, fix the traces and vias so they will 
not be rerouted accidentally later. See “Manipulating Traces and Vias” on page 128.

Related Topics

Editing Predefined Fanouts in a Package Cell

Defining BGA Fanout Regions

Defining BGA Escapes

Routing Fanouts with Defined Patterns

BGA Breakouts

Editing Predefined Fanouts in a Package Cell
You can edit a predefined fanout by flattening the package cell.

If you define fanout traces and vias within a package cell, those elements are locked and you 
cannot edit them in your design. However, you can flatten a package cell and unlock the “built-
in” fanout traces and vias for a placed component. You can then edit them to accommodate the 
routing requirements for your particular design.

The edits you make to the flattened package cell do not change the package cell definition that is 
stored in the library. The edits only apply locally to the individual cell you flatten and edit in 
your design.

Route a fanout for an 
individual pad with 
interactive routing tools

1. Select the pad you want to fanout.
2. Click the Plow/Multi button (F3).
3. Choose your preferred routing mode and style 

from the popup menu. See “Overview of 
Interactive Routing” on page 92.

4. Drag the cursor along the fanout path you want to 
follow and route the trace to the desired location.

The system lays down traces along the path you 
indicate, following the direction of the cursor.

5. (Optional) Choose the appropriate via and layer 
from the popup menu to insert a fanout via at the 
end of the trace, then click to place the via at the 
desired location.

6. Choose Cancel from the popup menu.

If you want to... Do the following...
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Note
If you flatten a cell, the individual elements that make up the cell are no longer grouped 
together. When you move a flattened cell, you must select all of the elements you want to 

move with it so they stay together as a single unit. You cannot regroup or unflatten a cell once 
you have flattened it.

Procedure

1. Select the component you want to edit, then choose the Edit > Modify > Flatten Cell 
menu item.

The fanout traces and vias in the package cell for the selected component become 
unlocked so you can edit them.

2. Use standard interactive routing techniques to modify the unlocked fanout traces and 
vias. See “Interactive Routing Techniques” on page 91 and “Fanout and Escape Routing 
Techniques” on page 27.

3. When you are finished with the edits, lock the fanout traces and vias so you do not alter 
them accidentally when you are routing or making other edits to the design. See 
“Manipulating Traces and Vias” on page 128.

Related Topics

Creating a Basic Package Cell [Cell Editor User's Guide]

Adding Fanouts to Cells [Cell Editor User's Guide]

Routing Fanouts Interactively

Mutual Escapes
Mutual escape routing automatically generates escapes and routes bus connections between two 
BGAs (or other pin array components). 

The system optimizes the mutual escapes according to the bit-ordering (netline sequencing) on 
both ends of the bus so it can route them on a single layer.

You can generate the mutual escapes from the BGA pins to the escape outlines or you can 
generate the escapes and route the complete connections between the components.

You must define escape outlines for both BGAs and draw bus paths between the BGAs for each 
of the buses you want to escape. It is important to draw bus paths correctly because they guide 
the routing of mutual escapes and they optimize the bit-ordering of bus routing.
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Mutual Escapes Workflow

Set up the required conditions for routing mutual escapes according to the following workflow. 

Related Topics

Routing Mutual Escapes

Routing Mutual Escapes
Use the Mutual Escape router to route optimized escapes on a single layer for buses that connect 
between two BGAs. 

The mutual escapes are arranged sequentially according to the bit-ordering of the bus nets at 
each end of the bus path between the two BGAs.
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Prerequisites

• The Layout 151 (or higher) license has been activated in the Available Licenses dialog 
box when you opened the design database if you are routing High Density Interconnect 
(HDI) designs.

Note
An HDI design is any design that employs high connection density and microvia 
structures: laser-drilled vias, skip vias, blind/buried vias, or any other vias that 

require some form of multi-laminate process for via construction. You define these 
microvia structures in the Via Definitions tab of the Setup Parameters dialog box 
(Setup > Setup Parameters menu item, Via Definitions tab).

• The Topology Planner and Topology Router licenses have been activated 
(Setup > Licensed Modules menu item, Xpedition Topology Planner and Xpedition 
Topology Router options).

• The buses have been defined in Net Explorer or Constraint Manager.

• A rule area has been defined around each BGA component as an escape outline. See 
“Creating Rule Areas” on page 23.

Procedure

1. Draw a bus path between the two BGA components for each of the buses you want to 
escape. See “Routing Bus Nets Interactively” on page 123.
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Tip
Draw a bus path for each bus you want to escape.

2. Use one of the following methods to generate mutual escapes: 

• Choose the Route > Mutual Escapes menu item to generate mutual escapes for all 
of the bus paths. 

• Select a single bus path and choose Mutual Escapes Route from the popup menu.
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The system generates escapes for the buses in an optimized pattern from both sets of 
BGA pins to their respective escape outlines.

3. Select a bus path with mutual escapes and choose Route Escapes from the popup menu.

The system routes the connections between the mutual escapes on a single layer. The 
arrangement of the routed connections is optimized because of the bit-ordering of the 
mutual escapes on both ends of the bus path.
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Tip
To generate the escapes and route the connections simultaneously, select a bus path 
and choose Mutual Escapes Route + Connect from the popup menu.

Related Topics

Defining BGA Fanouts and Escapes

Mutual Escapes
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Chapter 5
Power and Ground Planes

You can create power and ground planes in a PCB layout and define different hatch patterns and 
thermal connections. 

You can also create custom split planes or shield planes, or modify the planes in other ways to 
improve manufacturability.

Overview of Planes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

Setting Up Plane Layers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Creating Plane Boundaries . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Assigning Nets to Planes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Defining Plane Classes and Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Defining Hatch Patterns  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57

Creating Clearance Areas within Planes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Thermal Pins Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Defining Thermal Pins for Planes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Adding Thermal Overrides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Removing Thermal Overrides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Plane Shapes Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Creating Plane Shapes and Split Planes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Modifications to Plane Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Modifying Plane Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Merging Plane Shapes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Subtracting Plane Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
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Overview of Planes
Planes are areas on a board that are filled with copper and connected to a specific net, usually a 
power or ground net. 

• Plane layers typically fill an entire layer of the PCB layout.

• Split planes are plane layers that are divided into two or more regions, with each region 
connected to a different net. 

• Plane shapes are limited to smaller regions of a layer (typically a routing layer). 

Most multi-layer designs require at least one power plane layer and one ground plane layer. 
Plane layers provide better and more uniform connectivity for power and ground pins. Planes 
are also useful as shielding elements in the overall design.

Define the display and data characteristics for a plane by assigning it a specific Type, Class, and 
Data State. 

Table 5-1. Plane Types, Classes, and Data States 

Parameter Description Application

Type

Positive Shows and stores the positive image 
of the filled plane area with thermal 
pins for the plane connections.

Use positive planes for 
verifying the final plane 
images and connectivity 
(visually and with Batch 
DRC).

Negative Shows and stores the negative image 
of the plane and clearance pads. 
Does not show fill patterns or pin 
connections.

Avoid using negative 
planes for normal design 
work. Negative planes do 
not support the latest 
features for plane creation 
and editing (such as 
dynamic updating and 
hatching); they are 
available to maintain older 
legacy designs. With 
negative planes, batch 
DRC checks only for 
shorts between the plane 
boundary and other metal 
objects.

Class

Solid The plane area is filled completely. Use solid planes to fill the 
plane area completely 
without gaps.
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Hatch The plane area is filled with a hatch 
pattern. You specify the size and 
direction of the hatching. See 
“Displaying and Generating Planes” 
on page 87. 

Use hatching with caution 
because hatched planes can 
cause impedance mismatch 
and reduce current flow.

Data State

Inherited The plane layer inherits the data state 
of the plane layer just above it in the 
Plane Assignments dialog box.

Use inherited planes to 
adopt the parameters of a 
previously defined plane in 
the Plane Assignments 
dialog box.

Draft Shows the plane boundary and 
clearance pads. Does not show fill 
patterns or pin connections.

Use draft planes to reduce 
display time.

Dynamic Dynamically updates the filled plane 
area as you make edits to the plane or 
the plane connections.

Use dynamic planes to 
show changes immediately 
when you move parts or 
vias, or when routing 
through a plane area.

Static Shows the filled plane area without 
updating to reflect recent edits to the 
design. The plane data is cannot be 
edited.

Use static planes when you 
are inspecting the planes 
for the finished design and 
to archive the design data.

Batch Only appears if the Plane Type is 
“Negative”.

Allows you to generate the 
Gerber output for multiple 
planes with a single batch 
command.

Table 5-1. Plane Types, Classes, and Data States  (cont.)

Parameter Description Application
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Related Topics

Power and Ground Planes

Plane Assignments Dialog Box [Layout Operations and Reference Guide]

Table 5-2. Examples of Typical Plane Types, Classes, and Data States 

Type/Class/State Example

Positive type

Solid class

Dynamic state

-or-

Positive type

Solid class

Static state

Positive type

Hatch class

Dynamic state

-or-

Positive type

Hatch class

Static state

Negative type

Any class

Batch state

-or-

Positive type

Any class

Draft state
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Setting Up Plane Layers
During board setup, define the plane layers such as power and ground.

This helps with placement locations and provides immediate feedback about the power and 
ground signals.

Prerequisites

• The layer stackup has been defined for the layout. See “Defining the Basic Stackup” in 
the Stackup Editor User Guide.

• The initial Forward Annotation has been performed. See“ Forward Annotating From the 
Schematic to Layout the First Time” in the PCB Operations and Reference Guide.

Procedure

1. Verify the layer stackup settings with the Stackup Editor (Setup > Stackup Editor 
menu item) to be sure they meet the specific requirements for your design.

2. Create the plane boundaries for each plane layer. See “Creating Plane Boundaries” on 
page 53.

3. Define the display and data parameters for the planes. See “Defining Plane Classes and 
Parameters” on page 56.

4. Define the thermal relief pads, anti-pads, and clearances for the planes. See “Defining 
Thermal Pins for Planes” on page 63.

5. If required, create plane shapes, split planes, or plane clearances. See “Creating Plane 
Shapes and Split Planes” on page 68 and “Creating Clearance Areas within Planes” on 
page 60.

Results

You are now ready to complete the setup of the layout before placing the parts.

Related Topics

Overview of Planes

Creating Plane Boundaries
Generate plane boundaries automatically with the Plane Assignments dialog box.

You can also draw the plane boundaries manually for each plane layer. 

Prerequisites

• At least one plane layer has been defined in the layer stackup. See “Defining the Basic 
Stackup” in the Stackup Editor User Guide.
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Procedure

1. Open the Plane Assignments dialog box (Planes > Plane Assignments menu item). 

2. Select the Use route border as plane shape radio button for each plane layer.

Note
Only one plane net per plane layer can use the route border.

-or-

Open the Properties dialog box with Type: “Plane Shape” (Planes > Plane Shape menu 
item) and manually draw the plane boundary on each plane layer. See “Creating Plane 
Shapes and Split Planes” on page 68. The Properties dialog box shows the (x,y) 
coordinates of each vertex of the boundary as you draw it.

Note
The plane boundary must be a closed polygon.

Tip
You can edit the plane boundaries by changing the (x,y) coordinates of the plane 
shape in the Properties dialog box.

Results

The boundaries you create are Draw objects (closed polygons) that define the extent of the fill 
areas for the planes. They also serve as routing keepouts for the plane layers during autorouting.
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Related Topics

Setting Up a New Design [Layout Operations and Reference Guide]

Defining Plane Classes and Parameters

Plane Assignments Dialog Box [Layout Operations and Reference Guide]

Assigning Nets to Planes
You assign a net to a plane layer when you create the layer stackup. 

Prerequisites

• At least one plane layer has been defined in the layer stackup. See “Defining the Basic 
Stackup” in the Stackup Editor User Guide.

Procedure

1. Open the Plane Assignments dialog box (Planes > Plane Assignment menu item).

2. Select the plane layer you want to edit and click Browse  to open the Nets dialog box.

3. In the Exculded list, select the net name(s) to include as assigned to the plane.

4. Click the right arrow to move the net name(s) to the Included list. 

5. Click OK to close the Nets dialog box.

The new net(s) are assigned to the plane.
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Note
If you assign a single net to a plane layer using the route border as the shape 
boundary, that layer is automatically a full plane layer. (You can draw a plane shape 

that is smaller than the route border and assign a single net to it also.) If you assign 
additional nets to the full size plane layer as in this example, you define a split plane and 
need to create the corresponding plane shapes for the added nets. See “Creating Plane 
Shapes and Split Planes” on page 68.

Results

The nets you moved to the Included list are assigned to the plane layers with an inherited plane 
class.

Related Topics

Setting Up a New Design [Layout Operations and Reference Guide]

Plane Assignments Dialog Box [Layout Operations and Reference Guide]

Defining Plane Classes and Parameters
Define a plane class that specifies the thermal pin styles, hatch patterns, and clearance 
parameters for that plane.

Prerequisites

• At least one plane layer has been defined in the layer stackup. See “Defining the Basic 
Stackup” in the Stackup Editor User Guide.

Procedure

1. Open the Plane Classes and Parameters dialog box (Planes > Plane Classes and 
Parameters menu item).

2. Click New Plane Class , then enter a name for the new plane class in the Plane 
Class text box.

3. Click the Thermal Definition tab, then define the size, style, and rotation of the thermal 
pins to apply to vias, through-hole pins, and SMD pins that connect to the planes. See 
“Defining Thermal Pins for Planes” on page 63.

4. Click the Clearances/Discard/Negative tab, then define the parameters for the 
clearances and unconnected plane areas.

5. Click the Hatch Options tab, then do the following:

a. Define the hatch Settings and choose one of the hatch Patterns.

b. (Optional) Define the Customize parameters, if necessary.
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c. Check the appropriate Options for the hatching. (The available options vary, 
depending on which hatch pattern you choose.)

6. Click OK.

Results

The parameters you specify are applied to the plane layers and are saved as the new plane class 
definition for later use.

Related Topics

Plane Classes and Parameters Dialog Box [Layout Operations and Reference Guide]

Defining Hatch Patterns
You can define custom hatch patterns for filling positive planes instead of using a solid fill.

Hatch patterns eliminate the issue of copper blistering that can occur during the manufacturing 
process on large solid fill areas.

Figure 5-1. Examples of Hatch Patterns 
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Note
If you set the hatch width to a narrow value, the resulting Gerber output files will be larger 
because there is more data. If you set the hatch width to a thicker value, the Gerber files will 

be smaller but the wider hatch patterns may prohibit connectivity to the plane in some areas..

Prerequisites

• At least one plane layer has been defined in the layer stackup or a plane shape has been 
defined.

• Planes have been displayed. See “Displaying and Generating Planes” on page 87.

Procedure

1. Open the Plane Classes and Parameters dialog box, Hatch Options tab (Planes > Plane 
Classes and Parameters menu item, Hatch Options tab).

2. Click New Plane Class  and enter a name for the class to create a new plane class for 
the custom hatch pattern.

3. Enter values for the Width and Distance, or a percentage for Metal, then choose the 
appropriate hatch pattern.

Note
The Distance must be greater than the Width to create hatching. If the Distance is 
less than or equal to the Width, the fill will be solid (100% Metal).

4. Check the appropriate Options.

5. Click OK to save the new plane class with the hatch pattern definition and exit the 
dialog box.

6. For a plane layer:

a. Open the Plane Assignments dialog box (Planes > Plane Assignments menu item).

b. From the Plane Class dropdown list for the plane layer, choose the new plane class.
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Note
The Plane Type must be Positive to view the hatch pattern.

c. Click OK.

7. For a plane shape:

a. Select the shape, then click Properties .

b. From the Plane Class dropdown list, choose the new plane class.

8. Visually inspect the plane for possible connection problems, or run Batch DRC 
(Analysis > Batch DRC) to verify that the new fill pattern connects all pins.

Results

The positive plane is filled with the hatch pattern you defined in the selected plane class. The 
same hatch pattern is used for generating the Gerber output.

Related Topics

Defining Plane Classes and Parameters

Creating Plane Shapes and Split Planes

Plane Classes and Parameters Dialog Box - Hatch Options Tab [Layout Operations and Refer-
ence Guide]

Plane Assignments Dialog Box [Layout Operations and Reference Guide]
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Creating Clearance Areas within Planes
Create clearance areas (obstructs) within planes to provide physical clearance around slots and 
other mechanical elements, or to meet special electrical constraints.

Figure 5-2. Example of Clearance Area

Note
Plane obstructs are treated as separate design elements and are not attached to the plane 
shape. If you move the plane, the obstruct will not move with it. Use the Subtract feature 

(see “Subtracting Plane Shapes” on page 75) to define a clearance area that remains part of the 
plane shape.

Prerequisites

• At least one plane layer has been defined in the layer stackup or a plane shape has been 
defined on a mixed layer (see “Creating Plane Shapes and Split Planes” on page 68).

Procedure

1. Set the Plane layers to display. Open the Display Control dialog box (View > Display 
Control menu item or click ) and enable the following:

• Edit tab, Layer Display section, plane layers to display

• Edit tab, Global View & Interactive Selection section, “Visibility”, “Planes”

• Objects tab, Planes section, options to display
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2. Open the Properties dialog box with Type: Plane Obstruct (Planes > Plane Obstruct 
menu item). 

3. Click a location in the design to establish the first vertex of the obstruct boundary within 
the plane shape.

The (x,y) coordinates for the vertex appear in the Vertices section of the Properties 
dialog box.

4. Continue to place additional vertices as you draw the obstruct.

Tip
Alternately, you can enter exact (x,y) coordinates in the Vertices section of the 
Properties dialog box to specify the vertices.

5. Choose Close Polygon from the popup menu to complete the boundary.

The last vertex you entered automatically connects to the first vertex to complete the 
closed polygon for the obstruct.
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Note
The obstruct must be a closed polygon.

6. Choose Cancel from the popup menu to end the editing session.

Results

A clearance area corresponding to the obstruct polygon is created within the plane. Pins within 
the obstruct are not connected to the plane, even if those pins are part of the net that is assigned 
to the plane.

Related Topics

Setting Up a New Design [Layout Operations and Reference Guide]

Display Control Dialog Box [Layout Operations and Reference Guide]
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Thermal Pins Overview
Thermal pins (also known as thermal relief pads or thermal ties) make connections to planes 
using special spoked pads that reduce thermal conductivity and thus improve solderability of 
through-hole leaded components.

Thermal pins are typically required only for soldering through-hole leaded components, but you 
can also define thermal pins for vias and for SMD pads.

You can assign a thermal pin in three different ways:

• Assign a thermal pin to a padstack definition. The thermal pin is part of the padstack and 
applies wherever the padstack is used. See Creating a Padstack.

• Assign a thermal pin to a plane class. The thermal pin is used for all planes that belong 
to the particular plane class. You can choose to have the thermal pin for the plane class 
override the thermal pin assigned to the padstack definition. See “Defining Plane 
Classes and Parameters” on page 56.

• Define a pin-specific thermal override and assign it to individual pins in the design. The 
thermal override is used instead of both the thermal pin in the padstack definition and 
the thermal pin assigned to the plane class. See “Adding Thermal Overrides” on 
page 65.

Defining Thermal Pins for Planes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Adding Thermal Overrides. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Removing Thermal Overrides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Defining Thermal Pins for Planes
Define thermal pins for a plane class to improve the thermal and electrical properties of the 
plane connections.

Thermal pins are special padstacks that provide connections to planes using tie bars rather than 
solid fills over the component pins and vias. For each plane class, you must define a default 
thermal pin for vias, through-hole pins, and SMD pads. You can choose whether to override the 
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default thermal pin you assign to a plane class with the thermal pin assigned to the padstack 
definition.

Figure 5-3. Example of Thermal Pins 

Tip
You can modify the thermal pin configurations for individual plane connections with 
thermal overrides. See “Adding Thermal Overrides” on page 65.

Prerequisites

• At least one plane layer has been defined in the layer stackup. See “Defining the Basic 
Stackup” in the Stackup Editor User Guide .

Procedure

1. Open the Planes Classes and Parameters dialog box (Planes > Plane Classes and 
Parameters menu item).

2. Add a new plane class.

3. Click the Thermal Definition tab and define each type of thermal connection (vias, 
through-hole pins, SMD pins).

4. (Optional) Enable “Use thermal definition from padstack” to use the thermal pin 
assigned to the padstack instead of the default thermal pin assigned to the plane class.

5. Click OK.

Results

The thermal pin definitions you specify are applied automatically to all plane connections.

Related Topics

Defining Plane Classes and Parameters

Thermal Pins Overview
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Plane Classes and Parameters Dialog Box [Layout Operations and Reference Guide]

Pin Thermal Dialog Box [Layout Operations and Reference Guide]

Adding Thermal Overrides
You can modify the default thermal pin by defining a thermal override.

Note
You must be careful to manage any thermal overrides in your design. The system does not 
automatically remove thermal overrides or change their properties when you edit the 

surrounding planes. Also, you do not receive any warning messages or other reports when you 
edit planes that contain thermal overrides.

Note
If you add a thermal override to a custom-defined pad shape with a complex, irregular 
outline, the resulting thermal ties may not be optimal.

Prerequisites

• At least one plane layer has been defined in the layer stackup or a plane shape has been 
defined on a mixed layer (see “Creating Plane Shapes and Split Planes” on page 68).

Procedure

1. Select the thermal pins you want to change, then choose Place Thermal Override from 
the popup menu.

2. In the Pin Thermal dialog box, select the plane layer for the override and change the 
appropriate parameters to create a new thermal override.

3. Click OK to save the override definition and apply it to the selected pins.

Results

The new thermal override is assigned to the selected pins for the designated plane layer and 
overrides the default thermal pin.

Tip
You can create a custom pad Clearance Override by setting the number of thermal ties to 
none, and defining a clearance radius.

Related Topics

Defining Thermal Pins for Planes

Removing Thermal Overrides

Thermal Pins Overview
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Pin Thermal Dialog Box [Layout Operations and Reference Guide]

Plane Classes and Parameters Dialog Box - Thermal Definition Tab [Layout Operations and Ref-
erence Guide]

Removing Thermal Overrides
Remove thermal overrides that you assigned to alter the default thermal pin definition for 
special plane connections.

Note
You must be careful to manage any thermal overrides in your design. The system does not 
automatically remove thermal overrides or change their properties when you edit the 

surrounding planes. Also, you do not receive any warning messages or other reports when you 
edit planes that contain thermal overrides.

Prerequisites

• At least one plane layer has been defined in the layer stackup or a plane shape has been 
defined on a mixed layer (see “Creating Plane Shapes and Split Planes” on page 68).

• A thermal override has been assigned. See “Adding Thermal Overrides” on page 65.

Note
The Remove Thermal Override option in the popup menu is not available if the pin 
you select does not have a thermal override assignment.

Procedure

Use any of the following operations to remove thermal pin overrides.

If you want to... Do the following...

Remove an individual 
thermal override

1. Select the pin containing the override.
2. Choose Remove Thermal Override from the popup 

menu.

Remove multiple selected 
thermal overrides

1. Select the pins containing the overrides using basic group 
selection techniques (Ctrl-click or Shift-click).

2. Choose Remove Thermal Override from the popup 
menu.

Remove all thermal 
overrides

1. Choose the Edit > Select All menu item or group select 
all nets containing thermal overrides.

2. Choose Remove Thermal Override from the popup 
menu.



Power and Ground Planes
Removing Thermal Overrides

Layout Routing Solutions Guide, X-ENTP VX.2.5 67

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Related Topics

Adding Thermal Overrides

Thermal Pins Overview

Pin Thermal Dialog Box [Layout Operations and Reference Guide]

Plane Classes and Parameters Dialog Box - Thermal Definition Tab [Layout Operations and Ref-
erence Guide]

Remove a placed pin 
thermal override

• Choose the Edit > Undo menu item after you place a pin 
thermal override.
Note: Undo removes only the last placed pin thermal 
override.

If you want to... Do the following...
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Plane Shapes Overview
You can create custom plane shapes on routing layers to accommodate special design 
requirements.

Creating Plane Shapes and Split Planes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Modifications to Plane Shapes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Modifying Plane Shapes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Merging Plane Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Subtracting Plane Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Deleting Plane Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Creating Plane Shapes and Split Planes
Use Plane Shapes to define plane areas on routing layers (mixed layers) or to create split planes 
on plane layers.

Split planes are two or more plane shapes that exist on the same plane layer but are connected to 
different nets.

Note
You cannot create plane shapes for ordered nets.

Note
Avoid creating plane shapes as part of cell definitions for library parts, since this may cause 
unpredictable results when processing the final output data.

Procedure

1. Set the Plane layers to display. Open the Display Control dialog box (View > Display 
Control menu item or click ) and enable the following:

• Edit tab, Layer Display section, plane layers to display

• Edit tab, Global View & Interactive Selection section, “Visibility”, “Planes”

• Objects tab, Planes section, options to display
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2. Open the Properties dialog box with Type: Plane Shape (Planes > Plane Shape menu 
item). 

3. Click a location in the design to establish the first vertex of the polygon for the plane 
shape.

The (x,y) coordinates for the vertex appear in the Vertices section of the Properties 
dialog box.

Tip
Alternately, you can enter the exact (x,y) coordinates for each vertex of the plane 
shape in the Vertices section.

4. Continue to place additional vertices as you draw the plane shape. 

5. Choose Close Polygon from the popup menu to complete the shape boundary.
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The last vertex you entered automatically connects to the first vertex to complete the 
closed polygon for the plane shape.

Note
The plane shape must be a closed polygon.

6. From the Net dropdown list, select the net you want to assign to the plane shape. 

All of the pins assigned to that net (and contained within the shape) connect 
automatically to the plane.

Note
If you check the “Isolate Plane” option, the plane shape either merges with 
overlapping plane data of the same net or is separated by the minimum plane-to-

plane DRC rule.

7. Choose Cancel from the popup menu to end the editing session.

Results

The shape you draw is a new plane area. All pins attached to the assigned net are connected to 
the shape with thermal pins. If you checked the “Fill Plane Shapes” option in Display Control, a 
plane mesh appears in the plane shape.

Related Topics

Display Control Dialog Box [Layout Operations and Reference Guide]

Defining Thermal Pins for Planes
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Modifications to Plane Shapes
You can modify plane shapes in the following ways: 

• Plane Shape Handles — Drag and drop the drawing handles on the boundary of the 
plane shape to move the side or corner of the boundary to a new location. See 
“Modifying Plane Shapes” on page 71.

• Merge Shapes — Combine two plane shapes together to form a single larger shape with 
a more complex boundary. See “Merging Plane Shapes” on page 74.

• Subtract Shapes — Subtract the area of one plane shape from another shape to form a 
cutout in the second plane shape. See “Subtracting Plane Shapes” on page 75.

• Set Priorities — Set priorities when one plane shape overlaps a second plane shape. See 
the tooltip videos by hovering your cursor over the Bring Forward and Send 
Backward icons on the Draw Edit toolbar.

Related Topics

Deleting Plane Shapes

Modifying Plane Shapes
Modify an existing plane shape to accommodate changes in the design.

Tip
You can merge plane shapes and subtract areas of plane shapes (see “Merging Plane 
Shapes” on page 74 and “Subtracting Plane Shapes” on page 75).

Prerequisites

• At least one plane shape has been defined. See “Creating Plane Shapes and Split Planes” 
on page 68.

• Planes have been displayed. See “Displaying and Generating Planes” on page 87.

Procedure

Select the plane shape and use the following procedures to modify it:

Table 5-3. Operations for Modifying Plane Shapes 

If you want to... Do the following...

Move a plane shape 1. Choose Move from the popup menu.
2. Drag and drop the shape to a new location.
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Rotate a plane shape 1. Choose Rotate from the popup menu.

The plane shape rotates 90 degrees counter-
clockwise around its physical centerpoint. 

2. Choose Rotate repeatedly until the shape is in the 
correct orientation.

Example of Rotated Shape: 

Mirror a plane shape • Choose Mirror Horiz from the popup menu to 
mirror the shape horizontally along the vertical axis 
that runs through its physical centerpoint.

• Choose Mirror Vert from the popup menu to 
mirror the shape vertically along the horizontal axis 
that runs through its physical centerpoint.

Example of Mirror Horiz Shape: 

Table 5-3. Operations for Modifying Plane Shapes  (cont.)

If you want to... Do the following...
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Tip
Visually inspect the design, or run Batch DRC (Analysis > Batch DRC menu item), 
to verify that deleting the plane shape has not caused open connections or created 

other connectivity errors.

Results

The new plane shape automatically refills and connects to any additional pins within the new 
boundaries that are part of the net assigned to the plane.

Related Topics

Modifications to Plane Shapes

Deleting Plane Shapes

Properties dialog box [Layout Operations and Reference Guide]

Example of Mirror Vert Shape: 

Resize a plane shape or add 
vertices

Note: Ensure that Display center handles is 
checked in the Properties dialog box for the 

selected plane shape.

• Drag and drop the handle for a side or a vertex of 
the shape boundary to a new location.

Table 5-3. Operations for Modifying Plane Shapes  (cont.)

If you want to... Do the following...
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Merging Plane Shapes
Use the Merge function to merge two plane shapes together into a single plane shape.

Prerequisites

• At least two plane shapes have been defined and their boundaries touch or overlap at 
some point. See “Creating Plane Shapes and Split Planes” on page 68 and “Modifying 
Plane Shapes” on page 71.

• Planes have been displayed. See “Displaying and Generating Planes” on page 87.

• The Draw Edit toolbar has been made visible (View > Toolbars > Draw Edit menu 
item).

Procedure

1. Select one of the plane shapes you want to merge. 

2. Click Merge  on the Draw Edit toolbar.
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3. Select the second shape. 

Results

The two plane shapes combine into a single plane shape with a single continuous boundary. If 
the second plane shape was assigned to a different net, it is reassigned to the net of the first 
plane shape. Thermal ties are added for any new connections to the assigned net that lie within 
the merged shape.

Related Topics

Modifications to Plane Shapes

Subtracting Plane Shapes
Use the Subtract function to cut away an area of a plane shape based on the boundary of a 
different plane shape.

Prerequisites

• At least two plane shapes have been defined and their boundaries touch or overlap at 
some point. See “Creating Plane Shapes and Split Planes” on page 68 and “Modifying 
Plane Shapes” on page 71.

• Planes have been displayed. See “Displaying and Generating Planes” on page 87.

• The Draw Edit toolbar has been made visible (View > Toolbars > Draw Edit menu 
item).
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Procedure

1. Select the plane shape you want to subtract from.

2. Click Subtract  on the Draw Edit toolbar.

3. Select the second plane shape. 

4. Visually inspect the design, or run Batch DRC (Analysis > Batch DRC menu item), to 
verify that the Subtract function has not left unconnected pins in the region that was 
removed.
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Results

The fill area of the first plane shape adjusts to accommodate the subtracted region of the 
overlapping plane shape. The second plane shape is removed.

Related Topics

Modifications to Plane Shapes

Deleting Plane Shapes
Delete plane shapes that you no longer need in your design. 

Prerequisites

• At least one plane shape has been defined. See “Creating Plane Shapes and Split Planes” 
on page 68.

• Planes have been displayed. See “Displaying and Generating Planes” on page 87.

Procedure

1. Select the plane shape you want to delete.

Note
If the plane shape you want to delete is Fixed or Locked, you must open the 
Properties dialog box and change the Lock Status to None.

2. Press the Delete key.

3. Visually inspect the design, or run Batch DRC (Analysis > Batch DRC menu item), to 
verify that deleting the plane shape has not caused opens or created other connectivity 
errors.

Results

The plane shape you select is removed from the design. Pins that were connected to the net 
assigned to the plane shape may no longer be tied to that net.

Related Topics

Modifications to Plane Shapes

Creating Plane Shapes and Split Planes

Properties Dialog Box [Layout Operations and Reference Guide]

Defining Routed Plane Pins
You can define which pins (routed plane pins) should not be connected directly to the plane 
with thermal pins.
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Normally, all pins included in a net that is assigned to a plane are connected automatically to 
that plane with thermal pins. In certain cases, the design requirements may specify that some 
pins should not be connected directly to the plane with thermal pins; you must connect them to 
the plane manually with traces.

One of the most common applications of routed plane pins is to prevent SMD pins from 
connecting with thermal pins. By defining the SMD pins as routed plane pins, you prohibit the 
automatic connection to the plane.

Figure 5-4. Example of Routed Plane Pins 

Note
Batch DRC does not check routed plane pins that are connected to planes on negative plane 
layers.

Routed plane pin definitions are backannotated to the schematic with the schematic symbol pin 
property “Routed Plane Pin”.

Prerequisites

• At least one plane layer or plane shape has been defined. See “Creating Plane Shapes 
and Split Planes” on page 68.

• Planes have been displayed. See “Displaying and Generating Planes” on page 87.

Procedure

1. Open the Routed Plane Pin Control dialog box (Planes > Routed Plane Pins menu 
item).

2. From the Plane net dropdown list, choose the net assigned to the plane.

3. In the Pin selection list, select the part and then check the pins that should be routed 
plane pins (pins that should not connect to the plane).

4. Click OK.

5. Backannotate the changes to the schematic.
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6. Connect the routed plane pins to the plane with regular interactive routing methods. See 
“Interactive Routing Techniques” on page 91.

Results

The pins you define as routed plane pins are removed from the list of pins that connect to the 
plane automatically.

Related Topics

Defining Thermal Pins for Planes

Routing Traces on Planes

Routed Plane Pin Control Dialog Box [Layout Operations and Reference Guide]

Back Annotating Design Changes [Layout Operations and Reference Guide]

Routing Traces on Planes
You can route traces through plane shapes or on plane layers when necessary to accommodate 
special design requirements or to complete the remaining routes on a very dense design.

Any plane layer that includes traces is considered a “mixed” layer. Clearances are generated 
automatically around the traces you route inside a plane boundary.

Figure 5-5. Example of Mixed Layer 
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Prerequisites

• At least one plane shape or plane layer has been defined. See “Creating Plane Shapes 
and Split Planes” on page 68.

• Planes have been displayed. See “Displaying and Generating Planes” on page 87.

Procedure

1. To route traces through a plane shape defined on a signal layer, skip to Step 3.

2. To route traces on a plane layer, change the layer definition and enable routing as 
follows:

Note
If you define the layer as a Signal Plane in the Plane Assignments dialog box, you do 
not need to change the Usage definition in Constraint Manager. The layer can have 

both routed traces and plane shapes. You can route traces on a layer designated as a 
plane as long as routing on that layer is enabled and the planes are dynamic.

a. Open Constraint Manager.

b. Open the Stackup Editor (Edit > Stackup menu item) and click the Basic tab.

c. In the Usage column for the plane layer, choose Split/Mixed from the dropdown 
list.

This changes the plane definition from a solid plane to a mixed layer so you can 
route traces on the plane layer.

Note
A message may appear prompting you to recalculate typical impedance values 
for the new stackup definition. Click Yes to proceed.

d. In the Net Classes worksheet, expand each of the net class lists under the Master 
scheme and enable the Route option for the mixed plane layer in each net class.

e. Exit Constraint Manager.



Power and Ground Planes
Routing Traces on Planes

Layout Routing Solutions Guide, X-ENTP VX.2.5 81

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

f. In Layout, forward annotate the stackup changes from Constraint Manager by 
clicking the middle indicator light (Schematic constraint changes are pending) in 
the lower-right corner of the workspace. 

The stackup changes are incorporated into the Layout database and you can now 
route traces on the plane layer.

g. Open the Editor Control dialog box, Route tab (Setup > Editor Control menu item, 
click the Route tab or click ).

h. In the Dialogs section, click Layer Settings and check the “Enable Layer” check 
box for the mixed plane layer, then click OK.

3. Open the Display Control dialog box, Edit tab (View > Display Control menu item, 
click the Edit tab or click ).

4. In the Layer Display section, select the layer you want to be the active layer for routing.

5. Use the regular interactive routing methods to route traces inside the plane. See 
“Interactive Routing Techniques” on page 91.

Tip
For best results, choose routing channels that will not isolate thermal pin 
connections to the plane and leave open plane connections because of the trace 

clearances.

6. Visually inspect the design, or run Batch DRC (Analysis > Batch DRC), to verify that 
the traces have not caused problems with the plane shape or connectivity.

Results

Clearances are generated automatically around the traces you route inside the plane. 

Related Topics

Defining Routed Plane Pins

Viewing or Modifying Stackup Properties [Constraint Manager User's Manual]

Plane Assignments Dialog Box [Layout Operations and Reference Guide]
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Editor Control Dialog Box - Route Tab [Layout Operations and Reference Guide]

Display Control Dialog Box - Edit Tab [Layout Operations and Reference Guide]

Removing Scallop Patterns
Remove scallop patterns to smooth the plane edges and improve the manufacturability of the 
PCB.

Scallop patterns are the ragged edges of planes that surround pads and holes. Typically, you 
should remove scallop patterns at the end of the design cycle just before generating Gerber files 
and manufacturing output.

Note
Scalloped plane edges are not removed from around pins that have a tie leg setting of 4 or 
more, or from pins with tie legs that you have edited manually.

Figure 5-6. Example of Scallop Patterns 

Prerequisites

• At least one plane shape or plane layer has been defined. See “Creating Plane Shapes 
and Split Planes” on page 68.

• Planes have been displayed. See “Displaying and Generating Planes” on page 87.

Procedure

1. Select the plane shape, then choose Plane Classes and Parameters from the popup 
menu.

2. Click the Clearances/Discard/Negative tab.

3. In the Discard plane area options section, check “Remove Scallops” and click OK.
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Results

The scalloping is removed and the plane clearances have smooth edges.

Related Topics

Plane Classes and Parameters Dialog Box - Clearances / Discard / Negative Tab [Layout Opera-
tions and Reference Guide]

Removing Unconnected Pads
Remove unconnected pads on internal plane layers to reduce the possibility of shorts between 
the plane and the unused pads during manufacturing. 

Typically, you should remove unconnected pads at the end of the design cycle just before 
generating Gerber files and manufacturing output.

Note
You cannot remove SMD pads or skip vias.

Prerequisites

• At least one plane shape or plane layer has been defined with unconnected pads. See 
“Creating Plane Shapes and Split Planes” on page 68.

• Planes have been displayed. See “Displaying and Generating Planes” on page 87.

Procedure

1. Open the Padstack Processing dialog box, Pads tab (Edit > Modify > Padstack 
Processor menu item, click the Pads tab).

2. Choose Delete from the Action dropdown list.

3. In the Layers list, select the plane layer.

4. In the Pad Types in Design list, select the pad type you want to remove.

5. Click Process Pads.

Results

All unconnected pads are removed from the plane.

Related Topics

Padstack Processing Dialog Box - Pads Tab [Layout Operations and Reference Guide]
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Removing Unconnected Plane Islands
Remove unconnected islands of copper within a plane to reduce the possibility of shorts during 
manufacturing and also eliminate possible electrical interference problems.

You can choose to remove different types of plane islands. Typically, you should do this at the 
end of the design cycle just before generating Gerber files and manufacturing output.

Prerequisites

• At least one plane shape or plane layer has been defined. See “Creating Plane Shapes 
and Split Planes” on page 68.

• Planes have been displayed. See “Displaying and Generating Planes” on page 87.

Procedure

1. Select the plane shape, then choose Plane Classes and Parameters from the popup 
menu. 

2. Click the Clearances/Discard/Negative tab. 
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3. In the Discard plane area options section, check “All untied areas” and click Apply. 

4. (Optional) Check “Areas tied to single pad” and click Apply.
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5. (Optional) Check “Any areas less than” and enter length and width values for the area, 
then click Apply. 

6. Visually inspect the design, or run Batch DRC (Analysis > Batch DRC menu item), to 
verify that removing the unconnected islands has not caused problems with the plane 
connectivity.

Results

All unconnected plane islands are removed from the plane.

Related Topics

Plane Classes and Parameters Dialog Box - Clearances / Discard / Negative Tab [Layout Opera-
tions and Reference Guide]

Migrating Existing Plane Data
You can import plane data from an older legacy design to compare the original plane data with 
the results you can achieve using the newer plane generation features. 

Prerequisites

• An Xpedition FabLink license has been acquired to import Gerber files into Layout.
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Procedure

1. Open the legacy design in Layout.

2. Generate Gerber files for all layers that contain the original plane data. (Exclude 
everything except the plane data when generating the Gerber files.)

3. Import the Gerber files back into Layout on user-defined draft layers.

4. Change all plane layers and plane nets in the design from “Static” to “Dynamic”. See 
“Displaying and Generating Planes” on page 87.

5. Visually compare the imported planes on the draft layers with the corresponding original 
plane data to identify areas where you could improve the planes.

Results

You may discover areas in the plane data of the original design that you can improve with the 
newer plane generation features in Layout.

Related Topics

Comparing Gerber Data [Layout Manufacturing Inputs and Outputs Guide]

Gerber Output Dialog Box [Layout Manufacturing Inputs and Outputs Guide]

Gerber Import Dialog Box - Import Options Tab [Layout Manufacturing Inputs and Outputs 
Guide]

Gerber Compare Dialog Box [Layout Manufacturing Inputs and Outputs Guide]

Gerber [Layout Manufacturing Inputs and Outputs Guide]

Displaying and Generating Planes
You can set the visibility of plane layers and plane objects.

You can change how the planes appear in the workspace, the type of plane data that is stored 
with the design, and how the plane data is generated for Gerber and manufacturing outputs.

Prerequisites

• At least one plane layer has been defined in the layer stackup. See “Defining the Basic 
Stackup” in the Stackup Editor User Guide.

Procedure

1. Set the Plane layers to display. Open Display Control (View > Display Control menu 
item or click ) and enable the following:

• Edit tab, Layer Display section, plane layers to display

• Edit tab, Global View & Interactive Selection section, Visibility, Planes
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• Objects tab, Planes section, options to display

2. Open the Plane Assignments dialog box (Planes > Plane Assignments menu item). 

3. Choose the appropriate options from the dropdown lists in the Plane Type, Plane Class, 
and Plane Data State cells for each plane layer.

4. Click Apply.

Results

The planes and objects you specified as visible appear in the workspace. The plane assignments 
you specify determine how the planes appear in the workspace and how they are generated for 
Gerber and manufacturing output.

Related Topics

Setting Up a New Design [Layout Operations and Reference Guide]

Display Control Dialog Box [Layout Operations and Reference Guide]

Plane Assignments Dialog Box [Layout Operations and Reference Guide]

Generating Negative Planes
You can generate negative plane data for display and output purposes.

Negative planes show and store the negative image of the plane and clearance pads. They do not 
show fill patterns or pin connections.

Note
Avoid using negative planes for normal design work. See Restrictions and Limitations 
below.

Restrictions and Limitations

• Negative planes do not support the latest features for plane creation and editing (such as 
dynamic updating and hatching); they are available to maintain older legacy designs. 
With negative planes, batch DRC checks only for shorts between the plane boundary 
and other metal objects.

• The Generate Negative Planes command does not delete existing negative plane data 
prior to generating new data.

Prerequisites

• The plane layers you want to process as negative images must have been defined as 
Plane Type = Negative in the Plane Assignments dialog box (choose the Planes 
> Plane Assignments menu item).
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Procedure

1. Choose the Planes > Plane Classes and Parameters menu item to open the Plane 
Classes and Parameters dialog box, click the Clearances/Discard/Negative tab, then 
specify the following options:

a. Under Negative clearance pads, choose how you want to display the negative 
clearance pads (Anti-Pad or Donut).

a. Under “Negative plane fill distance beyond route border”, specify the distance value.

2. Click the OK button to close the dialog box and apply the new settings.

3. Choose the Planes > Generate Negative Planes menu item.

Results

The system generates the negative plane data for all layers of Plane Type = Negative and 
displays those planes as negative images.

Examples

Negative plane layer with Anti-Pads:

Negative plane layer with Donuts:

Related Topics

Overview of Planes

Plane Assignments Dialog Box [Layout Operations and Reference Guide]

Plane Classes and Parameters Dialog Box - Clearances / Discard / Negative Tab [Layout Opera-
tions and Reference Guide]
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Chapter 6
Interactive Routing Techniques

Use interactive routing techniques to complete connections manually and achieve the best 
routing results. 

Overview of Interactive Routing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92
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Overview of Interactive Routing
Interactive routing involves laying down trace segments manually to make connections between 
component pins on a net-by-net basis. 

Depending on the interactive routing method you choose, the system may assist in various ways 
to guide you in routing the traces and may even complete a connection automatically as you 
approach the target pin.

Layout supports different interactive routing styles and modes (see “Plow and Multi-Plow 
Modes” on page 94 and Table 6-2). Choose the most effective interactive routing mode for your 
needs. 

Table 6-1. Comparison of Interactive Routing Modes 

Routing Method Autocomplete Push-and-Shove Application

Real Trace / Delayed yes after routing fast autocomplete 
routing 

Real Trace / Dynamic yes during routing fast autocomplete 
routing with control 
over push-and-shove 
results

Hockey Stick / On 
Click

no after routing controlled placement of 
trace segments

Segment / On Click no after routing most precise placement 
of trace segments
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Note
The routing modes and styles described in the following table are available only in Plow 
mode. They are not available in Multi-Plow mode (see “Plow and Multi-Plow Modes” on 

page 94).

Table 6-2. Interactive Routing Modes and Styles 

Routing Method Description

Modes — The interactive routing modes provide different means of completing a 
connection, with varied control over the precision of placing trace segments and allowing 
push-and-shove functionality. Table 6-1 compares the different routing modes to help you 
choose the best one for your needs.

Real Trace / Delayed (Available with Mouse Up Plow Style and Mouse Drag Plow 
Style.)

Routes the traces by finding the best routing channels as you 
drag the cursor in the general direction of the target pin. 
Autocompletes the connection when you hover the cursor 
over the target pad.

The push-and-shove function occurs when the trace you are 
routing enters open space. Interfering traces and vias are 
moved out of the way of the new route. 

See “Routing with Real Trace / Delayed Mode” on page 98.

Real Trace / Dynamic (Available with Mouse Up Plow Style and Mouse Drag Plow 
Style.)

Routes the traces by finding the best routing channels as you 
drag the cursor in the general direction of the target pin. 
Autocompletes the connection when you hover the cursor 
over the target pad. 

The push-and-shove function works dynamically in real time 
as you route the trace. Interfering traces and vias are moved 
out of the way as you move the cursor during routing. The 
Real Trace / Dynamic mode allows you to see the results as 
you route and provides more precise control of the final 
routed connection.

See “Routing with Real Trace / Dynamic Mode” on 
page 101.
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Related Topics

Interactive Routing Techniques

Plow and Multi-Plow Modes

Plow and Multi-Plow Modes
Layout provides two different interactive routing modes: Plow and Multi-Plow.

Hockey Stick / On Click (Available only with the Mouse Up Plow Style.)

Routes angled trace segments (“hockey stick” shape) as you 
click to define the anchor points. You must click on the target 
pad to complete the connection.

The push-and-shove function does not occur until after you 
click to place the anchor point of the next angled trace 
segments. Interfering traces and vias are moved out of the 
way of the new route only after the angled trace segments are 
placed.

See “Routing with Hockey Stick / On Click Mode” on 
page 103.

Segment / On Click (Available only with the Mouse Up Plow Style.)

Routes traces segment by segment as you click to define the 
anchor points of each segment. You must click on the target 
pad to complete the connection.

The push-and-shove function does not occur until after you 
click to place the anchor point of the next trace segment. 
Interfering traces and vias are moved out of the way of the 
new route only after the trace segment is placed.

See “Routing with Segment / On Click Mode” on page 105.

Styles — The interactive routing styles are functionally identical. Choosing a style is a 
matter of personal preference and routing technique. See “Routing with Mouse Up Plow 
and Mouse Drag Plow Styles” on page 107.

Mouse Up Plow Style Allows you to route traces with the left mouse button “up” 
(not-depressed) while dragging the trace endpoint across the 
workspace towards the target pin.

Mouse Drag Plow Style Allows you to route traces with the left mouse button “down” 
(depressed) while dragging the trace endpoint across the 
workspace towards the target pin.

Table 6-2. Interactive Routing Modes and Styles  (cont.)

Routing Method Description
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Route with Plow mode when you want to connect a single net. In Plow mode, you can choose 
different interactive routing methods that improve your routing efficiency. Plow mode is the 
default mode when you select a single net for interactive routing.

Route with Multi-Plow mode when you want to connect multiple nets simultaneously along the 
same routing path. Multi-Plow helps you connect differential pairs and buses quickly and 
reliably, or any other group of nets you select. When you add vias in Multi-Plow mode, a via is 
added for each net in the group you are routing. You can adjust the arrangement of the vias 
dynamically to choose the best pattern (see “Adding Vias During Interactive Routing” on 
page 127). Multi-Plow mode does not support the interactive routing styles and modes that are 
available with Plow mode. You activate Multi-Plow mode automatically when you select two or 
more nets for interactive routing.

Related Topics

Interactive Routing Techniques

Differential Pairs

Setting the Display Control for Interactive 
Routing

Set the Display Control visibility and selection options to achieve an efficient workspace 
environment for interactive routing.

As you gain more experience, you can customize these settings to match your own preferences.

Procedure

1. Choose the View > Display Control menu item to open Display Control. 

2. Click each tab and enable the desired display options.

The following table provides recommended display and selection settings.

Field Recommended Settings

Edit tab

Favorites section Check any options you may have placed under Favorites that 
relate to interactive routing, such as layers, grids, netlines, and so 
forth.
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Layer Display 
section

Check the following:

• Visibility and Selection for the routing layers you are 
currently routing

Uncheck the following:

• List Only Route Enabled Layers
• Display Active Layer Only

Global View & 
Interactive 
Selection section

Check the following:

• Route Objects — Visibility and Selection for all options
• Board Objects — Visibility and Selection for all options

Uncheck the following:

• Place Objects — Visibility and Selection for all options
• Planning — Visibility and Selection
• Draw & Fab Objects — Visibility and Selection for all 

options

Objects tab

Netlines section Check the following:

• All options
Tip: You may want to customize these settings when you are 
routing only certain net types or classes, or when you are routing 
specific components and their associated nets.

Planning section Check the following:

• All options

Vias section Check the following:

• All options

Pins section Check the following:

• All options

Planes section Uncheck the following:

• All options

Obstructs section Check the following:

• All options except Placement - Top and Placement - 
Bottom

Route Areas 
section

Check the following:

• All options

Field Recommended Settings
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Place Objects 
section

Check the following:

• Top Facement and Bottom for Part Ref Des
Uncheck the following:

• All other options

Graphic tab

Graphics Options 
section

Check the appropriate options to control object selection and 
highlighting, display patterns, grid parameters, and other general 
workspace parameters based on your preferences.

Grids section Check the following:

• Drawing
• Place Primary
• Place Secondary
• Route
• Via

Uncheck the following:

• Jumper
• Test Point

Color By Group 
Outlines section

Uncheck this section

Color By Net or 
Class section

Check the appropriate options to apply color for highlighting 
nets and classes according to your preferences.

Tip: You may find it helpful to change these settings as you 
route different nets and classes.

Object Appearance 
section

Check each option to define the pattern you want to assign to the 
Traces, Pads, and Plane Data.

Fab tab

Board Objects 
section

Check the following:

• Fiducials - Top
• Fiducials - Bottom
• Holes — Pin Holes, Via Holes, Mounting Holes
• Board Elements — Board Outline, Manufacturing 

Outline, Test Fixture Outline, Contours — Span 
Numbers

• Text Items — all options
Uncheck the following:

• Board Elements — all other options

Field Recommended Settings
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3. Click the Save Scheme icon , then enter a new name to save the Display Control 
settings as a scheme that you can reuse later.

Related Topics

Display Control Dialog Box [Layout Operations and Reference Guide]

Overview of Interactive Routing

Saving, Modifying, and Reusing Settings and Assignments With Schemes [Layout Operations 
and Reference Guide]

Routing with Real Trace / Delayed Mode 
Use this mode for completing routes quickly in areas of the design that are not particularly 
dense.

Real Trace / Delayed Mode routes the traces by finding the best routing channels as you drag 
the cursor in the general direction of the target pin.

Real Trace / Delayed mode is available with the Mouse Up Plow Style and the Mouse Drag 
Plow Style. See “Routing with Mouse Up Plow and Mouse Drag Plow Styles” on page 107. 

Copper Balancing 
section

Uncheck this section

Fabrication Objects 
section

Check the following:

• Top for Silkscreen Items
• Top and Bottom for Cell Items

Uncheck the following:

• All other options

Drill Drawing 
section

Uncheck this section

User Draft Layers Uncheck this section

DRC tab

Hazards section Check the options for how you want DRC errors to appear in the 
workspace.

Online section Check the options for the DRC errors you want to make visible 
in the workspace.

Batch section Check the options for the DRC errors you want to make visible 
in the workspace.

Field Recommended Settings
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If you enable glossing, the push-and-shove function occurs when the trace you are routing 
enters open space. Interfering traces and vias are moved out of the way of the new route.

Prerequisites

• Glossing has been enabled by clicking the Toggle Gloss Action Key (F10).

Video

Procedure

1. Click on the pad or the netline you want to route.

2. Click the Plow/Multi Action Key (F3).

3. Choose one of the following menu items from the popup menu:

• Mouse Up Plow Style > Real Trace / Delayed 

• Mouse Drag Plow Style > Real Trace / Delayed 

4. Drag the cursor along the routing path you want to define.

The system lays down traces along the path you indicate, following the direction of the 
cursor, automatically routing around any obstacles.

https://support.mentor.com/video/e87cd98e-0aac-4189-b684-839533b4f351
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Tip
To temporarily suspend Plow mode, press the Shift key. The end of the trace you are 
routing is anchored at the last position of the cursor. When you want to resume 

Plow, click anywhere in the workspace to continue routing. (This applies only to routing 
with Real Trace mode.)

5. Hover the cursor over the target pad to autocomplete the route.

The system pushes interfering traces and vias out of the way when it completes the 
connection.
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Tip
When you are routing through dense areas that allow a path for the trace after push-
and-shove, the trace segment turns green to indicate you have an open routing 

channel.

Related Topics

Overview of Interactive Routing

Plow and Multi-Plow Modes

Routing with Real Trace / Dynamic Mode

Routing with Hockey Stick / On Click Mode

Routing with Segment / On Click Mode

Routing with Real Trace / Dynamic Mode 
Use this mode for completing routes quickly in denser areas of the design where you need to 
view and control the results of push-and-shove on existing traces and vias.

Real Trace / Dynamic Mode routes the traces by finding the best routing channels as you drag 
the cursor in the general direction of the target pin.

Real Trace / Dynamic mode is available with the Mouse Up Plow Style and the Mouse Drag 
Plow Style. See “Routing with Mouse Up Plow and Mouse Drag Plow Styles” on page 107.

If you enable glossing, the push-and-shove function works dynamically in real time as you route 
the trace. Interfering traces and vias are moved out of the way as you move the cursor during 
routing.

Prerequisites

• Glossing has been enabled by clicking the Toggle Gloss Action Key (F10).
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Video

Procedure

1. Click on the pad or the netline you want to route.

2. Click the Plow/Multi Action Key (F3). 

3. Choose one of the following menu items from the popup menu:

• Mouse Up Plow Style > Real Trace / Dynamic 

• Mouse Drag Plow Style > Real Trace / Dynamic 

4. Drag the cursor along the routing path you want to define.

The system lays down traces along the path you indicate, following the direction of the 
cursor, automatically routing around any obstacles. 

Tip
To temporarily suspend Plow mode, press the Shift key. The end of the trace you are 
routing is anchored at the last position of the cursor. When you want to resume 

Plow, click anywhere in the workspace to continue routing. (This applies only to routing 
with Real Trace mode.)

https://support.mentor.com/video/dfd265c9-8c92-4f19-93ca-3f98f6d85d2f
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Existing traces and vias are pushed out of the way dynamically to open routing channels. 

5. Hover the cursor over the target pad to autocomplete the route.

Related Topics

Overview of Interactive Routing

Plow and Multi-Plow Modes

Routing with Real Trace / Delayed Mode

Routing with Hockey Stick / On Click Mode

Routing with Segment / On Click Mode

Routing with Hockey Stick / On Click Mode 
Use this mode to control the routing pattern more accurately than with the Real Trace modes but 
still route quickly.

Hockey Stick / On Click Mode routes angled trace segments (“hockey stick” shape) as you click 
to define the anchor points.

Hockey Stick / On Click mode is available only with the Mouse Up Plow Style. See “Routing 
with Mouse Up Plow and Mouse Drag Plow Styles” on page 107. 

If you enable glossing, the push-and-shove function occurs when the trace you are routing 
enters open space. Interfering traces and vias are moved out of the way of the new route.

Note
If you enable Gloss All, the anchor points are disabled. If you enable Gloss Local, the 
anchor points are preserved. Gloss is disabled automatically when you choose Angle Mode. 



Layout Routing Solutions Guide, X-ENTP VX.2.5104

Interactive Routing Techniques
Routing with Hockey Stick / On Click Mode

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Video

Procedure

1. Click on the pad or the netline you want to route.

2. Click the Plow/Multi Action Key (F3).

3. Choose the Mouse Up Plow Style > Hockey Stick / On Click menu item from the 
popup menu.

4. Choose the Angle Mode menu item from the popup menu, then choose either the 45 or 
90 menu item for the “hockey stick” pattern.

5. Click the cursor along the routing path to place anchor points that define the location of 
each angled segment.

The system lays down angled trace segments each time you click an anchor point 
location.

https://support.mentor.com/video/585d6f42-2b0c-4205-a65a-fbabf8dac151
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6. Click on the target pad (or click the Autofinish Action Key (F5)) to complete the route. 

Related Topics

Overview of Interactive Routing

Plow and Multi-Plow Modes

Routing with Real Trace / Delayed Mode

Routing with Real Trace / Dynamic Mode

Routing with Segment / On Click Mode

Routing with Segment / On Click Mode 
Use this mode to achieve the most precise routing pattern.

Segment / On Click Mode routes traces segment by segment as you click to define the anchor 
points of each segment. Segment / On Click is the traditional digitizing method of routing trace 
segments one at a time. 

Segment / On Click mode is available only with the Mouse Up Plow Style. See “Routing with 
Mouse Up Plow and Mouse Drag Plow Styles” on page 107. 

If you enable glossing, the push-and-shove function occurs when the trace you are routing 
enters open space. Interfering traces and vias are moved out of the way of the new route.

Note
If you enable Gloss All, the anchor points are disabled. If you enable Gloss Local, the 
anchor points are preserved. Gloss is disabled automatically when you choose Angle Mode. 

Video

Procedure

1. Click on the pad or the netline you want to route.

2. Click the Plow/Multi Action Key (F3).

https://support.mentor.com/video/5e31abd1-4684-494a-ae2f-636a08fee84d
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3. Choose the Mouse Up Plow Style > Segment / On Click menu item from the popup 
menu.

4. Choose the Angle Mode menu item from the popup menu, then choose either the 45, 90, 
or Any menu item.

5. Click the cursor along the routing path to place anchor points that define each individual 
trace segment.

The system lays down single trace segments each time you click an anchor point 
location. 

6. Click on the target pad (or click the Autofinish Action Key (F5)) to complete the route. 

Tip
Click the Toggle Gloss Action Key (F10) to turn off the glossing function and gain 
even more precise control over how you place the trace segments. 

Related Topics

Overview of Interactive Routing

Plow and Multi-Plow Modes

Routing with Real Trace / Delayed Mode

Routing with Real Trace / Dynamic Mode

Routing with Hockey Stick / On Click Mode
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Routing with Mouse Up Plow and Mouse Drag 
Plow Styles 

Use the Plow routing style that suits your personal routing preference.

The interactive routing styles are functionally identical. Choosing a style is a matter of personal 
preference and routing technique. The styles are always enabled. The default is Mouse Up Plow 
Style. Activate Mouse Drag Plow Style by pressing and holding the left mouse button. 

Video

Procedure

1. Click the pad or the netline you want to route.

2. Select the Plow/Multi ( F3) Action Key. 

3. Choose one of the following routing modes from the popup menu: 

If you want to... Do the following...

Route with Mouse Up 
Plow Style using either 
Real Trace / Delayed or 
Real Trace / Dynamic 
mode. 

1. Drag the cursor along the routing path you want to 
define without pressing the left mouse button.

The system lays down traces along the path you 
indicate, following the direction of the cursor, 
automatically routing around any obstacles.

2. Hover the cursor over the target pad to autocomplete 
the route.

Route with Mouse Up 
Plow Style using either 
Hockey Stick / On Click 
or Segment / On Click 
mode. 

1. Click the cursor along the routing path to place 
anchor points that define the trace segments.

The system lays down trace segments each time you 
click an anchor point location.

2. Click the cursor on the target pad (or select the 
Autofinish ( F5) Action Key) to complete the route. 

https://support.mentor.com/video/1d403e7f-1d49-4fcf-bd05-8a913a13eef4


Layout Routing Solutions Guide, X-ENTP VX.2.5108

Interactive Routing Techniques
Routing with the Hug Router

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Tip
Since the styles are always enabled, you can quickly switch between styles by 
pressing or releasing the left mouse button. You may gain efficiency by setting 

different routing modes for each style. For example, you might enable the combination 
Mouse Up Plow Style > Real Trace / Dynamic and Mouse Drag Plow Style > Real 
Trace / Delayed so you can toggle quickly between dynamic and delayed push-and-
shove functions. 

Related Topics

Overview of Interactive Routing

Plow and Multi-Plow Modes

Routing with Real Trace / Delayed Mode

Routing with Real Trace / Dynamic Mode

Routing with Hockey Stick / On Click Mode

Routing with Segment / On Click Mode

Routing with the Hug Router 
Use the Hug Router in conjunction with the Sketch Router to finish routing a selected net (or 
multiple nets) that the Sketch Router could not route. 

The Sketch Router does not push and shove existing traces, so in dense areas it may not be able 
to complete all of the nets it is attempting to route. The Hug Router applies automatic routing 
algorithms, including push and shove, to complete the remaining unrouted nets along the path of 
nearby traces.

The Hug Router may insert vias if necessary and switch to other layers in an attempt to follow 
the full path of nearby existing traces. It may also push and shove existing traces and ignore the 
layer bias settings.

Route with Mouse Drag 
Plow Style using either 
Real Trace / Delayed or 
Real Trace / Dynamic 
mode. 

1. Press and hold down the left mouse button while you 
drag the cursor along the routing path you want to 
define.

The system lays down traces along the path you 
indicate, following the direction of the cursor, 
automatically routing around any obstacles.

2. Hover the cursor over the target pad to autocomplete 
the route, then release the left mouse button.

If you want to... Do the following...
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Note
Select no more than four nets for routing with the Hug Router. The Hug Router does not 
route effectively if you attempt to route more than four nets.

Video

Procedure

1. Set up the Hug Router:

a. Open the Editor Control dialog box ( Setup > Editor Control). 

b. Select the  Route tab and expand the Edit & Route Controls section. 

c. Choose Sketch Router from the Route behavior Interactive router method 
dropdown list. 

The F9 Action Key toggles between Sketch Route/Hug Route depending on the 
setting you choose in Editor Control. 

2. Select the nets and route them with the Sketch Router. See “Routing With a Sketch 
Path” on page 179. 

Any nets the Sketch Router cannot complete remain selected.

https://support.mentor.com/video/16c3770d-d4b0-4d84-aea6-47f3f60242da
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3. If the Sketch Router cannot route some nets, choose Hug Router from the Route 
behavior Interactive router method dropdown list in Editor Control. ( Note: The nets 
remain selected after you change to Hug Router mode.) 

4. Select the Hug Route ( F9) Action Key. 

The Hug Router automatically routes the selected nets that the Sketch Router could not 
complete, following the general path of the nearest existing traces. 

Note: If more than four nets remain selected, the system automatically switches to 
Sketch Router mode to attempt the routing. 

Related Topics

Sketch Routing Techniques

Differential Pairs
A differential pair consists of two nets (a carrying signal and its inverse) generally derived from 
the outputs of a single gate. 

These nets are active at the same time and have the same number of inputs and terminators. 
Differential pairs reduce the effects of electromagnetic interference because information is 
determined by the difference between the two complementary signals.

In a PCB layout, the nets for a differential pair must share the same topology definition. The 
traces for each net must be routed adjacent to each other as closely as possible (within the 
specified edge-to-edge clearance value) with paired vias and matching trace lengths. This 
ensures that the signals arrive at the differential inputs with identical characteristics. 
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Figure 6-1. Example of Routed Differential Pairs 

Related Topics

Routing Differential Pairs

Routing Curved Traces

Differential Pair Creation and Pair Rule Definition [Constraint Manager User's Manual]

Routing Groups of Nets with Multi-Plow Mode 
Route with Multi-Plow mode when you want to connect multiple nets simultaneously along the 
same routing path, such as with a bus. 

A bus is a group of related nets that follow the same routing path to meet similar electrical or 
timing requirements.

Prerequisites

• To select a bus from a constraint class, the nets you intend to route as a bus must be 
grouped together and defined as a named bus either in the schematic or in the Constraint 
Manager. 
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Video

Procedure

1. Select the nets you want to route in one of the following ways: 

2. Select the Plow/Multi ( F3) Action Key. 

3. (Optional) Choose from the following routing settings to gain better control over how 
you route the traces: 

The system enters Multi-Plow mode so you can route all of the nets simultaneously.

If you want to... Do the following...

Route a group of 
nets.

While pressing the Shift key, click the pads (or netlines) for 
the nets you want to route together. 

The nets are selected and highlighted.

Route a bus. 1. Open Net Explorer and enable cross probing ( ). 

2. In the Navigator, select the Constraint Class that defines 
the bus.

The nets that make up the bus/constraint class are 
selected.

If you want to... Do the following...

Route traces at 45 
degree angles with 
glossing applied 
locally.

Select the Toggle Plow ( F3) Action Key repeatedly until 
the status bar shows: 

Route traces at any 
angle with 
glossing turned 
off.

Select the Toggle Plow ( F3) Action Key repeatedly until 
the status bar shows: 

https://support.mentor.com/video/d1df715a-6457-4f56-9b29-347738f745b2
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4. Click the cursor along the routing path to place anchor points for the trace segments.

As you drag the cursor across the workspace, ghost segments indicate the potential 
routing. Each time you click to place an anchor point, the system lays down trace 
segments to that point. 

Tip: Select the Converge Out ( F7) Action Key repeatedly to spread the traces apart. 
Or, conversely, select the Converge In ( F6) Action Key repeatedly to move the traces 
closer together. These functions may help you route through denser areas of the design 
or create better routing patterns. 
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5. Select the Add Via ( F2) Action Key to add vias to all of the nets, then select the Toggle 
Via ( F9) Action Key to toggle between different via placement patterns. See “Adding 
Vias During Interactive Routing” on page 127. 

6. Continue routing the nets towards the target pins. 

7. Complete the connections for all of the nets by selecting the Auto Finish ( F5) Action 
Key. Or, click the cursor on the target pad, via or trace segment for one of the nets. 

Note: The Autofinish function uses the options you select in the Editor Control dialog 
box, Route tab when attempting to complete the routes. 

8. If the Autofinish function cannot connect to the target pins, complete the remaining 
connections by routing the individual nets using Plow mode.

Related Topics

Plow and Multi-Plow Modes

Routing Differential Pairs

Tuning Techniques
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Routing Differential Pairs 
Route differential pairs simultaneously with Multi-Plow mode to achieve matched topology and 
length for the paired traces and vias. 

Note
If you route differential pair traces through a rule area, the trace widths and clearances may 
or may not change to match the constraint scheme of the rule area. This depends on which 

net classes are assigned to the diff pair nets and to the rule area. If net classes are assigned to 
both the diff pair nets and the rule area, the trace widths and clearances adhere to the rules 
defined in the net classes; however, if the rule area does not use the same net class, the rule area 
takes precedence over the rules assigned to the diff pair nets. Changes that occur within the rule 
area may have an impact on the required electrical characteristics of the routed diff pair.

Prerequisites

• You must define the nets that make up the differential pair in Constraint Manager.

• You must have set up the route parameters for the differential pairs.

Video

Procedure

1. Click on one of the netlines or on one of the starting pads of the differential pair.

2. Select the Plow/Multi ( F3) Action Key. 

https://support.mentor.com/video/3f0488f3-850d-4b9d-882e-890a853bdcdb
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The system automatically selects both nets of the pair and shifts to Multi-Plow mode. 

3. Choose your preferred routing style from the popup menu.

4. Route the differential pair. 

5. (Optional) Use tuning methods (see “Tuning a Trace” on page 240) to route the 
differential pairs so they meet any tuning constraints. 

Tip
To move one of the traces or vias independently, press and hold the ALT key while 
dragging the trace or via. The system does not normally allow you to “split” the 

differential pair traces when routing or moving them around pads or vias. When you 
place vias for differential pairs, the vias for both nets are placed as close together as 
possible and span the same layers. If you move one of the traces or vias for a differential 
pair, the other trace or via automatically moves in tandem to maintain the correct 
spacing and symmetry. 

Related Topics

Routing Groups of Nets with Multi-Plow Mode

Differential Pairs
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Defining BGA Fanouts and Escapes

Tuning a Trace

Differential Pair Creation and Pair Rule Definition [Constraint Manager User's Manual]

Diff Pairs Dialog Box [Layout Operations and Reference Guide]

Net Class Creation [Constraint Manager User's Manual]

Changing Trace Widths During Interactive 
Routing

You can change the width of trace segments during interactive routing to improve routing 
through tight spaces or to increase the width for power nets.

Prerequisites

• Minimum, Typical, and Expansion widths must be set in Constraint Manager.

Procedure

1. Select a pin or netline and start to route a trace.

2. Change the width of the trace with one of the following methods: 

Results

After you change the trace width, the remainder of the net is routed with that width. 

Batch DRC generates Trace Width hazards for trace widths that violate the Constraint Manager 
Minimum, Maximum, or Expansion widths.

Related Topics

Changing Trace Widths of Routed Nets

Specifying Trace and Via Rules [Constraint Manager User's Manual]

Trace Width Expansion [Constraint Manager User's Manual]

Trace Width Minimum [Constraint Manager User's Manual]

If you want to... Do the following....

Change a trace width 
during routing

1. Choose Widths from the popup menu, then 
choose Minimal, Typical, Expansion, or one of 
the custom trace widths. 

Define custom trace 
widths during routing

1. Choose Widths from the popup menu, then 
choose Add Widths.

2. Enter a Custom Width and click OK.
Note: Values appear on the Widths popup menu.
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Trace Width Typical [Constraint Manager User's Manual]

Trace Width Hazards [Layout Verification Guide]

Routing Curved Traces
You can route curved traces rather than straight trace segments. 

Use curved traces to route along the rounded contour of a board or to improve the 
manufacturability of your design. Curved traces and traces with rounded corners provide stress 
relief for the design because rounded corners are less likely to fracture or break.

Note
Arcs and curves are not maintained when you move parts or traces. Therefore, it is best to 
create arcs and curves only when your design is nearly or completely routed.

Prerequisites

• Make traces and vias visible in the Display Control.

Procedure

1. Set up the radius angle for the curves by selecting or entering values for the curve radius 
and minimum radius in the Editor Control dialog box, Route tab, “Angles, Corners” 
section.

2. Select the netline or pad you want to route.

3. Click Plow/Multi (F3).

4. From the popup menu, choose one of the following:

• Mouse Up Plow Style > Hockey Stick / On Click

• Mouse Up Plow Style > Hockey Stick / Segment on Click

5. Click Toggle Curve F11 to enable curved routing. The ghost image of the trace(s) 
changes to indicate that curves are used rather than corners.



Interactive Routing Techniques
Routing Curved Trace Patterns

Layout Routing Solutions Guide, X-ENTP VX.2.5 119

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

6. Route the connection(s).

7. (Optional) Select a fixed radius value from the popup menu to define a specific radius 
for the curve.

Note
If you use Multi-Plow mode to route more than one trace, Layout automatically uses 
a variable radius for the curves.

Results

The traces are curved as indicated by the ghost images. Continue routing the selected nets with 
curves.

Related Topics

Curving Existing Trace Corners

Routing Curved Trace Patterns
You can route with curved trace patterns rather than straight trace segments to fit a connection 
through rows of closely spaced pads.

The system automatically calculates the optimum radius to apply to the traces based on the 
clearance values and other routing rules.

Note
Curved trace patterns only work when you are doing interactive routing on single nets or 
differential pairs.
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Procedure

1. Check Curved trace if needed in the Editor Control, Route tab, Angles, Corners 
section. (By default, this option should be checked.)

Tip: If you want to route through rows of tightly spaced staggered pads with any angle 
traces instead of curved traces, use the Keyin Command curves_off. To re-enable the 
curved routing through these areas, use the Keyin Command curves_on.

2. Begin routing using normal interactive routing methods.

3. When you reach a narrow routing channel through a row of closely spaced pads, drag 
the cursor through the row.

The normal straight trace segments change to repeated curved patterns that wrap around 
the pads and allow you to plow through the narrow channel. 
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Related Topics

Curving Existing Trace Corners

Routing Curved Traces

Routing Multiple Connections for the Same 
Net 

You can rapidly route nets on a single layer in uncrowded areas of the design. 

This is an efficient way to manually route sets of netlines that have multiple connection points 
and follow similar patterns, such as memory or data nets.

Video

Procedure

1. Click the starting pad of the first netline to begin interactive routing.

2. Open the popup menu and choose Plow Next Netline on Connect. 

3. Open the popup menu again and choose a mouse-up method:

• Mouse Up Plow Style > Real Trace / Delayed 

• Mouse Up Plow Style > Real Trace / Dynamic 

Note: The Plow Next Netline on Connect command does not work if you attempt to 
route with either Mouse Up Plow Style > Hockey Stick / On Click or Mouse Up Plow 
Style > Segment / On Click. 

4. Open the popup menu again and choose a mouse-drag method:

• Mouse Drag Plow Style > Real Trace / Delayed 

• Mouse Drag Plow Style > Real Trace / Dynamic 

5. Drag the cursor over the next pad for the netline to route the trace. (You do not need to 
click on the pad to make the connection.)

https://support.mentor.com/video/b7bfcb68-d88a-4b95-8ff7-0927b0904dec
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The trace you draw automatically connects to the pad and a new trace extends from that 
point. 

6. Drag the cursor in sequence over the other pads for the remainder of the net.

The traces connect automatically as you drag the cursor over each subsequent pad in the 
net and new traces extend with the cursor.

7. Choose Cancel from the popup menu when you are finished routing the last connection 
point. 
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Note: If you click Undo, all of the traces you created for the net are deleted, not just the 
traces between the last two connection points. 

8. Repeat the procedure to route other nets in the same area with similar connection 
patterns.

Related Topics

Plow and Multi-Plow Modes

Routing Bus Nets Interactively 
Route bus nets interactively by defining the common routing parameters for each net in the bus 
and drawing a bus path to indicate the routing path to follow. 

Once you have indicated the path for the bus, you invoke the Topology Router to complete the 
actual routing.

Prerequisites

• You must have defined the bus nets in Constraint Manager. 

• You must activate the Topology Planner license ( Setup > Licensed Modules > 
Acquire Xpedition Topology Planner) and the Topology Router license ( Setup > 
Licensed Modules > Acquire Xpedition Topology Router). 

Video

Procedure

1. Open Net Explorer by selecting the Net Explorer ( F5) Action Key ( Route > Net 
Explorer). 

2. From the list of net names, select the nets for the bus group.

3. Choose Create User Group from the popup menu and enter a name for the new group. 

https://support.mentor.com/video/93fb7b89-0ab6-4d5c-ad17-2565f6bf72fc
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The new user group appears in Net Explorer under the parent name User Groups. 

4. With the new user group selected, choose Place BusPath from the popup menu and 
draw a bus path in the workspace, then choose Cancel BusPlow to end the bus path at 
the desired location. 

Tip: For clarity, set the Netlines option in the Display Control, Route tab to display the 
netlines for just the bus nets. 
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The bus path defines the general routing path that the Topology Router should follow 
when routing the bus nets. The bus path is saved with the design as a route object for 
future use. 

Tip: You can view or change the bus path properties by selecting the bus path and 
choosing Properties > Bus Path Properties from the popup menu. You can move 
segments of the bus path to change the routing path or delete segments. 

5. Define whether the Topology Router can place vias within the bus path by selecting the 
end segment of the bus path and choosing Toggle Via Preference from the popup menu 
(or select the Toggle Via Preference ( F11) Action Key). 

If you want to... Do the following....

Allow the Topology Router 
to place vias only when 
necessary within the bus 
path

No action required. The default setting for the Via 
Preference state is “No Preference”. 

The end segment of the bus path does not display a 
symbol. 
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Note: The Topology Router attempts to respect the Via Preference option you set, but it 
will violate the Via Preference setting if necessary to complete all of the connections. 

6. Double-click on the bus path to select the entire path, then choose Route Bus Paths 
from the popup menu to start the Topology Router. 

The Topology Router routes the bus nets automatically along the bus path.

Related Topics

Plow and Multi-Plow Modes

Methods for Shielding Buses

Rerouting a Trace
Use the Reroute command to cleanup single traces, multiple traces, or trace segments to 
optimize routes in a given area.

Reroute removes arced corners and existing tuning.

Prevent the Topology 
Router from placing vias 
within the bus path

Choose Toggle Via Preference from the popup menu 
(or select the Toggle Via Preference ( F11) Action 
Key) one time. This sets the Via Preference state to “No 
Bus Vias”. 

The end segment of the bus path displays a crossed out 
“V” (no via) symbol. 

Permit the Topology Router 
to place vias wherever 
possible within the bus path

Choose Toggle Via Preference from the popup menu 
(or select the Toggle Via Preference ( F11) Action 
Key) two times. This sets the Via Preference state to 
“Bus Vias Preferred”. 

The end segment of the bus path displays a “V” (via) 
symbol. 

If you want to... Do the following....
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Reroute works in the following manner:

• Deletes the selected trace or trace segment(s).

• Uses the layer bias and finds a new path to complete the open connection that is created 
by deleting the selected trace object(s).

• Removes hangers and glosses the new trace. A full gloss is done independent of the 
Editor Control Gloss settings.

Prerequisites

• Enable the display of traces.

Procedure

1. Select the traces you want to reroute.

2. Choose Reroute from the popup menu or choose Route > Add Routes > Reroute.

Note
The Reroute command removes Semi-fixed traces but not Fixed or Locked traces. 
To reroute Fixed or Locked traces, you must unlock or unfix those trace segments 

as described in “Manipulating Traces and Vias” on page 128.

Related Topics

Editor Control Dialog Box - Route Tab [Layout Operations and Reference Guide]

Display Control Dialog Box - Edit Tab [Layout Operations and Reference Guide]

Adding Vias During Interactive Routing
Add vias to route connections between different layers of the design.

Prerequisites

• Traces and vias must be made visible in Display Control.

• You must have defined the vias for your design.

Procedure

1. As you route traces, press Add Via (F2) to place vias. The ghost image of the trace 
changes to indicate vias.

2. From the popup menu, choose from the list of via layer spans that are defined for the 
design, then choose the specific via type. 

Note
By default, Layout uses layer spans that match the last vias placed.
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3. If you are routing multiple traces:

a. Spread or converge the traces using Converge In (F6) and Converge Out (F7).

b. Change the via pattern by using Toggle Via (F9) to change the via configurations. 
You can press F9 multiple times until you find the configuration that best suits your 
needs.

Figure 6-2. Examples of Via Configurations.

4. Click to place the vias.

Results

The vias you specify connect the layers. Continue routing on the new layer.

Related Topics

Display Control Dialog Box [Layout Operations and Reference Guide]

Defining Vias [Layout Operations and Reference Guide]

Manipulating Traces and Vias
You can manipulate existing traces and vias to improve routing patterns.

You can move or delete traces and vias. You can also fix or lock traces and vias to prevent them 
from being modified.

For example, if you have routed and tuned a critical net, you may want to fix or lock the traces 
and vias for that net so they are not altered as you route the remainder of the design.

Note
Glossing does not apply to any traces or vias that are fixed, semi-fixed or locked.

Prerequisites

• Traces and vias must be visible and selectable (Display Control, Edit tab, Layer Display 
section and Objects tab, Vias section).
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Procedure

1. Select a trace or via.

Tip
Double-click on a trace segment to select the entire trace length.

2. Do any of the following:

If you want to... Do the following...

Fix a trace or via so it 
cannot be moved, edited 
or deleted

Choose Fix/Lock > Fix from the popup menu.

The graphic representation of the trace changes to 
indicate that it is fixed.

Tip: You can move fixed traces or vias manually 
if you enable Move fixed objects with warning 

in Editor Control, Route tab, Common Settings 
section.

Lock a trace or via so it 
cannot be moved, edited 
or deleted

Choose Fix/Lock > Lock from the popup menu.

The graphic representation of the trace changes to 
indicate that it is locked.

Semi Fix a trace or via so 
it can only be moved or 
deleted manually

Choose Fix/Lock > Semi Fix from the popup menu.

The graphic representation of the trace changes to 
indicate that it is semi-fixed.

Unfix or unlock a trace or 
via

(Available only for traces and vias that are fixed, 
semi-fixed or locked.)

Choose Fix/Lock > Unfix or Unlock from the popup 
menu.

Move a trace or via Drag the trace or via to the desired location and click 
to place it.

Glossing occurs as necessary to make room for the 
trace or via at its new location.

Note: You cannot move component pins with 
traces and vias. If you inadvertently select 

component pins, choose Selection > Selection List 
from the popup menu and remove the pins from the 
group of selected objects.

Rotate a via Select the via, choose Properties > Padstack 
Properties from the popup menu, then specify a new 
rotation angle for the via.

Tip: You can also specify a rotation angle for 
vias that you place manually with the Add Via 

dialog box (choose Route > Add Via menu option).
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Copying Traces
You can copy traces to repeat routing patterns.

The Copy Trace function supports Multiple Via Objects (MVOs)and Complex Vias. For 
example, you can copy a set of traces with complex vias and place them on component pins that 
have the net of the component pin loaded into the traces and complex vias. This way, you can 
create a fanout pattern using complex vias, then copy this pattern to other components or pins.

Prerequisites

• Traces and vias must be visible and selectable in Display Control.

Procedure

1. Select the trace you want to copy. Triple-click to select the entire net. Double-click to 
select the trace between two pins. Doing so selects all segments of the trace, including 
vias.

2. Choose Copy Trace from the popup menu. 

Cross-hairs indicate the placement position for the copied trace.

3. Modify the ghost image of the trace as follows: 

Delete a trace or via Choose Delete from the popup menu (or press 
Delete).

The trace or via is removed. Traces are replaced by 
netlines indicating that the connection is no longer 
complete.

If you want to... Do the following...

Rotate the trace 90 degrees. Press F3.

Mirror the trace horizontally. Press F4.

Push the trace to the next 
active layer.

Press F5.

Mirror the trace vertically. Press F6.

Change the base point of the 
trace.

Press F7. Each time you press F7, the next base point for 
the trace is selected.

Return to the previous base 
point for the trace.

Press F8. Each time you press F8, the previous base point 
for the trace is selected.

Select a base point for the 
trace.

Press F9.

If you want to... Do the following...
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4. Move the cursor such that the ghost image of the trace aligns with the desired position. 

5. Click to place the copied trace at the new location as determined by the current base 
point. 

Note
If you attempt to place a copied trace in a location that violates design connectivity, 
the trace is not placed. The failed placement is indicated in the Status Bar.

6. Move the cursor to the next location and click again. 

Another copy of the trace is placed at the new location.

7. Press Esc to exit Copy Trace mode.

Results

Repeat this process to quickly add multiple traces.

Related Topics

Display Control Dialog Box [Layout Operations and Reference Guide]

Routing with Hug Trace Mode 
Use Hug Trace mode to route a trace alongside the routing path of an existing trace. 

This helps you maintain consistent routing channels and pack traces through dense areas of the 
design.

When you route with Hug Trace mode, the system places a single trace segment at the trace-to-
trace clearance distance from an existing trace, following its routing path as closely as possible 
on the same layer. ( Hug Trace mode does not work across multiple layers.) 

Tip
You can change the default trace-to-trace clearance by using the htc <value> keyin 
command and entering a new clearance value. 

Repeat the trace copy multiple 
times.

1. Press F10. This opens the Copy Trace dialog box.
2. Enter the number of repetitions you want to run and 

click OK. 

The selected trace is copied a number of times equal to 
the value you enter.

If you want to... Do the following...
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Figure 6-3. Example of Hug Trace Mode 

Prerequisites

• A routed trace must already exist to “hug” with the trace you are routing.

Video

Procedure

1. Click Hug Trace ( ) on the Route toolbar ( Route > Hug Trace). 

https://support.mentor.com/video/d14bfe9b-7733-47b0-a12e-acfe78128451
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The Status bar provides information about what to do next while in Hug Trace mode. 

Tip: Press ESC or choose Cancel from the popup menu to exit Hug Trace mode. 

2. Click the pin (or the netline) of the net you want to route.

3. (Optional) Set a trace-to-trace clearance value from the popup menu.

4. Mark the start point for hugging by clicking the desired point on the guide trace.

Note:  Hug Trace mode only operates along a guide trace with continuous segments. If 
the guide trace has T-junctions, vias, testpoints or component pins, Hug Trace mode 
fails. 

An “X” marker appears at the start point you selected. 

5. Mark the end point for hugging by clicking the desired point on the guide trace.

An “X” marker appears at the end point you selected. 
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6. Click the side of the guide trace you want to hug.

The system places a semi-fixed net-assigned trace segment for the new route between 
the user-defined start and end points at the specified clearance distance from the guide 
trace, following its routing path as closely as possible. 

Note:  Hug Trace mode automatically performs push-and-shove on other traces to open 
the pathway required to follow the guide trace. The guide trace is not altered by push-
and-shove. 

7. Click F3 to manually route and complete the connection using Plow mode (see “Plow 
and Multi-Plow Modes” on page 94). 

Tip: You can also assign a new net name to the new trace segment (Route > Assign Net 
Name). 
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Related Topics

Routing with Multiple Hug Traces Mode

Plow and Multi-Plow Modes

Assign Net Name Dialog Box [Layout Operations and Reference Guide]

Routing with Multiple Hug Traces Mode 
Use Multiple Hug Traces mode to route several traces along the routing path of an existing 
trace. 

Multiple Hug Traces mode creates multiple parallel traces simultaneously in a bus fashion. This 
helps you maintain consistent routing channels and pack traces through dense areas of the 
design. 

Prerequisites

• A routed trace must already exist to “hug” with the traces you are routing.

Video

Procedure

1. Open the Multiple Hug Traces dialog box ( Route > Multiple Hug Traces ). 

2. Do one of the following to select the nets you want to route. 

If you want to... Do the following...

Select the nets by 
choosing their names.

1. Ensure that the Graphical net name selection check box 
is unchecked (default). 

2. Enter the number of new traces you want to route in the 
Number of traces text box. 

The number of rows in the Net Name list adjusts 
automatically to correspond to the number you specify. 

3. Click in each Net Name cell and choose the desired net 
from the dropdown list. 

https://support.mentor.com/video/1395650d-b68d-4a3c-bfd5-ca157e6929e9
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3. (Optional) Enter a Separation or Width value for a particular net. 

Note: The Separation value for the first row defines the distance of the first trace from 
the guide trace. The other Separation values define the distance of each additional trace 
from the previous trace. 

4. Click OK or Apply. 

The Status bar provides information about what to do next while in Multiple Hug Traces 
mode. 

Tip: Press ESC or choose Cancel from the popup menu to exit Multiple Hug Traces 
mode. 

5. Mark the start point for hugging by clicking the desired point on the guide trace.

Note:  Multiple Hug Traces mode only operates along a guide trace with continuous 
segments. If the guide trace has T-junctions, vias, testpoints or component pins, Multiple 
Hug Traces mode fails. 

An “X” marker appears at the start point you selected.

6. Mark the end point for hugging by clicking the desired point on the guide trace.

Select the nets 
graphically.

1. Check the Graphical net name selection check box. 
2. In the workspace, click the pin (or the netline) of the first 

net you want to route closest to the guide trace being 
hugged.

The net name appears in the list of Net Names in the 
Multiple Hug Traces dialog box. 

3. Shift + Click the starting pins (or the netlines) for the 
other nets you want to route. 

The other nets are added to the list relative to their 
routing location away from the guide trace being hugged.

If you want to... Do the following...
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An “X” marker appears at the end point you selected. 

7. Click the side of the guide trace you want to hug.

The system places semi-fixed net-assigned trace segments for the new routes between 
the user-defined start and end points at the specified clearance distance from the guide 
trace, following its routing path as closely as possible.
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Note:  Multiple Hug Traces mode automatically performs push-and-shove on other 
traces to open the pathway required to follow the guide trace. The guide trace is not 
altered by push-and-shove. 

8. Click F3 to manually route and complete the connections using Multi-Plow mode (see 
“Plow and Multi-Plow Modes” on page 94). 

Tip: You can also assign new net names to the new trace segments (Route > Assign Net 
Name). 

Related Topics

Routing with Hug Trace Mode

Plow and Multi-Plow Modes

Multiple Hug Traces Dialog Box [Layout Operations and Reference Guide]

Assign Net Name Dialog Box [Layout Operations and Reference Guide]
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Routing Along a Design Object with Hug Trace 
Mode

Use Hug Trace mode or Multiple Hug Traces mode to route traces alongside an existing design 
object. 

This allows you to maximize the available routing channels near the object and is very useful 
for routing flex circuits.

Tip
If you need to route complicated pathways, you can draw a temporary route obstruct for the 
path you need to follow, then hug that obstruct line to make the routed trace segments 

follow the same pattern.

You can hug the following design objects:

• Route border

• Board outline

• Plane outline

• Placement keepout

• Rule area

• Contour

• Route obstruct

• Draw objects
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Figure 6-4. Example of Multiple Hug Traces Mode with Design Object 

Prerequisites

• A design object must already exist to “hug” with the traces you are routing.

Procedure

1. Select the design object to hug.

Tips:

• On a closed polygon, the hugging function follows the polygon in a counter-
clockwise direction. To change the direction, press the Tab key.

• When you select a design object, two points are selected and one section of the 
object is highlighted. To switch to the other section of the selected object, press the 
Tab key.

2. Choose a method depending on the number of traces you are routing: 

If you want to... Do the following...

Route a single 
trace with Hug 
Trace mode.

Follow the procedure described in “Routing with Hug 
Trace Mode” on page 131.
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3. After completing the routes, remember to delete any unneeded design objects from the 
signal layer to avoid potential DRC hazards later.

Related Topics

Routing with Hug Trace Mode

Routing with Multiple Hug Traces Mode

Repairing DRC Violations While Routing
You can route traces through blocked areas and intentionally cause DRC violations, then repair 
those violations immediately. 

This interactive routing method allows you to force traces through clogged routing channels and 
let the system automatically clean up the violations.

Note
The Repair DRC command does not work on a board-wide scale. The system only attempts 
to repair limited, local DRC violations resulting from your most recent routing activity.

Procedure

1. Use any of the interactive routing methods to begin routing.

The normal plow mode pushes and shoves interfering traces out of the way and cleans 
up the surrounding traces so you can complete the routing.

Route several 
traces with 
Multiple Hug 
Traces mode.

Follow the procedure described in “Routing with Multiple 
Hug Traces Mode” on page 135.

If you want to... Do the following...
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2. If you reach a blocked area, uncheck Prohibit Violations in the routing popup menu (or 
uncheck Prohibit violations in the Editor Control, Route tab, Plow section). 

3. Continue routing through any blocked areas to complete the connection.

If the system cannot open a clear routing channel, it allows you to route the connection 
with violations. 

4. Select Analysis > DRC Visualization to update and refresh the display of DRC 
markers.

DRC markers and highlighting appear for any traces that are in violation.

5. Select a trace that is marked as a DRC violation, then choose Repair Selected from the 
popup menu (or select Route > Repair DRC).
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The system automatically attempts to clean up any interfering traces and remove the 
DRC violation for you. 

6. Repeat Step 5, as necessary, to remove any other DRC violations.

Tip: Remember to check Prohibit Violations in the routing popup menu when you 
return to normal interactive routing. 

Related Topics

Verifying While You Place and Route [Layout Verification Guide]

Viewing Violations in Routing (DRC Visualization) [Layout Verification Guide]

Managing Nets with Net Explorer
Use Net Explorer to mark, filter, cross-highlight, and cross-probe nets while you route 
connections. 

You can also create and manage groups of nets.

Procedure

1. Open Net Explorer (choose Route > Net Explorer menu item).
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2. Do any of the following to manage the nets:

Related Topics

Net Explorer [Layout Operations and Reference Guide]

If you want to... View this video...

Mark nets

This video demonstrates how to mark and unmark nets. 
Mark nets so you can display only those nets in the 
workspace.

Filter nets

This video demonstrates how to filter and unfilter nets. 
Filter nets so you can select only those nets in the 
workspace.

Cross-highlight and 
cross-probe nets

This video demonstrates how to cross-highlight and cross-
probe nets between Net Explorer and the design workspace. 
Cross-highlight and cross-probe to find nets more easily.

Create and manage 
groups of nets

This video demonstrates how to create a group of nets and 
manage the group. Group nets together so you can route or 
edit the entire group at one time.

https://support.mentor.com/video/18b4b04c-b1e3-40b5-af9c-733775b6de8e
https://support.mentor.com/video/3d2781b8-569c-415b-bfb6-1543da779cd3
https://support.mentor.com/video/6b690b01-3fd2-4492-9694-6b0b9c91a7c6
https://support.mentor.com/video/6c117b22-6358-4f6d-9c34-45868f7314c9
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Reordering Netlines for Routing
You can adjust the order of the netlines for MST nets to provide a visual guide for interactive 
routing without having to define the netline order as a constraint. 

This allows you to specify how you intend to route a net by arranging the netlines in a particular 
order “on the fly” as you plan the routing strategy.

Note
When you change the order of the netlines, you only change their graphical display. You do 
not change the ordering constraint that applies to the nets in Constraint Editor. The 

reordered netlines do not create new topologies. Also, you cannot validate “on the fly” netline 
order changes with DRC.

The MST netlines in Layout are selectable and editable. You can reorder netlines by connecting 
them to pins, to the ends of trace segments, or to other parts of trace segments.

Procedure

1. Select the netline you want to change.

Editing “handles” appear at the endpoints of the netlines when you select them. 
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2. Click and drag one endpoint of the netline to a new location (a pin or trace on the same 
net). 

The pins highlight to indicate potential connection points as you drag the endpoint of the 
netline.
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3. Release the left mouse button to place the endpoint and reconnect the netline at the new 
location. 

Tip: If you make a mistake, choose Reschedule from the popup menu while the netline 
is still selected. This restores the netline to its original default MST order.

4. Save the design.

Results

The new netline patterns reflect your intended routing strategy and are saved with the design. 
Other designers who route the nets manually can follow the optimized netlines to achieve the 
preferred connection patterns.

Tip
For best results, when you route a trace for a reordered netline, set the Optimize netlines 
option to No (Setup > Editor Control, Route tab, Plow section). This prevents the netlines 

from adjusting as you route and guides you along the reordered path. If you set Optimize 
netlines to Local, the netlines automatically revert to their default MST order as you route 
traces.

Related Topics

Optimizing Netlines for Placement [Layout Planning and Placement Solutions Guide]
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Jumpers
A jumper is a hard wire connection between two pins on the PCB. Jumpers serve two basic 
purposes: 

• In a single layer design, jumpers allow you to “jump” over the etched traces on the board 
and complete connections that would otherwise be impossible because there are no 
crossover routing channels on the single layer.

• In multilayer designs, jumpers may be used as optional, pre-programmed alternative 
routing paths. For example, an engineer may design into the circuit three jumpers to 
provide optional ways to power an LED, but only one way is used for each different 
assembly. A particular jumper is wired for a particular assembly and the other two are 
left empty and unconnected. 

Normally, you assign jumpers to nets in the schematic and place them like any other component 
during parts placement. You create library cells for jumpers in the Cell Editor. You can also add 
jumpers to routed connections (see “Placing a Jumper” on page 150).

Related Topics

Creating a Jumper Cell [Cell Editor User's Guide]

Creating a Part [Common Library Editors User's Guide]

Setting up Jumpers in Layout

Placing a Jumper

Modifying Jumpers

Setting up Jumpers in Layout
Set up jumpers in Layout to specify which jumpers you want to have available for placement.

You can place a jumper as a static cell with fixed length or you can place it dynamically with 
variable length.

Prerequisites

• You must have at least one jumper cell in your Central Library. See “Creating a Jumper 
Cell” in the Cell Editor User’s Guide.

• You must have at least one jumper part associated with the jumper cell in your Central 
Library. See “Creating a Part” in the Common Library Editors User Guide.

Procedure

1. Open the Library Services dialog box (Setup > Libraries > Library Services menu 
item).
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2. In the Import from partition field, select the partition in which you created the new 
jumper part.

The parts in the partition appear in the Parts in import partition list.

3. Select the jumpers you want to use as jumpers in layout. 

4. Move the parts to the Parts to import list by clicking the single arrow button.

5. Click Apply.

6. Open the Jumpers section of the Editor Control dialog box, Place tab (Setup > Editor 
Control, Place tab).

7. Check Press spacebar to add jumper if you want to place a jumper with the spacebar 
during interactive routing. 

Note: If you do not check this option, the space bar places a via during interactive 
routing.

8. Set the Jumper placement angle to either Orthogonal or Any angle. 

Note: Static jumper cells can only be set to Orthogonal.

9. Click Jumper Table.

10. In the jumper table section of the Jumper Table dialog box, select the jumpers you want 
to be available for placement.

11. Under Creation options, choose whether you want to place static jumper cells or place 
jumpers dynamically: 

• If you want to place static jumper cells (fixed length), set Creation options to Use 
static jumper cell data.

• If you want to place jumpers dynamically (variable length), set Creation options to 
Create jumpers dynamically. Set Graphics options as necessary.

12. Click OK.

Results

You are now ready to place jumpers.

Related Topics

Placing a Jumper

Modifying Jumpers

Editor Control Dialog Box [Layout Operations and Reference Guide]

Jumper Table Dialog Box [Layout Operations and Reference Guide]
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Placing a Jumper
You can place a jumper to jump traces or to make a last-minute routing edit outside the normal 
Forward Annotation process.

Prerequisites

• You must have set up your jumper options. See “Setting up Jumpers in Layout” on 
page 148.

Procedure

1. In the Jumper Table dialog box, set the Jumper Table Creation options to Use static 
jumper cell data.

2. Begin interactive routing.

Related Topics

Creating a Part [Common Library Editors User's Guide]

Creating a Jumper Cell [Cell Editor User's Guide]

Modifying Jumpers

Jumper Table Dialog Box [Layout Operations and Reference Guide]

Modifying Jumpers
You can modify a static jumper cell’s orientation, and you can modify a dynamic jumper’s 
length and orientation.

If you want to... Do the following...

Place a static jumper cell 1. Press the space bar or select Route > Jumpers > 
Place Jumper.

The jumper cell appears at the current route location.

2. Continue interactive routing, placing jumpers where 
you want them.

Place a jumper dynamically 1. Press the space bar or select Route > Jumpers > 
Place Jumper.

2. The first pin appears at the current route location.
3. Drag the dynamic jumper to where you want to place 

the second pin and click.
4. Interactive routing continues from the second pin of 

the jumper. Place additional jumpers where 
necessary.
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Procedure

1. Select a pin of the jumper you want to modify.

2. Select Route > Jumpers > Modify Jumper.

The jumper becomes dynamic.

3. Modify the jumper as follows:

• If the jumper is a static cell jumper, you can click to change the orientation of the 
jumper, but only orthogonally.

• If the jumper is a dynamic jumper, the selected pin is attached to the cursor, and you 
can modify the length of the jumper and the rotation by moving the pin.

Related Topics

Placing a Jumper

Multiple Via Objects
A Multiple Via Object (MVO) is an array of two or more vias that are grouped together and 
enclosed by a conductive shape. 

An MVO is most useful for increasing the current carrying capacity of inter-layer connections 
for high voltage nets. An MVO carries more current between layers than a single via does.

You can define the number of vias to include in an MVO and its rotation, and you can assign 
appropriate padstack types and layer spans.

Figure 6-5. Multiple Via Object Example 

The conductive shape of the MVO appears on each layer where the via pads are defined. The 
conductive shape is treated as a single pad by the pad entry rules.
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MVO Definition

You define MVOs with a side file that contains information about the via types to use, the 
number of vias that should be in each array, and where to apply the different MVOs in the 
design. When you define an MVO side file, you set up default conditions in the local design 
database for placement of the MVOs during routing. See “MultiViaRules.hkp File Format” on 
page 152.

MVO Placement

MVOs are associated with particular trace widths within a scheme (rule area). If you have 
defined an MVO that applies to the scheme (rule area) and the netclass you are currently 
routing, the specified MVO appears when you change to the designated trace width while 
routing interactively within the rule area. 

You can also place MVOs on surface mount component pads.

If you define MVOs and apply them to specific schemes (rule areas) in the design, the 
Autorouter also places them automatically when autorouting within those rule areas.

MVOs and Planes

The vias for an MVO connect to planes as solid fills within the conductive shape of the MVO. 
They are not connected with thermal relief pads. The conductive shape for the MVO merges 
with the plane shape. When an MVO is part of a net that is different from the plane net, the 
default plane clearance value applies around the conductive shape of the MVO.

Related Topics

Defining Multiple Via Objects

Routing with Multiple Via Objects

Placing Multiple Via Objects on Component Pads

Modifying Multiple Via Objects

Overview of Interactive Routing

MultiViaRules.hkp File Format
The MultiViaRules.hkp file stores the definitions for Multiple Via Objects (MVOs). 

Create or update the MultiViaRules.hkp side file using the Multiple Via Objects dialog box. The 
file is located in your local design project directory under .../PCB/config.
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Note
The definitions in the side file MultiViaRules.hkp are not saved with the design database. If 
you make changes to an existing side file by editing it manually, you must close the design 

and open it again for the side file changes to take effect.

Parameters

Use the following keywords to define the MultiViaRules.hkp file 
Table 6-3. MultiViaRules.hkp Keywords 

Keyword Description

Header section — This section identifies the side file and specifies certain 
global parameters in the design. 

Note: The header section must be followed by a blank line.

.FILETYPE MULTIVIA_RULES Defines the side file as an MVO rules 
file.

.VERSION “xx.xx.xx” Defines the version number of the side 
file within quotes. This is not the 
version number of the Layout 
software. Use this to track revisions to 
the side file.

.CREATOR “author or company 
name”

Defines the name of the author of the 
side file or company name within 
quotes. Use this for identification only.

.DATE “day month date year time” Defines the date when the side file was 
last edited. This text string must be 
contained within quotes.

.UNITS xx Specifies the units of measure used in 
the design file: in, th, mm, um. The 
UNITS value must match the units 
setting in the design.

.PHYSICAL_LAYERS nn Specifies the number of layers in the 
design file. The 
PHYSICAL_LAYERS value must be 
the same as the number of layers in the 
design.

Rule Definition section — This section defines the rule sets for each MVO 
type. 

Note: The rule definition section must be followed by a blank line.

.MVO_RULE_SET “rule name” Defines a unique name for the MVO 
rule set. The rule name must be 
contained within quotes.
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..VIASPAN Begins the rule set definition for a 
particular via span.

...LAYER_NUM_RANGE (n,n) Defines the layer range for the via 
span. The beginning and ending layer 
numbers must be contained within 
parentheses.

...PADSTACK “padstack name” Specifies the padstack for the MVO 
vias. The padstack name must be 
contained within quotes. Each 
padstack must exist in the padstack 
library.

...MVO_RULE Begins the MVO rule definition for a 
particular trace width. 

You can define multiple MVO rules 
for different trace widths within a 
single rule set.

....WIDTH_EQUAL_OR_GREATER 
nn

Assigns the MVO to any traces that 
are equal to or greater than the 
specified trace width. Each line width 
value must match a line width defined 
in Constraint Manager.

....VIA_COUNT n Defines the number of vias for the 
MVO array.

Scheme and Net Class Assignment section — This section assigns the MVO 
rule sets to specific schemes (rule areas) and net classes in the design. 

Note: Each scheme and net class assignment must be followed by a blank line.

.NET_CLASS_SCHEME “scheme 
name”

Begins the MVO rule assignments for 
the specified scheme (rule area) name. 
The scheme name must be contained 
within quotes. Each scheme must be 
defined in Constraint Manager.

You can assign multiple rule sets for 
different net classes to a single 
scheme.

..NET_CLASS “net or net class name” Specifies the net name or net class 
name The name must be contained 
within quotes.

Table 6-3. MultiViaRules.hkp Keywords  (cont.)

Keyword Description
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...USE_MVO_RULE_SET “rule 
name”

Specifies the name of the MVO rule 
set to assign to the net class scheme. 
The rule name must be contained 
within quotes.

Table 6-3. MultiViaRules.hkp Keywords  (cont.)

Keyword Description
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Example

The following is an example of a MultiViaRules.hkp file:

.FILETYPE MULTIVIA_RULES 

.VERSION "0
3.02
" 
.CREATOR "
MENTOR GRAPHICS CORPORATION
" 
.DATE "Monday, May 01, 2012 9:15am" 
.UNITS 
TH 
.PHYSICAL_LAYERS 
6 
 
.MVO_RULE_SET "(Default)" 
..VIASPAN 
...LAYER_NUM_RANGE (
1,6
) 
...PADSTACK "(Default Via)" 
...MVO_RULE 
....WIDTH_EQUAL_OR_GREATER 
25 
....VIA_COUNT 
2 
 
.MVO_RULE_SET "
BGA_POWER
" 
..VIASPAN 
...LAYER_NUM_RANGE (
2,5
) 
...PADSTACK "
(BGAVIA)
" 
...MVO_RULE 
....WIDTH_EQUAL_OR_GREATER 
25 
....VIA_COUNT 
2 
...MVO_RULE 
....WIDTH_EQUAL_OR_GREATER 
50 
....VIA_COUNT 
4 
 
.NET_CLASS_SCHEME "(Master)" 
..NET_CLASS "POWER" 
...USE_MVO_RULE_SET "(Default)" 
 
.NET_CLASS_SCHEME "
BGA_RULE1
" 
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..NET_CLASS "
POWER
" 
...USE_MVO_RULE_SET "
BGA_POWER
" 
..NET_CLASS "
(Default)
" 
...USE_MVO_RULE_SET "
BGA_POWER
" 

Related Topics

Defining Multiple Via Objects

Routing with Multiple Via Objects

Placing Multiple Via Objects on Component Pads

Modifying Multiple Via Objects

Defining Multiple Via Objects
Define Multiple Via Objects (MVOs) using the Multiple Via Objects dialog box, where you 
specify the number of vias in the array and the schemes (rule areas) that use the MVOs. 

Prerequisites

• You must have defined the padstacks you want to use for the MVOs.

• You must have defined the schemes (rule areas) where you want to apply the MVOs.
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Procedure

1. Open the Multiple Via Objects dialog box (Setup > Advanced Setup > Multiple Via 
Objects).

Note
If you have not defined any MVOs previously, the dialog box is blank.

2. In the Rule Set section, define or select a rule set.

3. Define a via pattern:

a. Select the appropriate padstack from the Padstacks and spans list.

b. In the Via patterns section, define or select the appropriate Trace Width and Via 
Count values, and choose a Via Pattern.

c. (Optional) Repeat Steps a - b to define multiple via patterns for the same rule set.

The via patterns that are defined for each rule set are indicated in bold text.
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4. In the Rule Assignment section, choose the appropriate net and scheme (rule area) to 
apply to the rule set.

5. (Optional) Repeat this process to define other rule sets and assignments.

6. Click OK to save the MVO definitions and make them available for use in the design.

Results

The MVO definitions you create are saved in the side file MultiViaRules.hkp, located in your 
local design project directory under .../PCB/Config.

You are ready to route with the MVOs you defined for the different schemes and net classes.

Related Topics

MultiViaRules.hkp File Format

Routing with Multiple Via Objects

Placing Multiple Via Objects on Component Pads

Modifying Multiple Via Objects

Creating a Padstack [Common Library Editors User's Guide]

Creating Rule Area Schemes [Constraint Manager User's Manual]

Routing with Multiple Via Objects
Place Multiple Via Objects (MVOs) while you are routing a net interactively.

Prerequisites

• You must create and save a side file MultiViaRules.hkp that defines the MVO types and 
specifies the rule areas and net classes where the MVOs apply. See “Defining Multiple 
Via Objects” on page 157.

• You must have created rule areas that correspond to the rule area scheme you defined in 
Constraint Manager.

Procedure

1. Start routing a net that is assigned MVOs using any of the interactive routing methods. 
See Overview of Interactive Routing.
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2. As you route into a rule area where MVOs apply, change the trace width in one of the 
following ways: 

Changing to a different trace width that has an assigned MVO enables the use of that 
MVO as you continue routing.

3. Double-click to place the MVO.

The system places the MVO that is defined for that rule area, net class, and trace width 
instead of the default via. 

Tip: You can rotate the MVO, move it, or change the via array if necessary. See 
“Modifying Multiple Via Objects” on page 163.

4. Continue to route the net interactively and double-click to place additional MVOs where 
needed to complete the connection.

If you want to... Do the following....

Change the width with 
the key-in command.

1. In the design window, begin typing cw (change 
width). The command window appears.

2. Enter a space and the width value in the 
command, then press Enter. (Examples: cw 50, 
cw 25)

Change the width with 
the popup menu.

Choose Widths from the popup menu, then choose 
the trace width from the list that has the MVO 
assignment.
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As you drag the cursor within the rule area, a ghost image of the MVO attaches to the 
cursor. 

Note: The ghost image of the MVO does not appear initially when you change trace 
widths until you click the cursor.

Related Topics

Defining Multiple Via Objects

Placing Multiple Via Objects on Component Pads

Modifying Multiple Via Objects

Multiple Via Objects

Creating Rule Areas

Placing Multiple Via Objects on Component 
Pads

You can place Multiple Via Objects (MVOs) on large surface mount pads while routing 
interactively. 

This allows you to tie the pad directly to planes or other signal layers for high voltage 
connections.
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Prerequisites

• You must create a side file MultiViaRules.hkp that defines the MVO types and specifies 
the rule areas and net classes where the MVOs apply. See “Defining Multiple Via 
Objects” on page 157.

• The component pad must be located within a rule area where MVOs are defined and the 
pad size must be large enough to enclose the MVO.

• You must enable the Allow via under pad option in the Pad Entry dialog box (Setup > 
Editor Control, select the Route tab, expand the Dialogs section, then click Pad 
Entry).

• You must have created rule areas that correspond to the rule area scheme you defined in 
Constraint Manager.

Procedure

1. Select the component pad and route a short stub trace within the pad area.

2. Change the trace width in one of the following ways: 

Changing to a different trace width that has an assigned MVO enables the use of that 
MVO.

3. Double-click where you want to place the MVO within the pad area.

The system places the MVO defined for that rule area, net class, and trace width within 
the component pad. 

4. (Optional) Rotate the MVO or change the number of vias in the MVO array so it fits 
within the area of the surface mount pad. See “Modifying Multiple Via Objects” on 
page 163.

Related Topics

Defining Multiple Via Objects

Routing with Multiple Via Objects

Modifying Multiple Via Objects

If you want to... Do the following....

Change the width with 
the key-in command.

1. In the design window, begin typing cw (change 
width). The command window appears.

2. Enter a space and the width value in the 
command, then press Enter. (Examples: cw 50, 
cw 25)

Change the width with 
the popup menu.

Choose Widths from the popup menu, then choose 
the trace width from the list that has the MVO 
assignment.
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Multiple Via Objects

Creating Rule Areas

Modifying Multiple Via Objects
You can modify a Multiple Via Object (MVO) that you have placed in the design to change its 
rotation, the number or type of vias used, or to break up the MVO into its separate elements.

Note
You can only change one MVO at a time; you cannot make global changes to all existing 
MVOs.

Procedure

Modify MVOs using any of the following methods.

If you want to... Do the following....

Change the pattern of the vias and the 
number of vias.

1. Right-click the MVO, then choose Change MVO 
Pattern from the popup menu.

2. Choose the desired pattern from the cascading menu. 
Note: Depending on the new pattern you choose, the 
number of vias changes to create the new pattern.

Change the padstack for the vias. 1. Right-click the MVO, then choose Properties > 
Padstack Properties from the popup menu.

2. In the Padstack Properties dialog box, select a different 
padstack from the Padstack dropdown list. 

3. (Optional) Make any other changes to the padstack 
properties, as needed.

4. Click Apply.

Rotate the MVO. 1. Right-click the MVO, then choose Rotate MVO from 
the popup menu.

Tip: Choose Set MVO Rotation if you want to rotate 
the selected MVO and at the same time define the 
default rotation for any future MVOs that you place.

2. Choose the desired rotation angle from the cascading 
menu.

Move the MVO. Click the MVO and drag it to the desired location.

Dissolve the MVO into its separate 
elements so they are no longer grouped 
together.

Right-click the MVO, then choose Dissolve MVO from 
the popup menu.

Note: Once you dissolve an MVO, you cannot regroup the 
individual elements into an MVO again.
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Related Topics

Defining Multiple Via Objects

Routing with Multiple Via Objects

Placing Multiple Via Objects on Component Pads

Multiple Via Objects

Stacked and Merged Vias
You can open up more routing channels and reduce the complexity of the design by overlapping 
vias of the same net during interactive routing. 

There are two types of overlapping vias: stacked vias and merged vias. The system generates 
both types automatically when you push or place one via too close to another via of the same 
net.

Stacked Vias

A stacked via consists of two vias that have the same (x,y) coordinate location, share at least one 
layer in common, and are attached to the same net. Create a stacked via by moving one of the 
vias on top of the other so that their origins are the same (coincident). Once they are stacked, the 
two vias are combined and cannot be separated, but they retain their distinct definitions as 
different vias (layer spans, padstacks, clearance rules).

Merged Vias

A merged via consists of two vias that have the same (x,y) coordinate location, share at least 
two layers (one dielectric) in common, and are attached to the same net. At least one of the vias 
must be a stitch via (a via that is part of a via array tied to a plane). Create a merged via by 

Delete the MVO. Click the MVO and press Delete.

Note: If you delete an MVO, you disconnect the joined 
traces and leave an open connection for the net.

If you want to... Do the following....
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moving one of the vias on top of the other so that their origins are the same (coincident). Once 
they are merged, the two vias become a single via definition.

Related Topics

Setup Parameters Dialog Box - Via Clearances Tab [Layout Operations and Reference Guide]

Add Via Dialog Box - Stitch Contour Tab [Layout Operations and Reference Guide]

Add Via Dialog Box - Stitch Shape Tab [Layout Operations and Reference Guide]



Layout Routing Solutions Guide, X-ENTP VX.2.5166

Interactive Routing Techniques
Crankshaft Via .vpt File Format

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Crankshaft Via .vpt File Format
A .vpt file is required for each crankshaft via in the design.

The .vpt file defines the properties of a crankshaft via.

Create or edit a .vpt file using a standard text editor. Save the .vpt file to the ...\PCB\Config 
directory of your design project. You can have multiple .vpt files in this directory, one for each 
type of crankshaft via you need. The name of the .vpt file is the name that appears in the popup 
menu when you select the crankshaft via for placement.

Format
VPTable:Index;ViaSpan;ViaPadstack;OffsetX;OffsetY;

VPTable:Index;ViaSpan;ViaPadstack;OffsetX;OffsetY;

...

Parameters

• Index

Defines the sequential order of the VPTable entries. Use whole numbers (1,2,3...).

• ViaSpan

Defines the layer span for the via, expressed as 1-2, 2-4, 4-8, and so forth.

• ViaPadstack

Specifies the name of the padstack for the via.

• OffsetX

Defines the offset in the X axis.

• OffsetY

Defines the offset in the Y axis.
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Examples

The following .vpt file shows a basic crankshaft via definition for a 6 layer design with routing 
layers 1, 2, 5, 6. All of the padstacks are the same.

Related Topics

Adding Crankshaft Vias During Interactive Routing

Adding Crankshaft Vias During Interactive 
Routing 

Add crankshaft vias while you are interactively routing a net to optimize power delivery in 
package designs.

A crankshaft via is a custom via configuration that includes multiple vias defined on different 
layer spans.

Figure 6-6. Crankshaft Via Example
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Prerequisites

• Each crankshaft via you intend to use must be defined with a separate definition file. See 
“Crankshaft Via .vpt File Format” on page 166.

Procedure

1. Start routing a net using any of the interactive routing methods. See “Overview of 
Interactive Routing” on page 92.

2. Choose the desired crankshaft via from the popup menu, then press the number key for 
the layer where you want to connect the next trace. (For example, press “5” to connect to 
layer 5.)

A ghost image of the crankshaft via attaches to the cursor.

3. Rotate the cursor to position the crankshaft via cluster in the preferred arrangement.

4. Click to place the crankshaft via.

All of the pads and interconnecting traces that make up the crankshaft via are placed in 
the location and arrangement you specify.

Note
After you place a crankshaft via, each pad and trace in the cluster is a separate entity. 
Use normal editing techniques to edit the pads and traces.

5. Continue routing on the specified layer and complete the connection. Place additional 
crankshaft vias where needed.

Adding Complex Vias During Interactive 
Routing

Add complex vias while you are interactively routing a net to accommodate special routing 
requirements that you might encounter, such as in RF and analog designs.

A complex via is a user-defined custom via pattern used for special routing conditions. (See 
“Complex Vias” on page 329.)

Prerequisites

• Each complex via pattern you intend to use must have been defined in the .../PCB/
Config/ComplexViaPatterns.dat file. See “Creating Complex Vias” on page 331.

Procedure

1. Start routing a net using any of the interactive routing methods. See “Overview of 
Interactive Routing” on page 92.
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2. Choose the desired complex via pattern from the popup menu, then choose the layer 
number from the popup menu where you want to connect the next trace.

A ghost image of the complex via attaches to the cursor.

3. Rotate the cursor to position the complex via in the preferred orientation.

4. Click to place the complex via.

5. Continue routing on the specified layer and complete the connection. Place additional 
complex vias where needed.

Note
The last complex via pattern you chose from the popup menu is automatically set as 
the default pattern for placing additional complex vias. Choose a different pattern 

from the popup menu, if desired.

Related Topics

Add Via Dialog Box - Interactive Tab [Layout Operations and Reference Guide]
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Chapter 7
Sketch Routing Techniques

Use Sketch Router to route large groups of nets semi-automatically by drawing a general 
routing path to follow.

Sketch Router routes the selected nets along the path you specify with results that mimic 
manually routed traces.

Sketch Router Workflows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171

Sketch Routing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172

Sketch Router Via Patterns  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174

Sketch Routing Styles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177

Specifying the Netlines for Sketch Router . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178

Routing With a Sketch Path . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179

Routing Without a Sketch Path . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185

Modifying a Sketch Path . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187

Routing Buses by Reusing a Sketch Path  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 188

Sketch Router Workflows
You can use Sketch Router three different ways for various routing situations.
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Figure 7-1. Sketch Router Workflows

Related Topics

Specifying the Netlines for Sketch Router

Routing With a Sketch Path

Routing Without a Sketch Path

Modifying a Sketch Path

Sketch Routing

Sketch Router Via Patterns

Sketch Routing Styles

Sketch Routing
Sketch Router uses autorouting algorithms to route a group of netlines based on a path and 
direction that you “sketch” to define the general routing pattern (Sketch Path) the traces should 
follow.

The results closely resemble what you would achieve by routing manually.
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Figure 7-2. Example of Sketch Router Results 

Sketch Router routes netlines, not entire nets, that start and end in the same general area of the 
design. If you do not select specific netlines to be routed, Sketch Router automatically selects 
netlines based on their proximity to the start and end points of the Sketch Path. If you select 
route objects such as pins, vias or traces, Sketch Router attempts to route the netlines attached to 
those objects if no other netlines are selected.

Sketch Router vs Multi-Plow

Sketch Router offers advantages over using Multi-Plow mode for routing groups of netlines. 
Use Sketch Router instead of Multi-Plow mode based on your routing requirements.

Table 7-1. Comparison of Sketch Router vs Multi-Plow 

Characteristics Sketch Router Multi-Plow

General application Routes a specific set of netlines 
that start and end in the same 
general area.

Routes large numbers of netlines 
efficiently.

Routes any set of selected 
netlines.

Best used for routing a limited 
number of netlines.

Netline selection Selects a set of netlines 
automatically with the Sketch 
Path.

Selects a set of netlines manually.

Route completion Applies automated routing 
algorithms to complete the 
routing along the specified 
Sketch Path.

Requires manual routing with 
limited, semi-automated 
assistance.
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Related Topics

Specifying the Netlines for Sketch Router

Routing With a Sketch Path

Routing Without a Sketch Path

Modifying a Sketch Path

Sketch Router Workflows

Sketch Router Via Patterns

Sketch Routing Styles

Sketch Router Via Patterns
While drawing a Sketch Path, you can choose from several different via patterns to apply to the 
routes if you want to change layers.

Figure 7-3. Via Pattern Symbol 

The color of the symbol is the color of the starting layer for routing.

(A) The arrow indicates the direction the traces will exit a via pattern.

(B) The via symbol indicates a single or double row via pattern.

(C) The traces symbol indicates the direction the traces will enter a via pattern.

Route quality Closely mimics the results from 
manual routing.

Quality is acceptable but may 
need additional cleanup or 
glossing. 

Table 7-1. Comparison of Sketch Router vs Multi-Plow  (cont.)

Characteristics Sketch Router Multi-Plow
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Table 7-2. Sketch Routing Via Patterns 

Via Pattern Description Routing Example

Automatic

(default)

Vias are added in a pattern 
chosen automatically to 
achieve the highest 
completion rate. 

Note: You cannot rotate an 
Automatic via pattern.

Note: The via pattern chosen for 
Automatic can be any of the other 
patterns.

Arbitrary Vias are added in an 
arbitrary and irregular 
pattern to untangle the 
routes and achieve the 
highest completion rate.

Note: You cannot rotate an 
Arbitrary via pattern.

Direct 

Single

Vias are added in a single 
row pattern that does not 
change the order of the 
netlines.

Reverse 

Single

Vias are added in a single 
row pattern that reverses 
the order of the netlines.

Direct 
Double

Vias are added in a double 
row pattern that does not 
change the order of the 
netlines.
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You can rotate the single and double via patterns counter-clockwise at 45 degree increments 
from 0 degrees to 180 degrees. You can also rotate the via patterns clockwise. To rotate counter-
clockwise, specify a positive angle in the popup menu. To rotate clockwise, specify a negative 
angle.

Figure 7-4. Rotated Via Patterns 

Note
In some cases, depending on how the traces will exit the via pattern, an “X” may appear on 
the via pattern to indicate that the rotation you specified is invalid.

Related Topics

Specifying the Netlines for Sketch Router

Routing With a Sketch Path

Routing Without a Sketch Path

Modifying a Sketch Path

Sketch Router Workflows

Sketch Routing

Sketch Routing Styles

Reverse 
Double

Vias are added in a double 
row pattern that reverses 
the order of the netlines.

Table 7-2. Sketch Routing Via Patterns  (cont.)

Via Pattern Description Routing Example
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Sketch Routing Styles
You can choose two different styles of routing with Sketch Router: unpacked and packed. 

Table 7-3. Comparison of Sketch Routing Styles 

Routing Style Characteristics

Unpacked 

(default)

The unpacked style is most effective at routing through areas that are 
not particularly dense. The priority is to minimize the number of 
segments as opposed to packing the routes along the Sketch Path.

Example: 
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Related Topics

Specifying the Netlines for Sketch Router

Routing With a Sketch Path

Routing Without a Sketch Path

Modifying a Sketch Path

Sketch Router Workflows

Sketch Routing

Sketch Router Via Patterns

Specifying the Netlines for Sketch Router
Use Net Explorer to display only those netlines you want to route with Sketch Router. 

This allows you to control exactly which nets Sketch Router attempts to route before you begin 
drawing the Sketch Path.

Packed The packed style is more effective at routing through areas that are 
crowded with closely spaced routes or pins. This option forces 
Sketch Router to route with the minimum allowable trace-to-trace 
clearance values and achieves more closely packed routing patterns. 
The routed traces are centered around the Sketch Path.

Example: 

Table 7-3. Comparison of Sketch Routing Styles  (cont.)

Routing Style Characteristics
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Procedure

1. Click the Net Explorer Action Key (F5) to open Net Explorer.

2. Click Unmark All ( ) to turn off the display of all netlines.

3. Select the net for the specific netlines you want to route, then click Mark/Unmark 
Selected ( ).

The Marked “M” column shows an asterisk for each net name you selected.

4. Choose the View > Display Control menu item, click the Objects tab, then check the 
Netlines section.

5. Expand the Netlines section, then expand “Netlines for Marked Comps and Nets”.

6. Check only “From Marked Nets”. (Uncheck all other options.)

Only the nets you selected are visible and selectable in the workspace.

Tip
Zoom the workspace around the netlines so you can draw the Sketch Path more 
accurately.

Results

The netlines you want to route are selectable by Sketch Router when you begin drawing the 
Sketch Path. You are now ready to draw the Sketch Path and route the netlines.

Related Topics

Routing With a Sketch Path

Routing Without a Sketch Path

Sketch Router Workflows

Sketch Routing

Display Control Dialog Box - Objects Tab

Routing With a Sketch Path 
Use Sketch Router to route buses and other groups of netlines that start and end in the same 
general area.

Sketch Router applies semi-automated routing algorithms to route the netlines by following the 
routing path you sketch. The path that the routes follow is called the Sketch Path. By default, the 
Sketch Path is free-form: the path curves and tracks the motion of the cursor however you draw 
it. You can also draw a line-form Sketch Path (45 degrees) for more precise definition of the 
routing pattern.
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Figure 7-5. Example of a Line-Form Sketch Path 

If you start a new Sketch Path on the endpoint of an existing Sketch Path, you can extend the 
existing Sketch Path. 

Restrictions and Limitations

• You cannot edit or move an existing Sketch Path; you must redraw it if you want to 
define a different routing pattern. 

• If you start a new Sketch Path in a different location, any other existing Sketch Path is 
deleted. (Only one Sketch Path can exist in the design.) 

• You can select a Sketch Path and delete it.

• Sketch Paths are not persistent and they are not saved with the design.

• Sketch Router does not add teardrops during the routing process even if “Dynamic 
Teardrops” is enabled.
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Video

Procedure

1. (Optional) For better routing results with the Sketch Router, prepare the design in the 
following ways:

a. Use Net Explorer and Display Control to organize the nets you want to route so you 
can view, select, and control the routing of specific sets of netlines more easily.

b. Use IO Designer to swap pins for the netlines in a manner that minimizes netline 
crossovers so Sketch Router can achieve higher completion rates.

c. Use interactive routing methods to fanout entire BGAs prior to routing the whole 
design to be sure the fanout traces do not block potential via locations.

2. (Optional) Specify the netlines you want to route (see “Specifying the Netlines for 
Sketch Router” on page 178). 

3. Select the layer where you want to begin routing by pressing the appropriate layer 
number on the keyboard (or choose the layer from the popup menu).

4. Begin drawing the Sketch Path in one of the following ways:

• Click the Draw Sketch Action Key (F8).

• Choose the Route > Draw Sketch menu item.

Tip
If you double-click the icon, you will be in Sketch Path drawing mode and you 
will remain in that mode until you click the icon again to exit the mode.

5. Choose your preferred routing style (Unpacked or Packed) in one of the following ways 
(see “Sketch Routing Styles” on page 177): 

• Click the Toggle Route Style Action Key (F11).

• Choose Route Style from the popup menu. 

https://support.mentor.com/video/06b3f36e-95a1-4023-afa4-3d15d688d11a
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6. Choose your preferred sketch style (free-form or line-form) in one of the following 
ways:

• Click the Toggle Sketch Style Action Key (F10).

• Choose Sketch Style from the popup menu.

Tip
The current route style and sketch style are shown in the status bar.

7. Click a location in the design to start the Sketch Path, then drag the Sketch Path along 
the path you want the routes to follow. 

If you did not specify previously which netlines should be routed, the netlines are 
selected automatically based on their proximity to the start and end points of the Sketch 
Path.

Tip
You can also select pins, vias, or traces, in which case Sketch Router attempts to 
route the netlines attached to those objects if no other netlines are selected.

8. (Optional) Change layers by clicking to place an anchor point and then press the 
appropriate new layer number on the keyboard (or choose the new layer from the popup 
menu).

The Sketch Path changes color to match the new layer and shows the via pattern.
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Tip
You can change the via pattern or rotate it (see “Modifying a Sketch Path” on 
page 187).

9. Continue drawing the Sketch Path by dragging the cursor until you reach the desired end 
point, then click (or choose Finish Drawing from the popup menu) to complete the 
path.

The Sketch Path defines the general routing pattern you want the selected netlines to 
follow.

10. (Optional) Modify the Sketch Path if necessary (see “Modifying a Sketch Path” on 
page 187).

Tip
If you make a mistake drawing the Sketch Path, click the Undo Action Key (F6) (or 
choose Exit from the popup menu) to remove the entire Sketch Path and start over.

11. Route the traces in one of the following ways:

• Double-click to end the Sketch Path and start Sketch Router automatically.

• Click the Sketch Route Action Key (F9). 
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• Choose Sketch Route from the popup menu.

Tip
If you click elsewhere in the design after you draw the Sketch Path and the 
netlines become unselected, click the Draw Sketch Path icon ( ) and the 

netlines become selected again. 

Results

If you are attempting to route a large number of netlines, Sketch Router may take several 
minutes to complete the routing. You can interrupt Sketch Router by pressing Esc. Sketch 
Router stops and any routes that have been created are deleted. The Sketch Path is also deleted. 
Redraw the Sketch Path along a different routing channel or reduce the number of netlines to 
enable Sketch Router to complete the routes more efficiently. 

If Sketch Router determines that some of the selected netlines start or end too far away from the 
majority of selected netlines, those netlines will be ignored and Sketch Router will not attempt 
to route them. You may need to redraw the Sketch Path more precisely to enable Sketch Router 
to complete the routes for all of the selected netlines.

Related Topics

Specifying the Netlines for Sketch Router

Routing Without a Sketch Path

Modifying a Sketch Path

Sketch Router Workflows
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Sketch Routing

Routing Without a Sketch Path 
Use Sketch Router to quickly route a selected group of netlines without drawing a Sketch Path 
to follow.

Sketch Router attempts to route the selected netlines along the best possible routing path it can 
determine, much like an Autorouter. With this method, you do not have control over the routing 
path.

Video

Procedure

1. (Optional) For better routing results with the Sketch Router, prepare the design in the 
following ways:

a. Use Net Explorer and Display Control to organize the nets you want to route so you 
can view, select, and control the routing of specific sets of netlines more easily.

b. Use IO Designer to swap pins for the netlines in a manner that minimizes netline 
crossovers so Sketch Router can achieve higher completion rates.

c. Use interactive routing methods to fanout entire BGAs prior to routing the whole 
design to be sure the fanout traces do not block potential via locations.

https://support.mentor.com/video/fec478e2-e48e-45c9-8d63-4e03f6c86a35
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2. Specify the netlines you want to route (see “Specifying the Netlines for Sketch Router” 
on page 178), or select them graphically in the workspace.

Tip
You can also select pins, vias, or traces and Sketch Router will attempt to route the 
net-selected netlines even if no other netlines are selected.

3. Route the traces in one of the following ways:

• Click the Sketch Route Action Key (F9).

• Choose Sketch Route from the popup menu.

Results

If you are attempting to route a large number of netlines, Sketch Router may take several 
minutes to complete the routing. You can interrupt Sketch Router by pressing Esc. Sketch 
Router stops and any routes that have been created are deleted. Try reducing the number of 
selected netlines to enable Sketch Router to complete the routes more efficiently.
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Related Topics

Specifying the Netlines for Sketch Router

Routing With a Sketch Path

Sketch Router Workflows

Sketch Routing

Modifying a Sketch Path 
If Sketch Router does not route as well as you expected, you can undo the routing and modify 
the existing Sketch Path to achieve better results.

Video

Procedure

1. Perform any of the following operations: 

If you want to... Do the following...

Extend the Sketch Path 1. Select the Sketch Path.
2. Click on the end point of the Sketch Path, then 

drag it along the extended path you want the 
routes to follow to the new end point.

Change the via pattern 1. Select the via pattern symbol.
2. Do one of the following:

• Click the Add Via Pattern Action Key (F2).
• Choose SR Via Pattern from the popup menu 

and select the desired pattern. 
See “Sketch Router Via Patterns” on page 174. 

https://support.mentor.com/video/b60b16ea-20a3-4632-a3d3-3d9a23f70792
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2. (Optional) After making the necessary modifications to the Sketch Path, click the path to 
select it, then do one of the following to route the traces: 

• Click the Sketch Route Action Key (F9).

• Choose Sketch Route from the popup menu.

Related Topics

Specifying the Netlines for Sketch Router

Routing With a Sketch Path

Routing Without a Sketch Path

Sketch Router Workflows

Sketch Routing

Routing Buses by Reusing a Sketch Path 
You can route large numbers of netlines (buses) in stages by using the same single-layer Sketch 
Path more than once.

You can reuse the Sketch Path to route some of the netlines on one layer and others on a 
different layer, but still retain the same routing pattern on each layer.

This method is most useful when you need to route large buses on multiple layers and want the 
routing patterns to be similar (or even overlap) on all layers.

Note
You can only reuse a Sketch Path if the path is defined on a single layer. You cannot reuse a 
Sketch Path that spans multiple layers.

Rotate the via pattern 1. Select the via pattern symbol.
2. Do one of the following:

• Click either the Rotate 45 (F4) or the Rotate 
90 (F5) Action Key. 

• Choose SR Via Pattern from the popup menu 
and select the desired rotation. 

See “Sketch Router Via Patterns” on page 174. 

Delete the Sketch Path 1. Select the Sketch Path.
2. Press Delete (or choose Delete from the popup 

menu). 

If you want to... Do the following...
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Video

Procedure

1. (Optional) For better routing results with the Sketch Router, prepare the design in the 
following ways:

a. Use Net Explorer and Display Control to organize the nets you want to route so you 
can view, select, and control the routing of specific sets of netlines more easily. (See 
“Setting the Display Control for Interactive Routing” on page 95.)

b. Use interactive routing methods to fanout entire BGAs prior to routing the whole 
design to be sure the fanout traces do not block potential via locations. (See 
“Routing Fanouts Interactively” on page 41.)

https://support.mentor.com/video/44845cab-6e0d-4619-ad7f-53ed6a7a9912
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2. Draw a Sketch Path on a single layer for the netlines you want to route. (See “Routing 
With a Sketch Path” on page 179.)

3. Select a subset of the netlines, then click the Sketch Route Action Key (F9).
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Only the netlines you selected are routed. The Sketch Path disappears.

4. Select the next subset of netlines you want to route following the same pattern.

5. (Optional) Choose a different layer from the popup menu to make it the new active 
routing layer.

6. Click the Draw Sketch Action Key (F8), then click the Reuse Last Sketch Action Key 
(F8).
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The original Sketch Path re-appears. 

7. Click the Sketch Route Action Key (F9).
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The netlines are routed alongside the first set of traces in a similar routing pattern. The 
Sketch Path disappears.

8. Repeat Steps 4 - 7 as needed to finish routing all of the netlines in the bus.

Related Topics

Specifying the Netlines for Sketch Router

Routing With a Sketch Path

Sketch Router Workflows

Sketch Routing
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Chapter 8
Sketch Planning Techniques

Use Sketch Planner to plan how you want to route buses or other groups of netlines. 

Sketch Planner . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195

Sketch Planner Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196

Creating a Sketch Plan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

Assigning Netlines to a Sketch Plan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200

Modifying a Sketch Plan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202

Routing a Sketch Plan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204
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Sketch Planner
You can use Sketch Planner to plan specific routing pathways for groups of netlines and achieve 
the best routing results.

What is the difference between a Sketch Path and a Sketch Plan?

Sketch Paths and Sketch Plans are both bundles of netlines that follow a predetermined routing 
pathway. They allow you to direct the routing of the assigned netlines. Unlike traces and 
components in the design, they are not physical entities.

A Sketch Path is a one time temporary means of routing a group of netlines quickly. You can 
only create one active Sketch Path at a time within a design. A Sketch Path is not saved with the 
design and you can only modify it in limited ways.

A Sketch Plan is a more permanent way to plan the routing of a group of netlines. You can 
define multiple Sketch Plans for different groups of netlines within a design. Sketch Plans are 
saved with the design and you can modify them in various ways.

You can create a Sketch Path in the same design where you have created Sketch Plans. Both 
Sketch Paths and Sketch Plans use the same Sketch Router routing engine to route netlines. 
When you route, all of the selected Sketch Plans are routed as well as any Sketch Path you may 
have created.
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What is Sketch Planner?

You draw a Sketch Plan to indicate the routing pathway you want selected netlines to follow. A 
Sketch Plan defines how specific selected netlines should be routed. It does not route complete 
nets. You can assign one netline of a particular net to one Sketch Plan and assign another netline 
of the same net to a different Sketch Plan. You cannot assign the same netline to two different 
Sketch Plans.

You can draw multiple Sketch Plans to define the routing pathways for many different groups of 
netlines. Sketch Plans are saved with the design. You can modify existing Sketch Plans to 
change their patterns. You can also change which netlines are assigned to Sketch Plans. You 
control the display of Sketch Plans the same way you control the display of netlines.

Related Topics

Sketch Planner Workflow

Creating a Sketch Plan

Creating Sketch Plans for Planning Groups

Sketch Routing

Sketch Planner Workflow
You can achieve the best results if you follow the recommended workflow for creating Sketch 
Plans.
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Figure 8-1. Sketch Planner Workflow 

You can create and route as many Sketch Plans as you need for multiple groups of netlines.

Related Topics

Creating a Sketch Plan

Assigning Netlines to a Sketch Plan

Modifying a Sketch Plan

Routing a Sketch Plan

Sketch Planner

Creating a Sketch Plan 
Create a Sketch Plan to define a precise routing path for a bus or other group of netlines and 
force the routing to follow that path as closely as possible. 

A Sketch Plan provides accurate control over how the netlines are routed and often improves 
routing completion rates.

You can create multiple Sketch Plans and save them with the design. 
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Creating a Sketch Plan is very similar to routing a trace manually.

Prerequisites

• The “Xpedition Layout 201” license (or higher) has been acquired by checking the 
appropriate option in the Available Licenses dialog box when you opened Layout.

Video

Procedure

1. Set up the display of Sketch Plans in Display Control:

a. Choose the View > Display Control menu item to open Display Control. 

b. Click the Objects tab, then check the Netlines section.

c. In the Objects tab, check and expand the Route/Multi Planning section, then check 
“Sketch Plans”.

Note
The “Sketch Plans” option does not apply to the 3D View. Sketch Plans are 
always visible in the 3D View if you check “Netlines” in the 3D tab, Objects 

section.

d. (Optional) Expand the “Sketch Plans” option, then check “Width” to display Sketch 
Plans with the estimated width of the assigned netlines.

If the Sketch Plan crosses a Rule Area, the width of the Sketch Plan within the Rule 
Area adjusts automatically to reflect the different trace width and clearance rules that 
apply to the Rule Area.

Note
The “Width” option does not apply to the 3D View. Sketch Plans in the 3D View 
always display with their true width.

e. (Optional) Open a 3D View (Window > Add 3D View menu item), click the 3D tab 
in Display Control, check and expand the Objects section, then check “Netlines” to 
view Sketch Plans in the 3D View.

https://support.mentor.com/video/fe2ed2a4-859f-4460-ba65-05fdbdcfea06
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2. (Optional) Use Net Explorer to mark and display only the netlines you want to route. 
See “Managing Nets with Net Explorer” on page 143.

3. In Display Control, click the Edit tab, expand the Layer Display section, then choose the 
appropriate layer to set it as the active layer for drawing the Sketch Plan.

4. Choose the Route > Draw Sketch Plan menu item.

Tip
Choose the View > Toolbars > Sketch Plan menu item to display the Sketch Plan 
toolbar. This gives you quick access to the basic functions for drawing and editing 

Sketch Plans.

5. Choose Toggle Draw Style from the popup menu to select your preferred drawing style.

6. (Optional) Click the Toggle Route Style Action Key (F11) to apply either the Packed or 
Unpacked style to the Sketch Plan you are drawing.

Note
For best results, use the Packed routing style. The Unpacked routing style follows a 
more direct, straight line path and does not adhere to the Sketch Plan as closely as 

the Packed style does.

7. Click in the workspace to locate the start of the Sketch Plan, then drag the cursor and 
continue to draw the Sketch Plan to its termination.

Tip
To change to a different layer while drawing the Sketch Plan, type the new active 
layer number. The system inserts a via pattern and switches to the new layer for 

continuing the Sketch Plan. See “Modifying a Sketch Plan” on page 202 to edit the via 
pattern.

8. Click at the termination point to exit the drawing mode (or choose Finish Drawing from 
the popup menu, depending on your Route Style).

Note
The Sketch Plan you draw automatically identifies and selects the netlines that are 
closest to it. If you double-click to terminate the Sketch Plan, the selected netlines 

are automatically assigned to the Sketch Plan. You should make specific netline 
assignments to be sure the correct netlines are associated with the Sketch Plan.

9. Assign the netlines to the Sketch Plan. See “Assigning Netlines to a Sketch Plan” on 
page 200.

10. (Optional) Do the following to link the display of the Sketch Plan netlines to the visible 
layers: In Display Control, click the Graphic tab, expand the Graphics Options section, 
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expand the General subsection, then check “Link Sketch Netline Display to Layer 
Visibility”.

When you check this option, the Sketch Plan netlines are only visible when you turn on 
the visibility for the layers where the Sketch Plan is defined. For example, if you define 
the Sketch Plan on layer 3 but layer 3 is not currently visible, you do not see the netlines 
for the Sketch Plan. If you uncheck this option, the netlines are always visible even if the 
layers are not.

Related Topics

Assigning Netlines to a Sketch Plan

Modifying a Sketch Plan

Routing a Sketch Plan

Creating Sketch Plans for Planning Groups

Sketch Planner

Sketch Planner Workflow

Sketch Routing

Assigning Netlines to a Sketch Plan
You can assign netlines to a Sketch Plan or remove netlines that are already assigned.

This allows you to control exactly which netlines are routed with the Sketch Plan.

Restrictions and Limitations

The following limitations apply when you attempt to assign netlines to a Sketch Plan. Under 
any of these circumstances, the netlines are not added.

• One end of the netline is connected to floating geometry (the object it is connected to 
does not have a netline to, and is not connected to, another schematic pin). For example, 
a netline that goes from a pin to a floating trace, or a netline that goes from a pin to a 
non-schematic test point, cannot be added to a Sketch Plan.

• Ordered All netlines cannot be added to Sketch Plans.

• Ordered Open netlines cannot be added to a Sketch plan if one of the pins in the net is 
unplaced and is between the two end pins of the netline. For example, suppose you have 
a three pin ordered netline (U1-1 ties to U2-2 ties to U3-3). If you unplace the middle 
component (U2), then the remaining netline from U1-1 to U3-3 cannot be added to a 
Sketch Plan.

• Netlines that already belong to a bus path or to a Sketch Plan cannot be added to a 
different Sketch Plan.
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• Netlines connected to plane shapes cannot be added to a Sketch Plan.

Prerequisites

• The “Xpedition Layout 201” license (or higher) has been acquired by checking the 
appropriate option in the Available Licenses dialog box when you opened Layout.

• The display of Sketch Plans has been enabled in Display Control. See “Creating a 
Sketch Plan” on page 197.

Procedure

Do any of the following:

Tip
Alternately, choose the View > Toolbars > Sketch Plan menu item to display the 
Sketch Plan toolbar. This gives you quick access to the basic functions for drawing 

and editing Sketch Plans.

If you want to... Do the following...

Assign netlines while 
drawing the Sketch Plan

1. Select the netlines you want to assign.
2. Choose the Route > Draw Sketch Plan menu 

item.
3. Click in the workspace to locate the start of the 

Sketch Plan, then drag the cursor and continue to 
draw the Sketch Plan to its termination.

4. Double-click at the termination point to exit the 
drawing mode and automatically assign the 
selected netlines to the new Sketch Plan.

Assign netlines to an 
existing Sketch Plan

1. Select the netlines you want to assign.
2. Shift-click on an existing Sketch Plan to select it 

as well.
3. Choose Sketch Plans > Add from the popup 

menu.

Remove netlines from an 
existing Sketch Plan

1. Select the netlines you want to remove from a 
particular Sketch Plan.

2. Choose Sketch Plans > Remove from the popup 
menu.



Layout Routing Solutions Guide, X-ENTP VX.2.5202

Sketch Planning Techniques
Modifying a Sketch Plan

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Note
If you check “Width” for “Sketch Plans” in Display Control, the width of the Sketch 
Plan you edit adjusts automatically to reflect the new or removed netlines. The width 

of the Sketch Plan also reflects shield traces and vias if you assign a shielding rule to the 
Sketch Plan.

If a Sketch Plan crosses a Rule Area, the width of the Sketch Plan within the Rule Area 
adjusts automatically to reflect the different trace width and clearance rules that apply to 
the Rule Area.

Tip
Do the following to link the display of the Sketch Plan netlines to the visible layers: 
In Display Control, click the Graphic tab, expand the Graphics Options section, 

expand the General subsection, then check “Link Sketch Netline Display to Layer 
Visibility”. With this option enabled, when you turn off the visibility of the layers for the 
Sketch Plan, the Sketch Plan netlines do not display.

Related Topics

Creating a Sketch Plan

Creating Sketch Plans for Planning Groups

Modifying a Sketch Plan

Sketch Planner

Modifying a Sketch Plan 
You can modify a Sketch Plan in various ways.

Modifying a Sketch Plan is very similar to modifying traces. DRC and push-and-shove 
functionality do not apply to Sketch Plans, however.

Prerequisites

• The “Xpedition Layout 201” license (or higher) has been acquired by checking the 
appropriate option in the Available Licenses dialog box when you opened Layout. 

• The display of Sketch Plans has been enabled in Display Control. See “Creating a 
Sketch Plan” on page 197.
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Video

Procedure

Perform any of the following operations: 

Tip
Alternately, choose the View > Toolbars > Sketch Plan menu item to display the 
Sketch Plan toolbar. This gives you quick access to the basic functions for drawing 

and editing Sketch Plans.

If you want to... Do the following...

Show the width of a 
Sketch Plan

Check “Sketch Plans” and “Width” in Display 
Control, Objects tab, Route/Multi Planning section.

Extend the end points of a 
Sketch Plan

Click either end point of the Sketch Plan and drag it 
to a new location.

The rest of the Sketch Plan adjusts in real time as 
you move the end point.

Move segments of a 
Sketch Plan

Click the segment of the Sketch Plan you want to 
move, then drag the segment to the new location. 

The rest of the Sketch Plan adjusts in real time as 
you move the segment.

Add a new segment to a 
Sketch Plan

1. Click on a segment, then click again (2-point 
select) at a different part of the same segment.

A new segment is created within the original.

2. Drag the new segment to relocate it.

Change the layer of a 
Sketch Plan segment

1. Select a segment. (Select the entire Sketch Plan 
to change the layer for the Sketch Plan.)

2. Choose the new active routing layer with the up/
down arrow keys.

3. Click the Push Trace Action Key (F5). 
Note: Via patterns are inserted automatically at the 
end points of the selected segment.

https://support.mentor.com/video/1648074d-8004-48e0-960e-621fbaaa1f82
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Related Topics

Creating a Sketch Plan

Assigning Netlines to a Sketch Plan

Routing a Sketch Plan

Creating Sketch Plans for Planning Groups

Sketch Planner

Routing a Sketch Plan 
You can route a single Sketch Plan or several selected Sketch Plans at the same time. 

You can route the netlines completely from point to point, or you can choose to route only the 
trunk of the Sketch Plan.

Sketch Router applies semi-automated routing algorithms to route the netlines by following the 
Sketch Plans as closely as possible. 

Change the via patterns 1. Select the via pattern symbol.
2. Do one of the following:

• Click the Toggle Via Pattern Action Key (F3) 
to toggle through the via patterns. 

• Choose SR Via Pattern from the popup menu 
and select the desired via pattern. 

See “Sketch Router Via Patterns” on page 174.

Rotate the via patterns 1. Select the via pattern symbol.
2. Do one of the following:

• Click either the Rotate 45 (F4) or the Rotate 
90 (F5) Action Key.

• Choose Rotate SR Via Pattern from the 
popup menu and select the desired rotation. 

Note: Sometimes a rotation setting is skipped if 
it is impossible to route that specific rotation. 

See “Sketch Router Via Patterns” on page 174.

Delete a Sketch Plan 
segment

1. Select a segment. (Select the entire Sketch Plan 
to delete it.)

2. Press Delete (or choose Delete from the popup 
menu). 

If you want to... Do the following...
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If you have not created fanouts for surface mount pads, Sketch Router automatically generates 
them during the routing process.

Prerequisites

• The “Xpedition Layout 201” license (or higher) has been acquired by checking the 
appropriate option in the Available Licenses dialog box when you opened Layout.

• The display of Sketch Plans has been enabled in Display Control. See “Creating a 
Sketch Plan” on page 197.

Video

Procedure

1. Select the Sketch Plans you want to route.

2. Choose one of the following from the popup menu:

Tip
Alternately, choose the View > Toolbars > Sketch Plan menu item to display the 
Sketch Plan toolbar. This gives you quick access to the basic functions for drawing 

and editing Sketch Plans.

If you want to... Do the following...

Route the netlines 
completely

Choose Sketch Plans > Route (or click the Sketch 
Route Action Key (F9)). 

Route only the trunk of 
the Sketch Plan

Choose Sketch Plans > Route Trunk.

Note: If you route only the trunk, you need to 
complete the routing manually for each individual 
netline at both ends of the Sketch Plan.

https://support.mentor.com/video/f1344e9a-8ce8-431f-870d-90238bd800ee
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Results

The Sketch Plans are routed based on the routing command you choose. After the routing is 
completed, the Sketch Plans disappear. They are still saved with the design database and appear 
again if you perform an Undo or delete the routed traces. 

Related Topics

Creating a Sketch Plan

Swapping Nets

Sketch Planner

Shielding Rules for Sketch Plans
You define and assign shielding rules for Sketch Plans in Net Explorer, and you can override 
those shielding rule assignments when necessary.
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Shielding Rule Definitions in Net Explorer

In Net Explorer, a shielding rule definition consists of the following properties:

• A unique name for the shielding rule

• The net you want to assign to the shielding traces (typically, power or ground)

• Whether the shielding traces should be routed only on the outside of the signal traces or 
between them

• The number of shielding traces that should be routed between the signal traces

• Which layers are allowed for routing the shielding traces

To shield a Sketch Plan, you must first define a shielding rule with the appropriate properties.

Shielding Rule Assignments in Net Explorer

After you define a shielding rule, you assign the rule to the nets you want to shield. In Net 
Explorer, you assign shielding rules to User Groups, not to individual nets. If the nets you want 
to shield are not part of a User Group, you must create a new User Group that includes those 
nets. 

The netlines you include in a Sketch Plan automatically inherit the shielding rule assignments 
you make in Net Explorer for the corresponding nets. The rules assigned in Net Explorer have 
the name format “Inherited(rule_name)” when you open the Assign Shielding Rules dialog box.

Shielding Rule Overrides

You assign a single predefined shielding rule to all of the netlines in a Sketch Plan using the 
Assign Shielding Rules dialog box. The system saves the shielding rule assignment with the 
Sketch Plan.

The shielding rule you assign in this dialog box overrides any inherited shielding rule 
assignments in Net Explorer, but it does not change the rule assignments for nets in Net 
Explorer. If the Sketch Plan does not have a shielding rule assignment initially, the override 
assignment does not create shielding rule assignments for the corresponding nets in Net 
Explorer.

Shielding Rule Conflicts

All of the netlines in a Sketch Plan must have the same shielding rule assignment. Because a 
Sketch Plan attempts to route a group of netlines in a similar pattern, the system cannot route a 
Sketch Plan that has two or more conflicting shielding rule assignments. (This situation may 
occur if different netlines inherit conflicting rules, or if you assign the inherited rule 
“Inherited(_mixed_)” to the Sketch Plan.) If the netlines in a Sketch Plan have different 
shielding rules, warning messages appear in the Assign Shielding Rules dialog box.
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You can have multiple Sketch Plans in a design, each of which has a different shielding rule 
assignment. When you route those Sketch Plans, the system follows the shielding rule for each, 
as long as the same shielding rule applies to all of the netlines within a particular Sketch Plan.

Resolution of Shielding Rule Conflicts

If a Sketch Plan has conflicting shielding rule assignments, you can resolve the conflicts in any 
of the following ways:

• Assign a shielding rule override — This is the recommended method for resolving rule 
conflicts. Use the Assign Shielding Rules dialog box to assign a single override rule that 
applies to all of the netlines in the Sketch Plan.

• Remove netlines from the Sketch Plan — Identify which netlines have different, 
conflicting shielding rule assignments and remove them from the Sketch Plan. You can 
create a new Sketch Plan that mimics the routing path of the existing Sketch Plan and 
has a different shielding rule assignment.

• Change the shielding rule assignments in Net Explorer — In Net Explorer, edit the 
shielding rule assignments for the nets/netlines that are included in the Sketch Plan so 
that all of the nets are assigned the same shielding rule. The Sketch Plan automatically 
recognizes any changes you make to the shielding rule assignments in Net Explorer.

Related Topics

Adding Shielding to a Sketch Plan

Defining Shielding Rules with Net Explorer

Assign Shielding Rule Dialog Box [Layout Operations and Reference Guide]

Assign Shielding Rules Dialog Box [Layout Operations and Reference Guide]

Adding Shielding to a Sketch Plan 
You can assign a shielding rule to a Sketch Plan and shield the traces when you route the Sketch 
Plan.

Prerequisites

• The “Xpedition Layout 201” license (or higher) has been acquired by checking the 
appropriate option in the Available Licenses dialog box when you opened Layout.

• The display of Sketch Plans has been enabled in Display Control. See “Creating a 
Sketch Plan” on page 197.

• A Sketch Plan has been created in the design.

• A shielding rule has been created in Net Explorer. See “Defining Shielding Rules with 
Net Explorer” on page 287.
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Video

Procedure

1. Select the Sketch Plan, then do any of the following to assign a shielding rule to the 
netlines in the selected Sketch Plan:

Tip
Alternately, choose the View > Toolbars > Sketch Plan menu item to display the 
Sketch Plan toolbar. This gives you quick access to the basic functions for drawing 

and editing Sketch Plans.

If you want to... Do the following...

Assign shielding rules to 
nets in Net Explorer

See “Defining Shielding Rules with Net Explorer” 
on page 287.

The Sketch Plan inherits the shielding rule 
assignments from Net Explorer and routes the 
shielding traces accordingly unless you assign an 
override shielding rule.

https://support.mentor.com/video/93d1e7b1-86b6-4b3a-b540-f34e6943267a
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If you check “Width” for “Sketch Plans” in Display Control, the width of the Sketch 
Plan changes to include shield traces and vias when you assign a shielding rule to the 
Sketch Plan.

2. With the Sketch Plan selected, choose Sketch Plans > Route trunk from the popup 
menu.

Note
The Sketch Router is not designed to generate and completely route shielding traces 
if you choose Sketch Plans > Route from the popup menu. 

The system automatically routes the shielding traces in trunk mode, based on the 
shielding rule you assign.

3. (Optional) Complete the routing manually for both the signal traces and the shielding 
traces using the interactive Plow methods.

Related Topics

Creating a Sketch Plan

Routing a Sketch Plan

Defining Shielding Rules with Net Explorer

Shielding Rules for Sketch Plans

Adding Shielding Rules to Constraint Classes

Assign a shielding rule 
that overrides shielding 
rules inherited from Net 
Explorer

1. Choose Sketch Plans > Assign shielding rules 
from the popup menu.

2. In the Assign Shielding Rules dialog box, select 
the shielding rule you want to assign to the 
Sketch Plan, then click OK.

The assigned shielding rule is saved with the 
Sketch Plan and overrides any shielding rule 
assignments for nets in Net Explorer.

Note: Do not select the rule 
“Inherited(_mixed_)”. This indicates that in 

Net Explorer, conflicting shielding rules are 
assigned to different nets that are included in the 
Sketch Plan.

All of the netlines that are included in a Sketch 
Plan must have the same shielding rule 
assignment. If some netlines have different, 
conflicting shielding rules, the system cannot 
route the shielding traces.

If you want to... Do the following...
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Assign Shielding Rules Dialog box [Layout Operations and Reference Guide]

Creating Sketch Plans for Planning Groups
You can use Sketch Plans to refine the placement of planning groups and plan the routing 
pathways between the groups more accurately.

When you move the planning groups, the netlines of the Sketch Plans adjust dynamically to 
accommodate the placement changes.

Prerequisites

• The “Xpedition Layout 201” license (or higher) has been acquired by checking the 
appropriate option in the Available Licenses dialog box when you opened Layout.

• Two or more component planning groups have been placed in the design.

Video

Procedure

1. Enable the display of Sketch Plans and select the active layer in Display Control:

a. Choose the View > Display Control menu item to open Display Control.

b. Click the Objects tab, check and expand the Route/Multi Planning section, then 
check “Sketch Plans” and “Width”.

c. Click the Edit tab, expand the Layer Display section, then choose the desired layer.

2. Choose the Route > Draw Sketch Plan menu item.

Tip
Alternately, choose the View > Toolbars > Sketch Plan menu item to display the 
Sketch Plan toolbar. This gives you quick access to the basic functions for drawing 

and editing Sketch Plans.

3. Choose Toggle Draw Style from the popup menu to select your preferred drawing style.

https://support.mentor.com/video/1ba4e545-84dd-4730-ae5e-b3cc049f5c11
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4. Click near the center of a planning group to start the Sketch Plan, then drag the cursor 
and continue to draw the Sketch Plan to its termination near the center of another 
planning group (or to a single component, such as a connector).

5. Double-click at the termination point to exit the drawing mode. 

Note
The Sketch Plan automatically identifies and selects the netlines that connect 
between the two planning groups. When you double-click to terminate the Sketch 

Plan, the selected netlines are automatically assigned to the Sketch Plan. 
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Results

The Sketch Plan shows the estimated width of the netline bundle that connects the two planning 
groups. The default group netline bundle that previously represented the connections 
disappears.

Related Topics

Creating a Sketch Plan
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Modifying a Sketch Plan

Sketch Planner

Placement Planning With Groups [Layout Planning and Placement Solutions Guide]
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Chapter 9
Autorouting Techniques

Use the Autorouter to complete connections automatically based on predefined parameters that 
control which nets are routed, what kind of routing occurs, and how the routing is 
accomplished. 

Overview of Autorouting with Layout. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215

Setting up the Autorouter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 217

Autorouting a Design. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220

Spreading and Centering Traces with the Spread Pass . . . . . . . . . . . . . . . . . . . . . . . . . . 222

SpreadTo.txt File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225

Autorouting with Fences . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226

Autorouting with Target Areas  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 228

Autorouting Critical Nets Separately  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231

Autorouting Unpacked Areas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233

Autorouting High Density Interconnect (Microvia) Designs . . . . . . . . . . . . . . . . . . . . . . 234

Evaluating the Autorouter Progress  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236

Overview of Autorouting with Layout
The Autorouter is a shape-based router that is most effective at routing large numbers of nets in 
a batch mode.

Once you have defined the routing rules for the nets and have set up the autorouting parameters, 
the Autorouter attempts to route the nets according to those rules. If the Autorouter does not 
achieve 100% completion, you may need to adjust the autorouting parameters or even the net 
rules and retry the autorouting process again.
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Figure 9-1. Autorouter Workflow 

Autorouter Passes

The Autorouter runs through several passes to route the selected nets. Each pass focuses on a 
particular routing task or style, such as generating fanout patterns, routing without using vias, or 
tuning critical traces. You specify which passes to run and the ordering of the passes.
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To achieve the best possible routing results for a particular design, take care to define the passes 
and arrange them in a sequence that is appropriate for the design. Typically, run the Fanout and 
Memory passes first, then use the Route pass, and finally apply the special passes (Tune, 
Smooth, Via Min). You can use certain passes for special situations (Bus, Remove Hangers, 
Expand, Spread).

Related Topics

Setting up the Autorouter

Evaluating the Autorouter Progress

Strategies for Routing PCB Designs

Auto Route Dialog Box [Layout Operations and Reference Guide]

Setting up the Autorouter
For best routing results, set the appropriate autorouting parameters to match the characteristics 
of your design.

The Autorouter defaults to a predefined scheme of parameters you can use for general 
autorouting purposes. In most cases, however, you will achieve better autorouting results if you 
customize the setup by defining which routing passes to run and the correct sequence to run 
them, which nets and net classes to route, which layers should be enabled, and other grid and via 
parameters.

Prerequisites

• You must have activated the Layout 151 (or higher) license in the Available Licenses 
dialog box when you opened the design database if you are routing High Density 
Interconnect (HDI) designs.

Note: An HDI design is any design that employs high connection density and microvia 
structures: laser-drilled vias, skip vias, blind/buried vias, or any other vias that require 
some form of multi-laminate process for via construction. You define these microvia 
structures in the Via Definitions tab of the Setup Parameters dialog box (Setup > Setup 
Parameters > Via Definitions tab).
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Procedure

1. Open the Auto Route dialog box (Route > Auto Route). 

2. Define the appropriate passes and the order for routing them based on the characteristics 
of the design: 

Autorouting Task and Order Recommended Pass Type

1. Fanouts and escapes Simple Fanout 

Fanout 

2. Memory Memory 

Straight Line Interconnect 

3. Critical nets No Via 

No Via or Bias 

Tune Delay 

Tune Crosstalk 

Partial Route 

4. Buses Bus Route 

5. Shielding Bus Shielding 

6. Non-critical nets Route 
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3. For each autorouting pass:

a. Choose the nets or net classes to route under Items to Route.

o Choose the specific nets or net classes that the Autorouter should consider for the 
pass. For example, choose bus nets for a Bus Routing type pass.

o Choose All Nets for autorouting all of the remaining unrouted nets.

b. Specify which nets to route first under Order: autoroute the longest netlines first or 
the shortest netlines first.

o Choose Auto for general autorouting needs. 

o Choose Longest First or Shortest First depending on the design requirements.

o Choose Custom for special routing situations such as critical nets.

c. Specify the effort level.

Choose values in the Start and End columns for the effort you want the Autorouter 
to apply to the pass. The higher the effort level, the more the Autorouter applies 
push-and-shove, rip-up and retry, adds vias, and deviates from the defined layer bias.

Typically, you start a pass with Level 1 and end it with the highest level so the 
Autorouter can progressively increase the effort as it works through the unrouted 
nets of a pass.

d. Enable the routing layers.

o Choose the layers or layer pairs for routing during the pass.

o Use the Editor Control dialog box to enable routing on particular layers.

e. Define the via and route grids.

o Choose Default to apply the grid settings defined in Editor Control. 

o Choose None if you have a route grid defined in Editor Control but do not wish 
to apply that setting.

Tip: In general, you will achieve the best autorouting results if you do not apply a 
route grid.

7. Cleanup Remove Hangers 

Smooth 

Expand 

Spread 

Via Min 

Autorouting Task and Order Recommended Pass Type
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4. Specify the AutoSave Interval and other autorouting options.

5. Save the autorouting settings as a new scheme so you can reuse the settings later.

Related Topics

Autorouting a Design

Saving, Modifying, and Reusing Settings and Assignments With Schemes [Layout Operations 
and Reference Guide]

SpreadTo.txt File

Overview of Autorouting with Layout

Auto Route Dialog Box [Layout Operations and Reference Guide]

Editor Control Dialog Box [Layout Operations and Reference Guide]

Autorouting a Design
Use the Autorouter to route large groups of nets rapidly.

The most effective way to use the Autorouter is to run a sequence of autorouting passes one at a 
time, with each pass defined to accomplish a particular routing goal (such as fanout of BGAs or 
autorouting memory chips). Allow the Autorouter to pause after each pass is complete so you 
can examine the results before proceeding with the next pass. If the results are not satisfactory 
for a particular pass, change the setup parameters and rerun that pass before proceeding with the 
remaining passes. By fine-tuning the pass definitions with each iteration, you will achieve the 
best overall routing results for the whole design.

Figure 9-2. Typical Sequence of Autorouting Passes 

Alternately, if you are confident of the pass sequence and the setup parameters, you can enable 
all of the passes and route them one after the other without pausing to evaluate the results of 
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each individual pass. This approach usually does not produce the best final results across the 
whole design unless you have experience autorouting previous designs that used similar setup 
definitions.

Prerequisites

• You must have activated the Layout 151 (or higher) license in the Available Licenses 
dialog box when you opened the design database if you are routing High Density 
Interconnect (HDI) designs. 

Note: An HDI design is any design that employs high connection density and microvia 
structures: laser-drilled vias, skip vias, blind/buried vias, or any other vias that require 
some form of multi-laminate process for via construction. You define these microvia 
structures in the Via Definitions tab of the Setup Parameters dialog box (Setup > Setup 
Parameters > Via Definitions tab).

• You have acquired the “Xpedition Layout 151” license (or higher) by checking the 
appropriate check box in the Available Licenses dialog box when you opened Layout if 
you are routing Tune passes.

• The Topology Router license must be activated (Setup > Licensed Modules > Acquire 
Xpedition Topology Router) if you are routing Bus passes.

• You must have defined any special routing rules and constraints for the critical nets in 
Constraint Manager.

Procedure

1. Open the Auto Route dialog box (Route > Auto Route).

2. Define the appropriate routing passes and parameters. See “Setting up the Autorouter” 
on page 217. 

3. Use the Editor Control dialog box ( ), Route tab to enable routing on particular layers 
and to set up other routing parameters such as layer bias, pad entry, and push-and-shove.

4. Check the Pass checkbox for the pass you want to route and uncheck all of the other 
passes.

5. Click Route.

The Autorouter attempts to route the nets you specified for the pass according to the 
routing parameters you defined.

6. Monitor the Session Status Table to evaluate the Autorouter progress.

7. When the Autorouter has completed the pass, examine the routed traces to determine if 
the results are satisfactory:

• If the routed traces are not satisfactory, click Undo Auto Route ( ), adjust the 
autorouting parameters for the pass, then click Route to reroute the pass.
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Note: The Undo Auto Route command will undo everything up to and including 
the last autorouting session, including any editing you may have done.

• If the routing is satisfactory, repeat Step 4 through Step 7 for each of the remaining 
passes you have defined.

Tip: Fix any critical routes so they are not rerouted later when you autoroute other nets. 
You can instruct the Autorouter to fix the traces automatically by checking Fix in the 
Auto Route dialog box for any passes you want to protect.

Related Topics

Setting up the Autorouter

Evaluating the Autorouter Progress

Autorouting with Fences

Autorouting Critical Nets Separately

Manipulating Traces and Vias

Specifying Trace and Via Rules [Constraint Manager User's Manual]

Auto Route Dialog Box [Layout Operations and Reference Guide]

Editor Control Dialog Box [Layout Operations and Reference Guide]

Spreading and Centering Traces with the 
Spread Pass

You can improve the PCB manufacturing processes by distributing the copper more uniformly 
on each routing layer.

Use the Spread pass in the Autorouter to space the trace patterns more evenly across the routing 
layers and center the traces between component pads and vias . 

Figure 9-3. Spreading Example 
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The Spread pass is compute-intensive, so it may take significant time to complete. You should 
run the Spread pass only after you have completely routed the design. As you increase the 
maximum distance, the Spread pass adds additional jogs and the traces become less smooth.

Tip
The Spread pass does not push traces over via or pin pads. Because of this, you may want to 
move some traces before running the Spread pass. This maximizes spreading and prevents 

extra jogs in traces that are trapped between vias in open spaces.

Prerequisites

• Before autorouting, fix or lock all traces that you do not want the Spread pass to modify, 
especially traces for high speed nets that include tuning.

Procedure

1. Create the side file (SpreadTo.txt in ...PCB/Config) that defines the layers for spreading 
and the maximum spread distance. 

Note: If you attempt to run the Spread pass without defining the side file first, the 
autorouter returns an error message and aborts the routing. 

2. Open the Auto Route dialog box (Route > Auto Route). 

3. In the Pass definition list, define a new pass as Pass Type: Spread and check it. (If you 
are autorouting multiple passes, run the Spread pass last.)

4. Under Options, check Allow “Cleanup” if not routed 100%. 

5. Click Route.

If you want to... Do the following...

Increase the clearances 
slightly

Define smaller maximum spread clearance values in 
the side file (for example, 5th to 7th). This allows 
traces with a net class clearance less than the 
maximum spread clearance to spread away from 
vias, pads, and other traces with minimal changes to 
the trace geometries.

Center traces between 
pads

Increase the maximum spread clearance values in 
the side file. The values you define are specific to 
the parts involved: for standard parts, a value of 
20th or 25th should be sufficient. Note that 
increasing the maximum spread clearance to allow 
centering may modify the trace geometries 
significantly.
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Related Topics

Autorouting a Design

SpreadTo.txt File
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SpreadTo.txt File
Use the SpreadTo.txt file to define the layers for spreading and the maximum spread distance.

The SpreadTo.txt file defines the parameters for the Spread pass in the Autorouter.

The side file SpreadTo.txt must be located in the ...PCB/Config sub-directory of the design 
project.

Format
<units> 
<layer> <distance> 
<layer> <distance> 
... 

Parameters

• <units>

Any of the following unit values: in, th, mm, um.

• <layer>

Any valid layer number in the design.

• <distance>

Any number greater than zero for the maximum spread clearance distance. 

The first line <units> is optional. You may include a different <units> value for each layer, if 
required. The other lines specify which layers and maximum trace-to-trace clearance distances 
are used during spreading.

Note: The Spread pass only applies to the layers you specify in the side file. Any layers you do 
not specify in the side file are ignored by the Spread pass.

Examples

Example of a SpreadTo.txt file with the initial <units> line:

th 1 8 
2 7 
5 7 
6 8 

Example of a SpreadTo.txt file with the units defined for each distance value:

1 8th 
2 7th 
5 7th 
6 8th 

Related Topics

Spreading and Centering Traces with the Spread Pass



Layout Routing Solutions Guide, X-ENTP VX.2.5226

Autorouting Techniques
Autorouting with Fences

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Setting up the Autorouter

Auto Route Dialog Box [Layout Operations and Reference Guide]

Autorouting with Fences
Use fences (also known as route keepins) to restrict autorouting to a limited area of the design. 

This allows you to autoroute different sections of the design with different autorouting 
parameters and thus achieve the best results in each section.

You can define two types of fences:

• A hard fence allows autorouting only inside the fence boundary. Since a hard fence 
does not allow autorouting outside the boundary, pins inside the fence that only connect 
to other pins outside the fence are ignored. 

• A soft fence allows autorouting to start or end within the fence boundary and continue 
beyond the boundary. All of the pins inside a soft fence are autorouted if possible, even 
if they connect to other pins outside the fence.

You can also nest fences inside other fences to achieve even greater control over the autorouting 
results.

Fences are saved as design objects with the design project file.

Note
The cleanup passes Spread, Via Min, and Smooth do not treat soft fences as route 
obstructs. They operate within soft fences.

Prerequisites

• You must have activated the Layout 151 (or higher) license in the Available Licenses 
dialog box when you opened the design database if you are routing High Density 
Interconnect (HDI) designs.

Note: An HDI design is any design that employs high connection density and microvia 
structures: laser-drilled vias, skip vias, blind/buried vias, or any other vias that require 
some form of multi-laminate process for via construction. You define these microvia 
structures in the Via Definitions tab of the Setup Parameters dialog box (Setup > Setup 
Parameters > Via Definitions tab).

• You must have defined any special routing rules and constraints for the critical nets in 
Constraint Manager.

Procedure

1. Select Draw > Route Fence. 
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2. In the Properties dialog box, enter a unique name for the new fence.

3. Choose the Fence type (Hard or Soft) from the dropdown list.

4. In the workspace, draw a closed polygon around the section of the design you want to 
enclose within the fence boundary. If necessary, use the editing handles to change the 
shape of the polygon or move it.

Tip: If you cannot see the fence boundary, enable the display of Fence - Hard and 
Fence - Soft in the Display Control, Objects tab, Route Areas section.

5. Repeat steps 1 through 4 to define additional fences, as needed.

6. Open the Auto Route dialog box (Route > Auto Route).

7. Define the autorouting parameters that you want to apply to the fence areas.

8. In the Fences column, choose the fence you want to autoroute for each autorouting pass 
you have enabled.

9. Click Route to autoroute the enabled passes for the specified fences.

10. Monitor the Session Status Table to evaluate the progress of the autorouting session.

11. (Optional) Fix the routes inside the fences so they are not rerouted later when you 
autoroute other areas of the design.

Tip: You can instruct the Autorouter to fix the traces automatically by checking Fix in 
the Auto Route dialog box for each pass you plan to run.

If you want to... Do the following...

Autoroute a hard fence. Choose the name of the hard fence.

This is useful when you want to autoroute one 
section of the design at a time.

Autoroute all of the soft 
fences.

Choose In-SFences.

This is useful for starting routes within a single 
section or multiple sections of the design and 
completing all of those routes across the entire 
design.

Note: You cannot autoroute individual soft fences 
independently. To do so, define only one soft fence 
at a time and autoroute it, then delete it before 
defining the next soft fence.

Autoroute the entire 
design, including all of 
the soft fences but not the 
hard fences.

Choose Board.

This is useful when you want to autoroute every 
part of a design except the areas within the hard 
fences.
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Related Topics

Setting up the Autorouter

Autorouting a Design

Evaluating the Autorouter Progress

Manipulating Traces and Vias

Specifying Trace and Via Rules [Constraint Manager User's Manual]

Auto Route Dialog Box [Layout Operations and Reference Guide]

Editor Control Dialog Box [Layout Operations and Reference Guide]

Autorouting with Target Areas
Use target areas to partially autoroute a small number of traces to a specific location and 
terminate all of them on a particular layer.

Note
Target areas only work with Minimum Spanning Tree (MST) topology nets.

Target areas consist of a boundary line, route targets, and straight line interconnects that 
indicate the connections to the component pins. Target areas are most useful for setting up 
uniform routing patterns for bus paths that should terminate on the same layer.

A target area with route targets only specifies a particular termination point for the partial 
routing of a group of nets on a single layer without defining a specific routing path. In contrast, 
a sketch path defines a complete routing path for a group of nets, including layer changes and 
via patterns.

Prerequisites

• The nets you want to autoroute with target areas have been defined as MST topologies. 
See “Specifying Topology Type” in the Constraint Manager User’s Manual.

• The Topology Planner and Topology Router licenses have been acquired (Setup > 
Licensed Modules > Acquire Xpedition Topology Planner, Acquire Xpedition 
Topology Router).



Autorouting Techniques
Autorouting with Target Areas

Layout Routing Solutions Guide, X-ENTP VX.2.5 229

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Procedure

1. Make the target areas and route targets visible. In the Display Control dialog box (View 
> Display Control), Objects tab, check Route/Multi Planning and Route Planning > 
Target Areas/Route Targets.

2. Open the Target Area dialog box (Route > Target Areas) and set the layer and 
placement options. The default Automatic option is recommended for most situations.

Note
Make sure the Target Layer is also the current active layer in the design.

3. Click Apply to keep the dialog box open. (If you close the dialog box, the Target Area 
Action Key (F3) is not available.)

4. In the workspace, select the component pins to route.

5. Click the Target Area Action Key (F3).

A ghost target area boundary attaches to the cursor. The boundary color indicates the 
layer where the routed connections terminate. (The route targets are not visible until you 
place the target area.)

Note
The size of the boundary is determined by the number of pins you select. You can 
change the boundary size by checking Override deviation distance and entering an 

override value.

6. Click to place the target area.
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Route targets associated with the selected pins appear within the target area. Straight 
line interconnects are drawn between the component pins and the route targets.

7. (Optional) Modify the route targets:

a. In the Target Area dialog box, select Interactive, then click Apply.

b. Click the Reassign Route Targets Action Key (F5).

c. Select each route target and place them individually within the target area.

8. (Optional) Modify the target area:

9. Route the connections to the target area:

a. Open the Auto Route Dialog Box (Route > Auto Route).

b. Check Pass for the first routing pass, then choose Straight Line Interconnect as the 
Pass Type.

c. Uncheck Pass for all other routing passes to disable autorouting for those.

d. Click Route.

If you want 
to...

Do the following...

Move a target 
area

Click anywhere within the target area and 
drag it to a new location.

Delete a target 
area

Select the target area and press Delete.

Note: You must have the Target Area 
dialog box open to delete a target area.
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Results

Traces are routed from the selected component pins to the corresponding route targets within 
the target area. All of the traces terminate on the layer you specified. You can continue to route 
the remainder of the nets from the route targets to their ultimate destinations.

Related Topics

Setting up the Autorouter

Autorouting a Design

Specifying Trace and Via Rules [Constraint Manager User's Manual]

Target Area Dialog Box [Layout Operations and Reference Guide]

Auto Route Dialog Box [Layout Operations and Reference Guide]

Editor Control Dialog Box [Layout Operations and Reference Guide]

Autorouting Critical Nets Separately
You can autoroute a select group of critical nets separately instead of routing them with the 
entire design. 

Critical nets include those that require tuning or those that must meet special constraints such as 
maximum length/delay and matched length.

This technique is useful when you want to experiment with autorouting just the critical nets to 
determine if the results will be satisfactory before autorouting the whole design. 

Prerequisites

• You must have activated the Layout 151 (or higher) license in the Available Licenses 
dialog box when you opened the design database if you are routing High Density 
Interconnect (HDI) designs.

Note: An HDI design is any design that employs high connection density and microvia 
structures: laser-drilled vias, skip vias, blind/buried vias, or any other vias that require 
some form of multi-laminate process for via construction. You define these microvia 
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structures in the Via Definitions tab of the Setup Parameters dialog box (Setup > Setup 
Parameters > Via Definitions tab).

• You must have defined any special routing rules and constraints for the critical nets in 
Constraint Manager.

• You must have defined a net class in Constraint Manager that includes the critical nets.

Procedure

1. Use the net filtering settings in Net Explorer (Route > Net Explorer) to autoroute only 
the nets in the critical net class and none of the other nets in the design.

2. Open the Auto Route dialog box (Route > Auto Route).

3. Define a Fanout pass and a Route pass with the appropriate parameters for each. For 
tuned nets, define a third Tune Delay or Tuned Crosstalk pass. 

4. Under the Items to Route column for both passes, choose Filtered Nets.

5. Uncheck all other passes that may be defined in the autorouting scheme.

6. Use the Editor Control dialog box ( ), Route tab to enable routing on particular layers 
and set up other parameters such as layer bias, pad entry, and push-and-shove.

7. Click Route.

8. Monitor the Session Status Table to evaluate the progress of the autorouting session.

9. If the autorouting results are not satisfactory, you can experiment with different setup 
parameters and autoroute the critical nets repeatedly until the results are acceptable.

10. If the autorouting results are satisfactory, fix the critical routes so they are not rerouted 
later when you autoroute the remainder of the design. 

Tip: You can instruct the Autorouter to fix the traces automatically by checking Fix in 
the Auto Route dialog box for each pass you plan to run.

Related Topics

Setting up the Autorouter

Autorouting a Design

Autorouting with Fences

Evaluating the Autorouter Progress

Specifying Trace and Via Rules [Constraint Manager User's Manual]

Auto Route Dialog Box [Layout Operations and Reference Guide]

Editor Control Dialog Box [Layout Operations and Reference Guide]
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Autorouting Unpacked Areas
You can create special bounded regions known as unpacked areas to optimize the autorouting of 
bus nets. 

Unpacked areas restrict the autorouting of particular buses to only certain layers, each with a 
specified routing bias. For best results, create unpacked areas where the layout is not densely 
packed with parts. Use unpacked areas most effectively to autoroute bus nets between 
component pins and a related bus path so the routing is optimized to the bus path. 

Note
An unpacked area cannot span solely between two bus paths. It must include some 
component pins for a bus.

Prerequisites

• You must activate the Topology Planner license (Setup > Licensed Modules > Acquire 
Xpedition Topology Planner).

• To view unpacked areas, you must enable the Unpacked Areas option in Display 
Control (select the Objects tab, expand the Route/Multi Planning section, expand 
Route Planning, check Unpacked Areas). 

Procedure

1. Select Route > Net Explorer.

2. In Net Explorer, select the bus you want to control and choose Place Unpacked Area 
from the popup menu.

3. In the Unpacked Layers dialog box, check the layers where you want to autoroute the 
bus and choose the routing bias for each of the enabled layers. 

Tip: If you enable adjacent layers, you can check No Vias between Layers to prevent 
the autorouter from inserting vias between those layers.

4. Click in the workspace to locate the first corner of the unpacked area boundary, drag the 
cursor to draw the rectangular boundary, then click to locate the opposite corner. Be sure 
to enclose the start and end points of the netlines for the bus within the boundary.

Tip: Use the handles on the boundary to adjust the size or shape of the unpacked area or 
select the boundary and move it to a new location.

Results

The unpacked area is saved with the design. The special routing properties you defined are 
applied to the bus nets within the bounded area when you autoroute with the Bus Route pass. 

Related Topics

Routing Bus Nets Interactively
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Setting up the Autorouter

Autorouting a Design

Evaluating the Autorouter Progress

Autorouting High Density Interconnect 
(Microvia) Designs

Use the Autorouter in conjunction with carefully defined via spans to autoroute high density 
interconnect designs with microvias. 

Because microvias are blind or buried vias, the Autorouter follows special algorithms to place 
the fanout vias and route through all possible layer combinations. This optimizes the use of the 
microvias and improves the overall success of the autorouting session for high density 
situations.

Prerequisites

• You must have activated the Layout 151 (or higher) license in the Available Licenses 
dialog box when you opened the design database if you are routing High Density 
Interconnect (HDI) designs.

Note: An HDI design is any design that employs high connection density and microvia 
structures: laser-drilled vias, skip vias, blind/buried vias, or any other vias that require 
some form of multi-laminate process for via construction. You define these microvia 
structures in the Via Definitions tab of the Setup Parameters dialog box (Setup > Setup 
Parameters > Via Definitions tab).

• You must have defined the necessary microvias in Constraint Manager.

Procedure

1. Open the Setup Parameters dialog box (Setup > Setup Parameters), select the Via 
Definitions tab, and verify the layer span definitions for the microvias. 

2. Make any necessary modifications to be sure the microvia spans match the layer stackup 
for the current design, then click OK.

3. Open the Auto Route dialog box (Route > Auto Route).

4. Define the appropriate routing passes and parameters for autorouting with microvias to 
assure that fanouts are placed effectively for all layer spans. 

For example, you can run a single fanout pass with one of the following definitions: 

Pass Layers Microvia Span

Fanout All Array 
Layers

Through 1-8
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You can also run multiple fanout passes as shown in the example below for an 8 layer 
design with two inner planes on layers 4 and 5: 

5. Under the Items to Route column, choose the nets or net classes you want to route for 
each pass. 

6. Use the Editor Control dialog box ( ), Route tab to enable routing on particular layers 
and set up other parameters such as layer bias, pad entry, and push-and-shove.

7. Check the Pass checkbox for the passes you want to route and uncheck all of the other 
passes.

8. Click Route.

9. Monitor the Session Status Table to evaluate the progress of the autorouting session.

Related Topics

Setting up the Autorouter

Autorouting a Design

Evaluating the Autorouter Progress

Specifying Trace and Via Rules [Constraint Manager User's Manual]

Setup Parameters Dialog Box [Layout Operations and Reference Guide]

Fanout All Top to 
Bottom

Through 1-8

Fanout All Bottom to 
Top

Through 1-8

Pass Layers Microvia Span

1. Fanout 1,2 Blind 1-2

2. Fanout 2,3 Buried 2-3

3. Fanout 3,4,5,6 Buried 3-6

4. Fanout 6,7 Buried 6-7

5. Fanout 7,8 Blind 7-8

6. Route All Enabled Through 1-8

Pass Layers Microvia Span
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Evaluating the Autorouter Progress
The Session Status Table in the Auto Route dialog box provides detailed statistical feedback 
about the progress of an autorouting session. 

By monitoring these statistics, you can evaluate whether the Autorouter is making steady 
progress towards 100% completion of all the routes. If you do not observe steady progress, you 
can stop the autorouting session, change various net or routing rules, and retry autorouting with 
the new set of parameters.

Figure 9-4. Session Status Table 

Tip
While the Autorouter is running, click Mini Status () to open the Auto Route Mini Status 
dialog box in place of the Auto Route dialog box. The Mini Status shows only the Session 

Status Table.

Procedure

1. Examine the statistics shown in the Session Status Table and determine if the design is 
routing successfully:

• The numbers in the # Routed and % Routed columns should be increasing with 
each subsequent pass.

• The numbers in the To Try and Opens columns should be decreasing steadily with 
each subsequent pass.



Autorouting Techniques
Evaluating the Autorouter Progress

Layout Routing Solutions Guide, X-ENTP VX.2.5 237

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

2. If the Autorouter does not show steady progress towards 100% completion, click 
Interrupt ( ) to open the Interrupt Auto Route dialog box so you can stop or skip the 
current autorouting session.

The Autorouter stops at the point you specify.

3. Do any of the following to improve routing success:

• Change the parameters in the Auto Route dialog box, then enable the appropriate 
passes to continue. You may need to choose different pass types, enable additional 
routing layers, change the effort levels, or change the via and route grids.

• Change the clearances, trace widths, or via sizes for certain nets.

• Move or delete route obstructs that may inhibit the Autorouter.

4. Click Route to restart the Autorouter and continue routing with the new parameters.

5. Continue to monitor the statistics in the Session Status Table to determine if the new 
rules and parameters improve autorouting success.

6. If the entire autorouting session is unacceptable, click Undo Auto Route ( ) to delete 
all of the traces and vias generated by the Autorouter, then start over with a new set of 
parameters.

Tip
Click Report ( ) to view a detailed log of the autorouting session and the setup 

parameters. This information may assist you to optimize the autorouting setup and 
improve completion rates in future autorouting sessions.

Related Topics

Setting up the Autorouter

Overview of Autorouting with Layout

Auto Route Dialog Box [Layout Operations and Reference Guide]
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Chapter 10
Tuning Techniques

Use the tuning tools in Layout to adjust the length of traces so they will meet timing or matched 
length constraints. 

Tuning Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 239

Tuning a Trace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240

Tuning Traces With Complex Constraints . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 243

Tuning Traces with Crosstalk and Parallelism Constraints . . . . . . . . . . . . . . . . . . . . . . 244

Automatically Tuning a Set of Nets With Target Lengths. . . . . . . . . . . . . . . . . . . . . . . . 246

Manually Tuning a Set of Nets With Target Lengths  . . . . . . . . . . . . . . . . . . . . . . . . . . . 247

Manually Tuning a Differential Pair . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249

Phase Tuning Differential Pairs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253

Modifying Existing Tuning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 256

Tuning Overview
Tuning is the process of lengthening critical traces to meet timing or matched length rules for 
single-ended traces or differential pairs. 

You specify special trace patterns (serpentine, trombone, sawtooth) to lengthen the traces.

Tuning Comparison

Layout supports several tuning commands. Choose the most effective command for your 
requirements.

Table 10-1. Comparison of Tuning Commands 

Command Net types Push & 
Shove

Application

Manual Tune single-ended yes Good control in tight spaces, 
serpentine only.

Interactive Tune single-ended and 
differential pairs

no Serpentine (including one-sided), 
trombone, and sawtooth. Control of 
range or length. Does not use Editor 
Control or Tuning Patterns dialog box 
settings.
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Note
Push & Shove is not supported for odd angle traces. 

Tuning Aides

Depending on the command you use, Layout offers features to assist you in tuning traces.

• Tuning Meter — The tuning meter is a graphic “ruler” that shows how the trace you are 
tuning is meeting the defined length constraints (minimum, maximum, and tolerance). 
The meter displays in colors - yellow (under length), green (in range), or red (over 
length). The tuning meter is available for Manual and Manual Saw tune methods and 
works with a single-ended trace or differential pair.

• Target Lengths — The Target Lengths dialog box provides feedback on a list of traces 
that share a common constraint. You can sort traces to assist in deciding what net to start 
with as you tune the traces.

Related Topics

Target Lengths Dialog Box [Layout Operations and Reference Guide]

Tuning a Trace 
You can tune an existing trace to meet the timing constraints set in Constraint Manager. 

Use the Tuning Meter to dynamically gauge how much you need to lengthen or shorten the trace 
to conform to the constraints.

Prerequisites

• The constraints for your design have been defined in Constraint Manager.

Tune single-ended and 
differential pairs

yes (Xpedition Layout 151 or higher 
license required)

Automatically tunes selected traces 
using Tuning dialog box settings. 

Manual Saw Tune differential pairs yes Good control in tight spaces. Balance 
length in differential pairs. Use for 
manual phase matching.

Phase Tune differential pairs yes Eliminate skew in differential pairs.

Table 10-1. Comparison of Tuning Commands  (cont.)

Command Net types Push & 
Shove

Application



Tuning Techniques
Tuning a Trace

Layout Routing Solutions Guide, X-ENTP VX.2.5 241

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Video

Procedure

1. Define the serpentine patterns in the Tuning pattern rules section of the Tuning 
Patterns dialog box ( Setup > Editor Control, Route tab, expand the Dialogs section, 
then click Tuning). 

2. Display the Tuning Meter ( Setup > Display Control, Graphic tab, expand the 
Graphic Options section, expand General, then check Tuning Meter). 

3. Select the trace you want to tune, then choose Tune Routes > Manual Tune from the 
popup menu. 

A preliminary tuning pattern is created on the selected trace. The pattern is contained 
within a tuning box with editing handles. The Tuning Meter attaches to the cursor 

https://support.mentor.com/video/cdb9d2db-3b32-485c-8ed5-06c3d68f7a44
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and provides a visual, color-coded indication of whether the trace meets the required 
length constraints. 

4. Select a handle on the tuning box and adjust the size of the pattern until the Tuning 
Meter turns green, indicating that the trace length falls within the constraints. 

Note: The tuning pattern respects clearance rules as you adjust the size of the tuning 
box. 
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Tip: You can recalculate the target and lengths by choosing Recalculate Target 
Lengths from the popup menu. 

5. Click outside of the tuning box to set the final tuning pattern (or choose Cancel Tuning 
from the popup menu). 

Related Topics

Modifying Existing Tuning

Tuning Traces With Complex Constraints

Tuning Patterns Dialog Box [Layout Operations and Reference Guide]

Tuning Traces With Complex Constraints 
You can tune a group of traces that share a common formula or set of constraints based on a 
specific target length applied to all of the traces. 

Prerequisites

• The Length or TOF (time of flight) Delay constraints have been defined in Constraint 
Manager. 

• All the nets you want to tune are unfixed and unlocked. Fixed or Locked traces are 
considered constant during calculations.

• All the nets are 100% routed: 

In the Review Hazards dialog box ( Analysis > Review Hazards), choose Online > 
Open Netlines. 

Unrouted nets appear as Open in the Target Lengths dialog box. 

• If you want to observe both sides of a differential pair (in the Target Lengths dialog 
box), a Match constraint exists on both traces of the differential pair. 

Video

Procedure

1. Open the Target Lengths dialog box ( Analysis > Target Lengths). 

https://support.mentor.com/video/60b167b6-9d10-4318-9e68-bf2b8b450e41
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2. Select the nets you want to tune.

Tip: Use the Find dialog box, Constraint Classes tab, Net Explorer, or Review Hazards 
dialog box to select a set of constrained nets. 

3. Mark rows that you do not want to change. However, this may prevent a tuning solution.

4. In the Target Lengths dialog box, sort the traces by Manhattan Length or Meander to 
determine if you can shorten traces with very long lengths by moving a component or 
rerouting the trace. 

5. Tune the remaining nets in the set/cluster using the length of the target trace as the 
baseline solution:

• “Automatically Tuning a Set of Nets With Target Lengths” on page 246 

• “Manually Tuning a Set of Nets With Target Lengths” on page 247 

• “Manually Tuning a Differential Pair” on page 249 

Related Topics

Target Lengths Dialog Box [Layout Operations and Reference Guide]

Find Dialog Box [Layout Operations and Reference Guide]

Net Explorer - Navigation Pane [Layout Operations and Reference Guide]

Tuning Traces with Crosstalk and Parallelism 
Constraints

You can automatically tune traces with crosstalk or parallelism constraints by adding spacers 
between the critical traces.

Spacers are temporary "trace segments" that spread the traces apart to meet the minimum 
spacing requirements of crosstalk and parallelism constraints.
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Prerequisites

• Critical nets with crosstalk or parallelism constraints have been defined in Constraint 
Manager.

Procedure

1. Choose the Analysis > Hazard Explorer menu item to open Hazard Explorer.

2. On the Online tab, open the popup menu on either the “Parallelism” or the “Estimated 
Crosstalk” hazard type and choose Resolve.

3. In the Spacer Insertion dialog box, click Accept All.

Tip
Alternately, you can use the Autorouter to insert spacers. This method may achieve 
better tuning results under some circumstances. Set up a single routing pass in the 

Autorouter and define the Pass Type as "Tune Crosstalk", then click Route.

The system inserts spacers wherever needed to increase the spacing between the critical 
traces, based on the constraint definitions.

4. (Optional) Select the spacers and move them to push the critical traces farther apart and 
improve the spacing between them, as needed.

5. (Optional) When you have finished tuning for crosstalk or parallelism, delete all of the 
spacers in the design.

Note
Although spacers are not processed for output, you should delete them before 
processing manufacturing output to assure a clean design. Remember to fix or lock 

the critical traces before deleting the spacers.

a. Choose the Edit > Add to Select Set > Spacers menu item to select all of the 
spacers. 

b. Press the Delete key.
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Examples

The following image shows spacers between routed traces with parallelism constraints:

Related Topics

Parallelism and Crosstalk Rule Creation [Constraint Manager User's Manual]

Autorouting Techniques

Automatically Tuning a Set of Nets With Target 
Lengths 

After you have a target solution for tuning nets, you can automatically tune the set of nets. 

Prerequisites

• The traces have been selected and set up in the Target Lengths dialog box. See “Tuning 
Traces With Complex Constraints” on page 243. 

• The Xpedition Layout 151 or higher license has been acquired.
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Video

Procedure

1. Set up tuning patterns in the Tuning Patterns dialog box. ( Setup > Editor Control, 
Route tab, expand the Dialogs section, then click Tuning) 

• If you are tuning single ended traces, set up a serpentine or trombone pattern in the 
Tuning pattern rules section. 

• If you are tuning differential pairs, set up a serpentine pattern (for adding length) in 
the Tuning pattern rules section and set up Diff pair balancing options for 
balancing the pair. 

2. Set up gloss and push-and-shove options in the Edit & Route Controls section of the 
Editor Control dialog box. 

3. In the Target Length dialog box, click Tune . 

4. If any traces remain untuned, use interactive methods to tune the remaining nets:

• “Manually Tuning a Set of Nets With Target Lengths” on page 247 

• “Manually Tuning a Differential Pair” on page 249 

Related Topics

Tuning Patterns Dialog Box [Layout Operations and Reference Guide]

Editor Control Dialog Box- Route Tab [Layout Operations and Reference Guide]

Manually Tuning a Set of Nets With Target 
Lengths 

After you have a target solution for tuning traces, you can manually tune the individual nets in a 
set of traces. 

• To manually tune differential pairs, see “Manually Tuning a Differential Pair” on 
page 249. 

https://support.mentor.com/video/e6c0e22e-4e9e-4e71-ba80-2b4f9f2ac256
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• To manually tune using a trombone pattern, use the Interactive Tune dialog box. 

Prerequisites

• The traces have been selected and set up in the Target Lengths dialog box. See “Tuning 
Traces With Complex Constraints” on page 243. 

Video

Procedure

1. Set up a serpentine pattern in the Tuning pattern rules section of the Tuning Patterns 
dialog box ( Setup > Editor Control, Route tab, expand the Dialogs section, then click 
Tuning). 

2. Set up gloss and push-and-shove options in the Edit & Route Controls section of the 
Editor Control, Route tab. 

3. (Optional) Enable the tuning meter. In the Display Control, Graphic tab, expand the 
Graphics Options section, expand the General section, and check Tuning Meter. 

4. (Optional) In the Target Length dialog box, check Highlight in the Cross Probe List to 
Graphics section. 

5. Select the trace with the largest deviation from the list.

6. In the graphics window, click the trace where you want to add tuning.

7. Choose Manual Tune from the popup menu or click Manual Tune  on the Route 
toolbar. 

A tuning snake is inserted into the trace enclosed within a tuning box. 

8. Enlarge the tuning box while observing the length in the Target Lengths dialog box. You 
can also modify the tuning interactively using several features. See “Modifying Existing 
Tuning” on page 256. 

9. Click outside the tuning box to set the tuning pattern.

Related Topics

Tuning Patterns Dialog Box [Layout Operations and Reference Guide]

https://support.mentor.com/video/14b79284-1d58-4931-aaab-7602f0edda22
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Target Lengths Dialog Box [Layout Operations and Reference Guide]

Editor Control Dialog Box- Route Tab [Layout Operations and Reference Guide]

Interactive Tune Dialog Box [Layout Operations and Reference Guide]

Manually Tuning a Differential Pair 
You can tune differential pairs with Manual Tune and Manual Saw Tune.

Note
You must have a Length or TOF (time of flight) Delay Match constraint on the differential 
pair to see both traces of the pair in the Target Lengths dialog box.

Note
If you route differential pair traces through a rule area, the trace widths and clearances may 
or may not change to match the constraint scheme of the rule area. This depends on which 

net classes are assigned to the diff pair nets and to the rule area. If net classes are assigned to 
both the diff pair nets and the rule area, the trace widths and clearances adhere to the rules 
defined in the net classes; however, if the rule area does not use the same net class, the rule area 
takes precedence over the rules assigned to the diff pair nets. Changes that occur within the rule 
area may have an impact on the required electrical characteristics of the routed diff pair.

Prerequisites

• The traces have been selected and set up in the Target Lengths dialog box. See “Tuning 
Traces With Complex Constraints” on page 243. 

Video

Procedure

1. Set up tuning pattern with the Tuning Patterns dialog box:

a. Set up a serpentine pattern in the Tuning pattern rules section to add length to the 
differential pair. 

https://support.mentor.com/video/17bfc54c-87eb-4a33-99ac-2478690f7e3d
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b. Set up a sawtooth pattern in the Diff pair balancing section to add length to one side 
of a differential pair in order to balance the pair. 

2. Set up gloss and push-and-shove options in the Edit & Route Controls section of the 
Editor Control dialog box, Route tab. 

3. In the Target Length dialog box, check Highlight in the Cross Probe List to Graphics 
section. 

4. (Optional) Enable the tuning meter. In the Display Control, Graphic tab, expand the 
Graphics Options section, expand the General section, and check Tuning Meter. 

5. In the workspace, select a differential pair trace.

6. If you need to add length to the differential pair, choose Manual Tune from the popup 

menu or click Manual Tune  on the Route toolbar. 

A tuning snake is inserted into the differential pair enclosed within a tuning box. 

7. Enlarge the tuning box while observing the length in the Target Lengths dialog box (or 
tuning meter). You can also modify the tuning interactively in different ways. See 
“Modifying Existing Tuning” on page 256. 

8. When the longest trace of the differential pair reaches the minimum length, click outside 
the tuning box to set the tuning pattern.
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9. If you need to balance the differential pair (remove a Diff Pair Tolerance violation):

a. Let the software attempt to fix the violation by clicking Resolve in the Diff Pair 
Length Tolerance or Diff Pair Delay Tolerance hazards in the Review Hazards 
dialog box. If this does not remove the violation perform the next step. 

b. In the design workspace, select the shorter trace of the differential pair near the 
location where you want to lengthen the trace.

Note: The longer trace displays the hazard symbol near the source. 

c. Choose Manual Saw Tune from the popup menu or click Manual Saw Tune  
on the Route toolbar. 
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A sawtooth tuning snake is inserted into the selected trace of the differential pair 
enclosed within a tuning box. 

d. Lengthen the tuning box while observing the length in the Target Lengths dialog box 
and the tuning meter.
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e. Click outside the tuning box to set the tuning pattern.

Related Topics

Tuning Patterns Dialog Box [Layout Operations and Reference Guide]

Editor Control Dialog Box- Route Tab [Layout Operations and Reference Guide]

Phase Tuning Differential Pairs

Net Class Creation [Constraint Manager User's Manual]

Phase Tuning Differential Pairs 
Tune a routed differential pair to remove skew by adding length to one side of the pair. 

You can add length automatically with Hazard Explorer or you can manually tune the diff pair 
traces using the tuning meter as a guide.

Note
If you route differential pair traces through a rule area, the trace widths and clearances may 
or may not change to match the constraint scheme of the rule area. This depends on which 

net classes are assigned to the diff pair nets and to the rule area. If net classes are assigned to 
both the diff pair nets and the rule area, the trace widths and clearances adhere to the rules 
defined in the net classes; however, if the rule area does not use the same net class, the rule area 
takes precedence over the rules assigned to the diff pair nets. Changes that occur within the rule 
area may have an impact on the required electrical characteristics of the routed diff pair.

Prerequisites

• The Differential Pair Phase Tol Max and Differential Pair Phase Tol Distance Max 
constraints must have been defined for the differential pair in Constraint Manager.

Video

https://support.mentor.com/video/2764897a-741e-4078-bb35-b81855799716


Layout Routing Solutions Guide, X-ENTP VX.2.5254

Tuning Techniques
Phase Tuning Differential Pairs

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Procedure

1. Choose the Analysis > Hazard Explorer menu item to open Hazard Explorer, then do 
the following:

a. Click Color By Hazard and Display Hazard Symbols to mark the violations in the 
workspace. 

b. Click Fit Selected and Toggle Highlight to activate these options so you can locate 
violations in the workspace. 

c. Click the Online tab, expand Differential Pairs, then check Diff Pairs Phase 
Matching.

This highlights and marks any phase matching violations for diff pairs in the 
workspace. The display zooms in around the traces that have violations.

d. (Optional) Click the color box in front of the Diff Pairs Phase Matching option and 
assign a contrasting color so these violations are more distinct in the workspace.

2. Select the Diff Pair Phase Matching option, then choose Update from the popup menu 
to determine if there are phase tuning violations.

If Hazard Explorer shows zero “(0)”, then there are no violations. If a number appears, 
then there are violations you need to resolve.

3. With the Diff Pair Phase Matching option still selected, choose Resolve from the 
popup menu to automatically fix any phase tuning violations.

Layout attempts to lengthen the traces that violate the Phase Tol Max value by adding 
serpentine patterns.

The violations are removed from the list in Hazard Explorer if they are resolved 
automatically.

4. (Optional) If a violation cannot be resolved automatically, fix the violation manually by 
doing the following:

a. Choose the View > Display Control menu item to open Display Control.

b. Click the Graphic tab, expand the Graphic Options section, expand the General 
sub-section, then check Tuning Meter.
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c. In the design workspace, select the trace near the “X” symbol that marks the location 
of the violation.

d. Choose the Route > Tune Routes > Manual Saw Tune menu item.

A tuning box appears around the trace in violation and the tuning meter attaches to 
the cursor.

e. Drag the editing box to adjust the sawtooth tuning pattern until the tuning meter 
shows “green”, indicating that the trace meets the required Phase Tol Max value for 
the diff pair.

When you have resolved the violation, Hazard Explorer updates the violation count 
in the list.
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f. Choose Cancel Tuning from the popup menu to exit the tuning mode.

Related Topics

Manually Tuning a Differential Pair

Modifying Existing Tuning

Differential Pair Phase Tol Max [Constraint Manager User's Manual]

Differential Pair Phase Tol Distance Max [Constraint Manager User's Manual]

Net Class Creation [Constraint Manager User's Manual]

Modifying Existing Tuning 
You can modify the tuning for a trace or differential pair.

Video

Procedure

1. Select a tuned trace or differential pair. If you are adjusting an existing tuning snake 
(serpentine or sawtooth), you must select at least one segment of the snake.

2. Modify the tuning pattern with one of the following methods: 

If you want to... Do the following...

Remove all tuning from 
trace(s)

1. Choose Gloss from the popup menu. 

Tuning is removed from the selected trace segments, 
except for odd-angle.

Tip: For odd-angle traces, start manual tune and reduce the 
tuning box until the tuning is removed. 

Make adjustments to an 
existing tuning pattern/
snake

1. If tuning a serpentine pattern, click Manual Tune. If 
tuning a sawtooth pattern click, Manual Saw Tune. 

2. Adjust the tuning box as required using other tuning 
options. 

https://support.mentor.com/video/6209f006-55ad-46b7-9fa2-1dbfcf4fe052
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Move the pattern/snake to 
one side of the trace 

During manual tune, move the cursor inside the tuning box and 
drag the box to the desired side. 

Disable pushing and 
shoving 

During manual tune, press Ctrl while changing the tuning box. 

Widen the pattern by 
allowing the pattern/snake 
to push other tuned traces

During manual tune, press Shift while changing the tuning 
box. 

Caution: Pushing tuned nets alters the length of those traces. 

If you want to... Do the following...
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3. Click outside the tuning box to set the new tuning pattern or choose Cancel Tuning 
from the popup menu. 

Related Topics

Tuning Overview

Adjust individual 
segments of trace tuning

1. Move any segment of the trace.
or

1. Choose Flatten Tuning Pattern from the popup menu. 

This allows you to select individual segments of the tuning 
pattern rather than the entire pattern.

2. Click on a tuning segment of the trace and move the cursor 
to adjust the size of that particular portion of the tuning 
pattern.

Note: After flattening or adjusting, the tuning pattern becomes 
separate trace segments that cannot be manipulated as a tuning 
snake. 

If you want to... Do the following...
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Chapter 11
Cleanup Techniques

You can clean up the routed connections in various ways and improve the overall routing 
quality.

This improves the PCB design and makes it easier to fabricate. 

Gloss Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 259

Optimizing Traces by Glossing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 262

Protecting Hanging Traces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 264

Removing Hanging Traces  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265

Changing Trace Widths of Routed Nets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 266

Curving Existing Trace Corners  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 267

Finding Unconnected Netlines  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 268

Balancing Metal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 268

Calculating Metal Area in Your Design  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 270

Gloss Modes
Glossing is the process of adjusting and optimizing existing traces and vias to accommodate 
design changes.

You can work in either of two different gloss modes to dynamically push-and-shove existing 
traces and vias: Gloss Local or Gloss On. Each gloss mode modifies existing traces and vias in 
different ways when you route new traces, move vias, or move components.

• Gloss Local — tends to make more local, limited push-and-shove changes and does less 
rerouting. This mode is useful if you want to constrain the impact of changes on the 
surrounding traces.

• Gloss On — allows for more widespread push-and-shove changes (often in areas of the 
design that may not be visible in the current workspace window) and tends to do more 
rerouting.

Use the Toggle Gloss Action Key (F10) to toggle between the gloss modes and apply the most 
suitable push-and-shove behavior for your particular editing needs. For most design situations, 
Gloss Local is the recommended mode. Toggle to Gloss On to handle more difficult editing 
conditions. To prevent dynamic glossing, toggle to Gloss Off mode.
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The following examples compare how the two gloss modes operate for different editing 
situations and show how they push-and-shove traces dynamically.

Glossing When Routing Traces

Figure 11-1. Gloss Local When Routing a Trace 

Figure 11-2. Gloss On When Routing a Trace 

The following video demonstrates the differences between Gloss Local and Gloss On when you 
route traces.

Glossing When Moving or Placing Vias

Figure 11-3. Gloss Local When Moving a Via 

https://support.mentor.com/video/c8825180-8a23-4a81-b966-d10804bf2370
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Figure 11-4. Gloss On When Moving a Via 

The following video demonstrates the differences between Gloss Local and Gloss On when you 
move or place vias.

Glossing When Moving or Placing Components

Figure 11-5. Gloss Local When Moving or Placing a Component

https://support.mentor.com/video/ab7e8faf-c1ed-4287-ba28-47e476dc9132


Layout Routing Solutions Guide, X-ENTP VX.2.5262

Cleanup Techniques
Optimizing Traces by Glossing

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Figure 11-6. Gloss On When Moving or Placing a Component 

The following video demonstrates the differences between Gloss Local and Gloss On when you 
move or place components.

Related Topics

Optimizing Traces by Glossing

Plow and Multi-Plow Modes

Optimizing Traces by Glossing
Glossing adjusts and optimizes routed traces by removing unnecessary bends, rerouting acute 
and 90 degree angles, and improving trace entry into pads.

Note
You cannot gloss tuned nets that have been flattened with the Flatten Tuning command in 
the popup menu.

Prerequisites

• Traces and vias have been made visible in Display Control.

Procedure

1. Select the traces you want to gloss.

https://support.mentor.com/video/f56f48f5-2afd-44a7-8bb0-c6c38c3201d5
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2. Choose one of the following gloss methods:

If you want to... Do the following...

Gloss only the 
selected trace 
segments

1. Select Gloss Local in Editor Control, Route tab, Edit and Route 
Controls section.

or

Click Toggle Gloss (F10) until Gloss Local appears on the Status 
bar.

2. Click  on the Route toolbar, or choose Gloss from the popup 
menu.

Example:

Gloss all trace 
segments 
associated with the 
selected traces

1. Select Gloss On in Editor Control, Route tab, Edit and Route 
Controls section.

or

2. Click Toggle Gloss (F10) until Gloss On appears on the Status 
bar.

3. Click  on the Route toolbar, or choose Gloss from the popup 
menu.

Example:



Layout Routing Solutions Guide, X-ENTP VX.2.5264

Cleanup Techniques
Protecting Hanging Traces

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Tip
Use the “Additional gloss spreading clearance” option in Editor Control (Editor 
Control, Route tab, Edit & Route Controls section) to increase the spacing 

between traces and other objects during glossing.

Related Topics

Editor Control Dialog Box - Route Tab [Layout Operations and Reference Guide]

Gloss Modes

Plow and Multi-Plow Modes

Protecting Hanging Traces
You can protect hanging traces (hangers) on specific nets so they are not removed when you 
execute the Remove Hanger command (choose the Route > Edit Routes > Remove Hanger 
menu item).

Note
Although you protect the hangers from being removed with the Remove Hanger command, 
they do not become fixed/locked. You can still edit or delete them manually.

Procedure

1. Choose the Setup > Advanced Setup > Hanger Protection menu item to open the 
Hanger Protection dialog box.

2. In the Excluded list, select the nets you want to protect, then click the right arrow key to 
move those nets to the Included list.

• The Excluded list displays all of the nets that are not protected. Hangers on nets in 
the Excluded list are removed with the Remove Hanger command.

• The Included list displays all of the nets that are protected. Hangers on nets in the 
Included list are not removed with the Remove Hanger command.

Tip
Enter a net name, or a partial name with a wildcard (example: ADDR*), in the 
Search text box to quickly find a particular net in the Excluded list.

3. (Optional) Click the right or left arrow keys to move selected nets between the two lists 
to achieve the desired protection settings. Alternately, check the Protect hangers for all 
nets option to move all of the nets from the Exlcuded list to the Included list.

4. Click OK.
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Related Topics

Removing Hanging Traces

Hanger Protection Dialog Box [Layout Operations and Reference Guide]

Removing Hanging Traces
Remove hanging traces (hangers) to improve the electrical characteristics of the design.

As you route and modify your design, the process may produce extraneous trace segments that 
do not terminate on a pin or plane. These trace segments are called “hangers” or “hanging 
traces.” Often, they are the result of specific types of design modifications. For example, you 
may have fixed/locked traces that are no longer needed after forward annotation. (The fixed/
locked status of the traces prevents them from being removed.) These hanging traces can 
adversely affect signal integrity or electromagnetic interference.

Figure 11-7. Example of a Hanging Trace 

Note
The Remove Hanger command removes Semi-fixed traces but not Fixed or Locked traces. 
To remove Fixed or Locked hangers, you must unlock or unfix those trace segments.

Tip
Choose the Setup > Advanced Setup > Hanger Protection menu item to open the Hanger 
Protection dialog box. Here you can prevent the removal of hangers on specific nets when 

you execute the Remove Hanger command.

Prerequisites

• The nets for the hangers you want to remove have not been protected in the Hanger 
Protection dialog box.
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Procedure

1. Select a section of the design using area select, or select the specific hanging traces you 
want to remove. Use Ctrl+A to select the entire design and remove all hangers.

2. Choose the Route > Edit Routes > Remove Hanger menu item. 

Related Topics

Protecting Hanging Traces

Manipulating Traces and Vias

Hanger Protection Dialog Box [Layout Operations and Reference Guide]

Changing Trace Widths of Routed Nets
You can change the width of selected trace segments to improve routing through tight spaces or 
to increase the width for power nets.

Prerequisites

• Minimum, Typical, and Expansion widths must be set in Constraint Manager.

Procedure

1. Select traces:

• Click — selects a single trace segment.

• Ctrl + Click — selects multiple traces segments.

• Double-click — selects the trace path in both directions to either a part pin or a 
junction.

• Triple-click — selects the entire net.

2. Change the width of routed traces with one of the following methods:

If you want to... Do the following...

Change a trace width with 
the Change Width Dialog 
Box

1. Open the Change Width dialog box (Route > 
Edit Routes > Change Width).

2. Specify a new width, then click OK.
Note: The Change Width dialog box changes a trace 
segment, if that change does not create a design-rule 
violation.

Change a trace width from 
the popup menu

1. Choose a Current, Minimal, Typical, or 
Expansion width from the Width popup menu.

Note: If selected traces contain multiple widths, no 
values appear for Current.
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Results

Batch DRC generates Trace Width hazards for trace widths different than the Constraint 
Manager Minimum, Maximum or Expansion width.

Related Topics

Changing Trace Widths During Interactive Routing

Change Width Dialog Box [Layout Operations and Reference Guide]

Specifying Trace and Via Rules [Constraint Manager User's Manual]

Trace Width Expansion [Constraint Manager User's Manual]

Trace Width Minimum [Constraint Manager User's Manual]

Trace Width Typical [Constraint Manager User's Manual]

Trace Width Hazards [Layout Verification Guide]

Curving Existing Trace Corners
You can change trace corners to curves and vice-versa on all routed traces in a design, or on a 
selected group of traces.

Prerequisites

• Set traces and vias to be visible in the Display Control.

Note
Arcs and curves are not maintained when you move parts or traces. Therefore, it is 
best to create arcs and curves only when your design is nearly or completely routed.

Procedure

1. Open the Modify Corners dialog box (Route > Edit Routes > Modify Corners).

2. Enter values for Minimum radius and Maximum radius.

3. Select Change to arcs.

Define new trace width 
values from the Set popup 
menu

1. Open the Set width dialog box from the Set 
popup menu.

2. Enter a new width value, then click OK.
Note: New trace width values added in the Set Width 
dialog box remain in the popup menu only for the 
current session.

If you want to... Do the following...
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4. From the dropdown list, choose one of the following:

• All Corners to change all trace corners in the design

• Selected Corners, then select a single trace or multiple traces to change only the 
selected corners.

5. Click Apply

Note
Corners that cannot be changed to arcs are reported as Missing Arcs hazards.

Related Topics

Routing Curved Traces

Modify Corners Dialog Box [Layout Operations and Reference Guide]

Missing Arcs Hazards [Layout Verification Guide]

Finding Unconnected Netlines
You can quickly find any remaining unconnected netlines in a dense design that is nearly 100% 
routed. 

This is especially useful when you are working with a large, dense design and have made 
extensive manual edits to the trace routing. Often in such cases, small disconnects occur that 
you cannot easily see or locate.

Procedure

1. Select Route > Find Next Netline.

The system zooms to and highlights an unconnected netline in the design.

2. Use interactive routing methods to connect the netline.

3. Repeat Steps 1- 2 to find any additional unconnected netlines and finish routing those.

Note: When you have completed routing all of the “hidden” netlines, the Find Next 
Netline command is grayed out and is no longer available in the Route menu. 

Related Topics

Interactive Routing Techniques

Balancing Metal
Metal balancing adds metal patterns to improve the manufacturing processes (plating and 
lamination) by distributing the amount of metal evenly on each layer.
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You can add metal balancing to the entire board area or you can add it to specific areas of the 
board by defining the areas with metal balancing shapes.

Prerequisites

• You must have an Xpedition FabLink license.

• The design must be 100% routed.

• All Batch DRC errors must be corrected.

Procedure

1. Set the layers to display on the Display Control, Edit tab, and set the Metal Balancing 
items to display on the Display Control, Fab tab.

2. If there are areas of the board where metal balancing is not allowed, add route obstructs.

3. If you are adding metal balancing to specific areas of the board, draw the areas as a 
metal balancing shape (Planes > Metal Balancing Shape).

Note
Metal balancing shapes must be inside the route border to generate metal balancing 
data.

4. Open the Metal Balancing Processor (Planes > Metal Balancing Processor).

5. Select the layers for metal balancing, choose the appropriate pattern, and set the other 
pattern parameters.

6. If you are adding metal balancing to the entire area within the board outline, check Auto 
Balance. If you are adding metal balancing to specific areas where you added metal 
balancing shapes, uncheck Auto Balance.

7. To define a minimum allowable area in which to generate metal balancing data, check 
Discard any metal balancing area less than.

8. Click OK.

Note: You can remove metal balancing from the entire board or by layer with the Delete 
Metal Balancing Data dialog box (Planes > Delete Metal Balancing Data). 

Results

Metal Balancing Data generates a log file (.../LogFiles/MetalBalancing.txt). You can open this 
file with File Viewer. 

Related Topics

Metal Balancing Processor Dialog Box [Layout Operations and Reference Guide]

Delete Metal Balancing Data Dialog Box [Layout Operations and Reference Guide]

Metal Balancing Shape [Layout Operations and Reference Guide]
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Calculating Metal Area in Your Design
Calculate the amount of metal in your design to determine the current capacity for planes, 
predict problems with reflow, estimate manufacturing costs, or verify heat sink dissipation.

Metal area calculation is useful throughout the design process, but particularly after component 
and plane placement.

Procedure

Choose Analysis > Calculate Metal Area. 

The file CalcMetalArea.txt file opens in FileViewer. This file contains information 
about the total metal area in the design as well as the metal area on each layer of the 
design. 
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Chapter 12
Special Routing Tasks

There are special routing tasks you may need to perform on certain types of designs. 

Topologies - Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273
Custom Topologies in Layout. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273
Modifying Custom Topologies in Layout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
Deleting a Netline in a Custom Topology  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 277
Adding a Netline to a Custom Topology  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 278
Adding a Virtual Pin to a Custom Topology  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 279
Adding a Guide Pin to a Custom Topology . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281

Shielding - Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284
Methods for Shielding Buses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284
Recommended Workflow for Shielding Bus Nets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 285
Defining Shielding Rules with Net Explorer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 287
Adding Shielding Rules to Constraint Classes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291
Routing Shield Traces with the Topology Router  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291
Adding Shielding Interactively . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292

Removing Unconnected Pads During Routing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 294

Moving Pins  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 295

Allowing Different Nets to Short  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 296

Starpoints . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 298

Generating Tabbed Routing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 300

Teardrops and Tracedrops - Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
Teardrops and Tracedrops  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302
Generating Teardrops Automatically . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 304
Generating Teardrops for T-junctions and Neckdowns . . . . . . . . . . . . . . . . . . . . . . . . . . . 306
Placing Teardrops Interactively  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 307
Changing the Shape of Teardrops. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 308
Creating Custom Curved Teardrops . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 308
Generating Tracedrops Automatically . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311
Placing Tracedrops Interactively  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313
Fixing and Locking Teardrops and Tracedrops  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313
Deleting Teardrops and Tracedrops . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 314

Sending a Net to HyperLynx LineSim . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 315

Swapping Nets  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 315

Stitch Vias - Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 318
Creating Stitch Vias Around Shapes and Traces  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 318



Layout Routing Solutions Guide, X-ENTP VX.2.5272

Special Routing Tasks

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Creating Stitch Vias Inside Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 323

Creating Radial Via Patterns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 325

Creating Rectangular Via Arrays  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327

Complex Vias - Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329
Complex Vias . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329
Creating Complex Vias. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 331
Creating the Elements of Complex Vias. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332
Creating Component Groups for Complex Vias. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334
Creating a ComplexViaShieldingNets.dat File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 335
ComplexViaShieldingNets.dat File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 336
Creating a Pattern File for Complex Vias. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 337
ComplexViaPatterns.dat File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 339



Special Routing Tasks
Topologies - Overview

Layout Routing Solutions Guide, X-ENTP VX.2.5 273

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Topologies - Overview
You can assign a variety of standard routing topologies to nets, or create, modify, and manage 
custom topologies.

Custom Topologies in Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273
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Custom Topologies in Layout
You assign one of the standard topology patterns to a net in Constraint Manager. 

A topology pattern defines the order of the pin-to-pin routing sequence for a net.

Table 12-1. Standard Topologies 

Topology Description

MST A Minimum Spanning Tree topology arranges the netlines in a tree pattern that 
minimizes the pin-to-pin connection distances as much as possible.

Chained A Chained topology arranges the netlines so the pin-to-pin connections start 
from the sources, then tie to the loads, and end at the terminators.

TShape A TShape topology arranges the netlines in a “T” shaped pattern.

HTree An HTree topology arranges the netlines according to a hierarchical tree 
pattern.

Star A Star topology arranges the netlines in a star shaped pattern.

Custom A Custom topology requires that you manipulate the netlines manually to 
define a special pin-to-pin routing sequence. A Custom topology does not 
include pin sets.

Complex A Complex topology is a Custom topology that includes pin sets. You cannot 
manipulate the netlines of a Complex topology; you must change it to a Custom 
topology to manipulate the netlines.
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If you assign the Custom topology to a net in Constraint Manager, you have the option of 
manipulating the netlines in Layout to order them in a particular pin-to-pin routing sequence 
rather than ordering the pins in Constraint Manager. This provides you more flexibility for 
optimizing the netlines in Layout. 

Related Topics

Topology Specification for Nets and Constraint Classes [Constraint Manager User's Manual]

Modifying Custom Topologies in Layout
You can re-arrange the netlines in Layout rather than in Constraint Manager for a Custom 
topology net. 

This allows you to optimize a particular pin-to-pin routing sequence while you are routing 
connections interactively. You can also add virtual pins and guide pins. 

You cannot connect a netline to a different net. You can only change the pin-to-pin ordering of 
the netlines within a particular net.

Note
If you select a topology other than Custom in Constraint Manager, Layout automatically 
adjusts the netlines so they conform to the sequential ordering requirements of that 

topology. If necessary, virtual pins are also added automatically to guide the routing sequence. 
You cannot manipulate the netlines for these topologies in Layout.

Prerequisites

• The net you intend to modify must be defined as a Custom topology.

• The Route toolbar must be visible (View > Toolbars > Route).

Table 12-2. Netline Manipulation Tasks for Custom Topologies 

If you want to... Refer to...

Change the sequence of pin-to-pin 
connections in Layout for a Custom 
topology.

“Modifying Custom Topologies in Layout” on page 274

Delete an existing netline so you can 
reconnect with a different netline.

“Deleting a Netline in a Custom Topology” on page 277

Add a new netline between the pins of an 
existing net.

“Adding a Netline to a Custom Topology” on page 278

Add virtual pins to netlines to route 
partial connections.

“Adding a Virtual Pin to a Custom Topology” on 
page 279

Add guide pins to netlines to aid in 
routing.

“Adding a Guide Pin to a Custom Topology” on 
page 281
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Procedure

1. Select Netline Manipulation ( ) on the Route toolbar. 

The workspace display changes to shadow mode.

2. Click the netline you want to modify. 

3. Click the netline again at the end closest to where you want to disconnect from the 
existing target pin. 

The end of the netline closest to the selection point attaches dynamically to the cursor.
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4. Drag the end of the netline to a different target pin on the same net and drop the netline 
on that pin. 

Tip: Select the Undo Action Key (F6) to undo the connection to the target pin if you 
choose the wrong pin.

5. If you want to reorder other netlines, choose Save Changes, Edit Related Net from the 
popup menu and repeat Step 2 through Step 4 for the other netlines.

6. Choose Save Changes and Exit from the popup menu.
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Tip: If you make a mistake while re-ordering the netlines, choose Discard Changes 
and Exit or Discard Changes, Edit Related Net. The netlines revert to their previous 
states.

Results

The modified netline ties the source pin to the selected target pin, changing the routing order of 
the pins within the net. Backannotate the changes (ECO > Back Annotate).

Related Topics

Deleting a Netline in a Custom Topology

Adding a Netline to a Custom Topology

Topology Specification for Nets and Constraint Classes [Constraint Manager User's Manual]

Deleting a Netline in a Custom Topology
You can delete a netline in a Custom topology net and reconnect it in a different way in Layout.

Note
When you delete a netline, the pins are not removed from the net. You must reconnect the 
pins in a different way with a new netline to preserve connectivity within the net.

Prerequisites

• The net you intend to modify must be defined as a Custom topology.

• The Route toolbar must be visible (View > Toolbars > Route).

Procedure

1. Select Netline Manipulation ( ) on the Route toolbar.

The workspace display changes to shadow mode.

2. Select the netline you want to remove.

3. Press the Delete key (or select Edit > Delete).

4. Choose Save Changes and Exit from the popup menu.

Tip: If you make a mistake deleting the netline, choose Discard Changes and Exit. The 
netline is restored to its previous state.

Results

The netline is removed. You can now reconnect the pins by adding a new netline (see “Adding a 
Netline to a Custom Topology” on page 278). Backannotate the changes (ECO > Back 
Annotate).
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Related Topics

Adding a Netline to a Custom Topology

Modifying Custom Topologies in Layout

Topology Specification for Nets and Constraint Classes [Constraint Manager User's Manual]

Adding a Netline to a Custom Topology
You can add a new netline to an existing custom topology net. 

This is useful when you have deleted one or more netlines in order to insert new netlines that 
follow a different connection sequence. 

You can only add netlines that connect between pins of an existing net. You cannot add a 
netline to unconnected pins to create an entirely new net.

Prerequisites

• The net you intend to modify must be defined as a Custom topology.

• The Route toolbar must be visible (View > Toolbars > Route).

Procedure

1. Select Netline Manipulation ( ) on the Route toolbar.

The workspace display changes to shadow mode.

2. Click on the first anchor pin for the netline.

3. Click on the target pin for the netline.

4. If you want to connect additional target pins, continue clicking on other pins for the 
same net.

5. Choose Save Changes and Exit from the popup menu.

Tip: If you make a mistake adding the netline, choose Discard Changes and Exit. The 
new netline is removed and the database is restored to its previous state.

Results

A new netline is added between the anchor and target pins of the existing net. Backannotate the 
changes (ECO > Back Annotate).

Related Topics

Deleting a Netline in a Custom Topology

Modifying Custom Topologies in Layout

Topology Specification for Nets and Constraint Classes [Constraint Manager User's Manual]
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Adding a Virtual Pin to a Custom Topology
Use virtual pins to define Custom topology patterns for routing ordered nets. 

By placing virtual pins in the appropriate positions along the routing path, you specify the 
custom topology pattern for the connections. The netlines stretch between the real pins and the 
virtual pins to reflect the order you specify for the routing.

Virtual pins appear as vertical “bow tie” shapes and are assigned unique reference designators 
(VPn) to assist in locating them in the design. They do not have padstacks or any physical 
characteristics, and use trace clearance rules instead of pad clearance rules. 

Figure 12-1. Example of a Virtual Pin 

Avoid placing virtual pins on regular pins, existing vias, or traces because the existing items 
may keep the router from creating connection points at the virtual pin location. If you place the 
virtual pin in a highly populated area where surrounding objects cannot be moved with push-
and-shove, the router may fail to make the connection.

Prerequisites

• The net you intend to modify must be defined as a Custom topology.

• Virtual pins must be visible (Display Control, Objects tab, “Route Planning” section, 
Virtual Pins item).

• The Route toolbar must be visible (View > Toolbars > Route).

Procedure

1. Select Netline Manipulation ( ) on the Route toolbar.

The workspace display changes to shadow mode.

2. Select the netline for the virtual pin.

3. Click the Place VP Action Key (F3).



Layout Routing Solutions Guide, X-ENTP VX.2.5280

Special Routing Tasks
Adding a Virtual Pin to a Custom Topology

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

The virtual pin attaches to the cursor.

4. Click to place the virtual pin.

Tip: Place virtual pins by starting from the source end of the topology and working 
towards the load end.

5. Click a section of the netline and drag it to the virtual pin to specify the connection path. 

6. Click the virtual pin as the source pin, then click another pin on the net as the target pin 
to complete the connection path for the net.

7. Modify the virtual pin in the following ways: 

8. Choose Save Changes and Exit from the popup menu.

Tip: If you make a mistake connecting with the virtual pin, choose Discard Changes 
and Exit. The virtual pin is removed and the net is restored to its previous state.

If you want to... Do the following...

Move the virtual pin. 1. Select the virtual pin.
2. Click the Move Action Key (F2), then click to 

place it at a new location. 
Note: You can also move a virtual pin without 
being in Netline Manipulation mode by pressing 
and holding the Shift key while clicking on the 
virtual pin and dragging it to a new location.

Return the net ordering to 
the previous state before 
you placed the virtual 
pin.

Click the Revert Action Key (F9).

Delete the virtual pin. Select the virtual pin and press the Delete key.
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Related Topics

Adding a Guide Pin to a Custom Topology

Modifying Custom Topologies in Layout

Interactive Routing Techniques

Topology Specification for Nets and Constraint Classes [Constraint Manager User's Manual]

Adding a Guide Pin to a Custom Topology
Use guide pins to define a preferred routing path for a Custom topology net. 

As you place guide pins, a color code indicates the direction of the connection: the incoming net 
to a guide pin is red, the outgoing net from a guide pin is yellow. Place guide pins by starting 
from the source end of the topology and working towards the load end.

Guide pins appear as horizontal “bow tie” shapes and are assigned unique reference designators 
(GPn) to assist in locating them in the design. They do not have padstacks or any physical 
characteristics, and use trace clearance rules instead of pad clearance rules. You can place guide 
pins on all layers or on a single layer. You can print guide pins and their associated netline but 
you cannot photoplot them.

Figure 12-2. Example of a Guide Pin 

Avoid placing guide pins on regular pins or existing vias or traces because the existing items 
may keep the router from creating connection points at the guide pin location. If you place the 
guide pin in a highly populated area where surrounding objects cannot be moved with push-and-
shove, the router may fail to make the connection.

Prerequisites

• The net you intend to modify must be defined as a Custom topology. 

• Guide pins must be visible (Display Control, Objects tab, “Route Planning” section, 
Guide Pins item).
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• The Route toolbar must be visible (View > Toolbars > Route).

Procedure

1. Select Netline Manipulation ( ) on the Route toolbar.

2. Select the netline for the guide pin.

3. Click the Place GP Action Key (F4).

Note: By default, guide pins are placed on all layers. You can choose a specific layer 
from the popup menu to place a guide pin on a single layer. 

4. Click to place the guide pin at the desired location.

The netline attaches to the guide pin from the source pin. 

5. (Optional) Continue clicking to place additional guide pins as you define the preferred 
routing path for the net.

6. Choose Accept Guide Pin(s) from the popup menu when you are finished placing all of 
the guide pins.

7. Modify a guide pin in the following ways: 

If you want to... Do the following...

Move the guide pin. 1. Select the guide pin.
2. Click the Move Action Key (F2), then click to 

place it at a new location. 
Note: You can also move a guide pin without being 
in Netline Manipulation mode by pressing and 
holding the Shift key while clicking on the guide 
pin and dragging it to a new location.
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8. Choose Save Changes and Exit from the popup menu.

Tip: If you make a mistake connecting with the guide pin, choose Discard Changes 
and Exit. The guide pin is removed and the net is restored to its previous state.

Related Topics

Adding a Virtual Pin to a Custom Topology

Modifying Custom Topologies in Layout

Interactive Routing Techniques

Topology Specification for Nets and Constraint Classes [Constraint Manager User's Manual]

Change the layer 
assignment for the guide 
pin.

When you place a guide pin, by default it is 
assigned to all layers. You can assign a guide pin to 
all layers, to a single signal layer, or to a single 
plane layer.

1. Select the guide pin.
2. Choose the desired layer assignment from the 

popup menu. 

Return the net ordering to 
the previous state before 
you placed the guide pin.

Click the Revert Action Key (F9).

Delete the guide pin. Select the guide pin and press the Delete key.

If you want to... Do the following...
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Shielding - Overview
You can define shielding rules for nets and create shield traces automatically or interactively.

Shielding reduces the potential adverse effects of EMI and cross-talk. You can shield bus nets 
automatically or shield individual traces interactively.

Methods for Shielding Buses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284

Recommended Workflow for Shielding Bus Nets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 285

Defining Shielding Rules with Net Explorer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 287

Adding Shielding Rules to Constraint Classes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291

Routing Shield Traces with the Topology Router. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291

Adding Shielding Interactively . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292

Methods for Shielding Buses
You can shield bus nets and other critical nets in different ways and with varying results. 

Table 12-3. Comparison of Shielding Methods 

Shielding Method Application

Interactive Routing — Route shield 
traces individually using interactive 
routing methods.

See “Adding Shielding Interactively” on 
page 292.

Manual routing is the most time-
consuming method but provides the 
greatest control over the exact pattern and 
location of the shield traces and vias.

Topology Router — Route shield traces 
with the Topology Router.

See “Routing Shield Traces with the 
Topology Router” on page 291.

The Topology Router generates shield 
traces quickly in a variety of shielding 
arrangements (one trace between shield 
traces, two traces between shield traces, 
and so forth).

Autorouter — Route shield traces with 
the Autorouter.

See “Autorouting Techniques” on 
page 215.

The Autorouter generates shield traces 
quickly, but the results may not be as 
satisfactory as with the Topology Router.

Shield Plane — Create a shield plane 
around the critical traces.

See “Creating Plane Shapes and Split 
Planes” on page 68.

A shield plane is often the most efficient 
(and effective) way to shield a group of 
critical traces.
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Related Topics

Defining Shielding Rules with Net Explorer

Routing Shield Traces with the Topology Router

Recommended Workflow for Shielding Bus Nets

Recommended Workflow for Shielding Bus Nets
Use Net Explorer to define the user group and the Topology Router to route the shield traces for 
bus nets. 

Trace-to-Trace Clearance — Space the 
critical traces far enough apart to avoid 
crosstalk and EMI problems. 

Defining sufficient spacing between 
critical traces is the simplest way to 
provide adequate shielding for many 
modern PCB designs.

Table 12-3. Comparison of Shielding Methods  (cont.)

Shielding Method Application
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Figure 12-3. Recommended Shielding Workflow 

Related Topics

Defining Shielding Rules with Net Explorer

Routing Shield Traces with the Topology Router

Methods for Shielding Buses



Special Routing Tasks
Defining Shielding Rules with Net Explorer

Layout Routing Solutions Guide, X-ENTP VX.2.5 287

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Defining Shielding Rules with Net Explorer 
Use Net Explorer to define the rules for routing shield traces around bus traces or for Sketch 
Plans.

Note
The procedure described here is the recommended “best practice” method for defining the 
shielding rules for bus paths. You can also define the shielding rules in Constraint Manager 

and import them into Layout. Use this same procedure to define shielding rules for Sketch 
Plans.

Prerequisites

• The Topology Planner and Topology Router licenses have been activated 
(Setup > Licensed Modules > Acquire Xpedition Topology Planner menu item and 
Setup > Licensed Modules > Acquire Xpedition Topology Router menu item.

Procedure

1. Choose the Route > Net Explorer menu item to open Net Explorer. 

2. From the list of net names, select the nets for the bus group or the Sketch Plan.

3. Choose the Create User Group popup menu item and enter a name for the new group.

Note
You must define a User Group for the nets you want to shield. You cannot assign a 
shielding rule to a Bus Group or to an individual net.
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The new user group appears in Net Explorer under the parent name “User Groups”.

4. With the new user group selected, choose the Place Bus Path popup menu item and 
draw a bus path in the workspace. 
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The bus path defines the general routing path that the Topology Router or the Autorouter 
should follow when routing the bus nets. The bus path is saved with the design as a route 
object for future use. (The Sketch Router works similarly for Sketch Plans.)

Tip
For clarity, check the Netlines option in Display Control, Route tab to display the 
netlines for just the bus nets.

5. In Net Explorer, select Shielding Rules, then choose the New popup menu item and 
enter a name for the new shield group. 

6. With the new shield group selected, choose the Shielding Properties popup menu item. 

7. Define the shielding rules in the Shielding Properties dialog box, then click OK.

Tip
The Shielding Net Class defines the routing rules that should apply to the shield 
traces. For general routing applications, choose the Default net class. For special 

routing requirements, define a new net class with special rules that should apply to the 
shield traces. 

8. Drag the new “Shielding Rules” group and place it on the new user group. 
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The shielding rule you defined is applied to the nets in the user group.

Tip
Select the bus path and choose the Properties > Bus Path Properties popup menu 
item to view the bus properties and shielding rules.

Note
Bus paths do not update dynamically to reflect changes you make. If you want to 
redefine the shielding rules, delete the existing rules, then define a new set of 

shielding rules that apply to the bus path. Choose the Remove Shield Rule popup menu 
item to remove shielding rules from a selected bus path or Sketch Plan.

Results

You are now ready to route the shielding traces with the Topology Router.

Related Topics

Routing Shield Traces with the Topology Router

Methods for Shielding Buses

Recommended Workflow for Shielding Bus Nets

Shielding Properties Dialog Box [Layout Operations and Reference Guide]

Net Explorer [Layout Operations and Reference Guide]

Creating Rule Area Schemes [Constraint Manager User's Manual]
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Adding Shielding Rules to Constraint Classes
You can assign a shielding rule to a Constraint Class in Net Explorer.

Prerequisites

• A shielding rule has been created in Net Explorer. See “Defining Shielding Rules with 
Net Explorer” on page 287.

Procedure

1. Choose the Route > Net Explorer menu item to open Net Explorer.

2. Select a Constraint Class, then choose the Add Shielding Rule popup menu item.

3. Choose the rule you want to assign to the Constraint class from the Shielding Rule 
dropdown list.

4. Click OK.

Tip
If you make a mistake, you can remove the shielding rule by choosing the Remove 
Shielding Rule popup menu item while the Constraint Class is selected.

Results

The shielding rule you select appears in the Shielding Rule column of Net Explorer for each net 
in the Constraint Class.

Related Topics

Assign Shielding Rule Dialog Box [Layout Operations and Reference Guide]

Routing Shield Traces with the Topology Router 
Use the Topology Router to route shield traces around bus traces.

Note
You can also route shield traces with the Autorouter (Route > Auto Route) using the Bus 
Shielding Pass Type and the Buses with Paths Items to Route settings. However, the 

results may not be as satisfactory as they would be with the Topology Router. See “Autorouting 
Techniques” on page 215. 

Prerequisites

• You must have defined a bus path and the shielding rules for the bus. See “Defining 
Shielding Rules with Net Explorer” on page 287. 

• You must activate the Topology Router license (Setup > Licensed Modules > Acquire 
Xpedition Topology Router). 
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Procedure

1. Double-click on the bus path to select the entire path, then choose Route Bus Paths 
from the popup menu to start the Topology Router.

The Topology Router routes the bus nets automatically along the bus path and generates 
shield traces according to the parameters you specified in the Shielding Rules in Net 
Explorer.

2. If the pattern of the shield traces is not acceptable, delete the bus path and redefine the 
shielding rules before routing the shield traces again.

Note: To remove shielding from a bus path and modify the shielding rules, you must 
delete the entire bus path, draw a new bus path, and then define a new set of shielding 
rules for the new bus path. 

3. Use interactive routing methods to add vias at each end of the shield traces and along the 
lengths of the shield traces, to be sure they are tied to the appropriate plane. (The 
Topology Router does not add these tie-down vias; it only routes the shield traces.) See 
“Adding Vias During Interactive Routing” on page 127. 

Tip: Alternately, you can use the Bus Shielding pass of the Autorouter to insert tie-
down vias along the shielding traces. See “Autorouting Techniques” on page 215. 

4. Perform a batch DRC around the bus traces to be sure there are no violations or 
problems.

Related Topics

Defining Shielding Rules with Net Explorer

Methods for Shielding Buses

Recommended Workflow for Shielding Bus Nets

Performing Batch DRC on a Subset of a Design [Layout Verification Guide]

Adding Shielding Interactively
You can protect critical traces from electrical interference by routing shield traces around them. 
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Shield traces typically tie to the GND plane at regular intervals to assure good connectivity 
along the entire trace run.

Figure 12-4. Example of a Shield Trace 

Alternately, in many situations you may find it more efficient to create a GND plane shape (see 
“Creating Plane Shapes and Split Planes” on page 68) to shield the area around a critical trace.

Figure 12-5. Example of a Shield Plane 

Tip
To maximize shielding, place the signal layer for the critical traces between GND planes on 
adjacent layers (see “Setting Up Plane Layers” on page 53). You may also choose to route a 

critical trace on a GND plane layer (see “Routing Traces on Planes” on page 79).

Prerequisites

• Define the shield trace widths and net classes in Constraint Manager.

• Allow loops during interactive routing: Choose the Route > Net Explorer menu item to 
open Net Explorer, select the net(s) for which you want to create loops, then click 
“Allow/Disallow Loops on Net” .

• Enable routing of the GND net in Constraint Manager to route the shield traces on a 
signal layer.

Procedure

1. Route the critical trace on the signal layer with standard interactive routing methods (see 
“Overview of Interactive Routing” on page 92).
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2. Route GND shield traces adjacent to and around the critical trace on the same signal 
layer. Use standard interactive routing methods or Hug Trace mode (see “Routing with 
Hug Trace Mode” on page 131). 

3. (Optional) Add vias at regular intervals along the shield traces that tie to the GND plane 
(see “Adding Vias During Interactive Routing” on page 127).

Tip: Fix or lock the signal trace along with the shield traces and vias so you do not edit 
them accidentally later when routing or editing other traces nearby (see “Manipulating 
Traces and Vias” on page 128).

Related Topics

Routing with Hug Trace Mode

Net Class Creation [Constraint Manager User's Manual]

Removing Unconnected Pads During Routing
You can conserve space on dense designs and provide additional routing channels by 
dynamically removing non-functional through-hole pads and through-via pads on inner layers.

The pads automatically appear or disappear based on the existence of a trace connection. The 
barrels of the pins and vias remain intact.

Procedure

1. In Padstack Editor (Setup > Libraries > Padstack Editor), Padstacks tab, assign an 
override of type (NC Pad) and pad (No Pad) to the internal layers of a through-hole or 
through-via padstack.

2. Route the connections.

Results

As you route to a pin or via with the override, the pad for that inner layer appears. When you 
remove the connection to the pin or via on that layer, the pad disappears.
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Note
Pads do not appear if they cause DRC violations to other pads. 

When you run Batch DRC, check the All pads on cover and connected internal layers option 
on the “Batch DRC dialog box - Connectivity and Special Rules tab” to ensure that the 
unconnected pads are not marked as missing pads violations.

Related Topics

Creating Layer Overrides in Padstack Editor [Common Library Editors User's Guide]

Moving Pins
You can move individual component pins to accommodate special routing requirements.

For example, you may need to shorten the standard lead spacing of a discrete through-hole 
component, such as a resistor, to open up more routing channels in a dense area.

Note
Moving a component pin could potentially generate a Hazard in Batch DRC. If you have set 
values for pin/pad to placement outline, to assembly outline, or to silkscreen, then moving a 

pin could violate these settings. You need to accept the violation in Batch DRC.

Procedure

1. Define the pins for a particular package as “movable” in Cell Editor:

a. Choose the Setup > Libraries > Cell Editor menu item to open Cell Editor.
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a. In the Package tab, select the package you want to modify, then click Properties 
.

a. In the Package Cell Properties dialog box, check Movable, click Close, then click 
OK to exit Cell Editor.

2. Click Route  to enter Route mode.

3. On any component of the package type you edited in Cell Editor, select the pin you want 
to move, then choose the Edit > Modify > Move Pin menu item.

Tip
You can also use the keyin command mp.

The pin attaches to the cursor.

4. Drag the cursor and click to place the pin in the desired location.

Related Topics

Element to Element Dialog Box [Layout Verification Guide]

Allowing Hazards in the Design [Layout Verification Guide]

Allowing Different Nets to Short 
You can intentionally connect different nets and allow the planes or traces to short at a specified 
pin or via without causing a DRC violation.

Design situations may require that different nets should tie together at specific pins (such as 
tying different power planes together at the common connector input). In Layout, you can 
define allowed shorts at those pins.

For a more persistent and visible representation of net shorting in the design, you can use 
starpoint symbols on the schematic to define how multiple nets should short at a custom, non-
component pin.

Note
If you allow net shorting for pins or vias connected to planes, the connectivity to the planes 
does not appear on negative planes. Thermal pads for allowed shorted pins or vias only 

appear on positive planes.

If you assign a net short to a via placed in a cell, then edit or reset the cell, the assignment is not 
preserved. To preserve the assignment, you must apply the MGC_CELL_OBJ_USER_ID 
property to the via prior to adding the short. See Placing Vias in the Cell Editor User's Guide.
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Procedure

1. Select the pin, via, or starpoint for the allowed short.

2. Choose Properties > Padstack Properties from the popup menu.

3. In the Padstack Properties dialog box, do the following:

4. (Optional) Generate a list of all of the allowed shorted nets in the design (Analysis > 
Allowed Net Shorting Report). 

The Net Shorting tab of the Message Window displays a list of all of the allowed shorted 
pins and vias, and gives the total count. View the file .../PCB/LogFiles/
AllowedNetShorting.txt to see the complete report.

If you want to... Do the following...

Allow shorts to a through 
pin, SMD pin, or via

1. Expand the “Shorted Net Settings” section.
2. In the “Shorted nets by layer” list, select the layer 

(or multiple layers) for the short, then click Edit. 
3. In the Nets dialog box, include the nets you want 

to connect to the selected pin or via.
4. Click OK.

The shorted net name appears in the “Shorted 
nets by layer” list.

5. (Optional) Repeat Steps 2 - 4 as needed to allow 
other nets to short to the same pin or via on 
different layers.

6. Click Apply.

The selected pin or via is allowed to connect to 
its original assigned net and also to the specified 
shorted nets.

Modify the layer 
assignments for SMD 
pads in a starpoint

1. Expand the “Starpoint Pad Settings” section.
2. In the Starpoint Pads list, choose a new layer 

from the Layer dropdown list for a particular pin 
number in the table to short the specified net to 
the SMD pad on that layer.

3. Repeat Step 2 as needed to modify the layer 
assignments for other SMD pads in the starpoint.

4. Click Apply.

The SMD pads in the selected starpoint move to 
the specified layers. This allows you to connect 
the shorted nets on different layers.
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Results

You can route traces for the different nets to the selected pin or via without causing DRC 
violations. On shorted planes, a thermal connection to each plane appears for the selected pin or 
via without DRC violations.

Related Topics

Starpoints

Padstack Properties Dialog Box [Layout Operations and Reference Guide]

Starpoints
Use starpoints to short multiple nets at one common connection point without causing DRC 
violations.

A starpoint is a special component with a single padstack connected to multiple nets. A 
starpoint defines which nets should short and the layers where the different nets connect to the 
common pin. In Layout, a starpoint is handled as a component that you can place and move. 
You can modify the layer assignments for the SMD pads in the padstack to optimize 
connectivity. Design Rule Checks (DRCs) for shorted nets are not applied to a starpoint.

Typical Use Case

Designers typically use a starpoint to provide a single common connection point for multiple 
grounds in a mixed design that has both analog and digital ground nets. The starpoint allows the 
different ground nets to short at only one pin, keeping them separated in the rest of the design. 
This helps reduce the possibility of creating unwanted ground loops and EMI radiation. This 
method of connecting multiple grounds is usually referred to as “star grounding”.

Starpoints on the Schematic

Create a starpoint symbol with enough pins to allow connections for all of the different nets you 
want to short at that point. You place a starpoint symbol on the schematic and connect the 
required nets to it like any other schematic symbol. You can also edit the starpoint like any other 
symbol.
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When the starpoint symbol is processed and forward annotated to the PCB layout, the logical 
connectivity for the shorted nets is carried across without causing error reports.

Starpoint Package Cells

A starpoint package cell must consist of one through-hole pin plus an SMD pad, placed on 
Layer 1, for each net that is connected to the starpoint (one physical pad for each pin on the 
schematic symbol). The through pin and each SMD pad must all share the same (x,y) coordinate 
location. (Turn off interactive DRC in Cell Editor when placing the pads.)

For more information about creating package cells, see Creating a Basic Package Cell.

Starpoints in the Layout

In the layout, when you place a starpoint, net shorting properties are automatically defined on 
the pads based on the connectivity defined on the schematic. Thus, all pads have the nets 
enabled for shorting. Although the starpoint is connected to multiple nets, it does not cause 
DRC violations.

You place, move, and edit a starpoint like any other component. You can connect the starpoint 
pads to planes or route traces to the pads using normal routing techniques.
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Note
Unlike regular components, starpoints are not listed in the BOM output.

Layer Assignments for Starpoint Pads

All of the SMD pads in a starpoint padstack are assigned to Layer 1 by default. You can only 
connect a specific net to its corresponding SMD pad in the starpoint. You can change the layer 
assignments for each SMD pad to customize the connectivity patterns in the layout and define 
where the physical shorting occurs. (See “Allowing Different Nets to Short” on page 296.) This 
allows you to connect the starpoint pads to planes on different layers.

Note
For starpoints, you are allowed to assign the SMD pads to inner layers.

Related Topics

Allowing Different Nets to Short

Generating Tabbed Routing
You can add tabs to routed traces to meet special routing requirements for chip designs.

Procedure

1. Open the Tabbed Routing dialog box (Route > Edit Routes > Tabbed Routing).

2. Select the type of tab (inter-digital or pin field).

3. Define the dimensions of the tabs and their pitch.

4. Select the trace (or traces) that should have tabs, then click Run.
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Results

The tabs you define are added to the selected traces in an alternating pattern on both sides of the 
traces as space allows.

If there is insufficient space along one side of a trace, tabs are only added along the side that has 
sufficient space. For differential pairs, tabs are only added to the outside of each trace.

Related Topics

Tabbed Routing Dialog Box [Layout Operations and Reference Guide]
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Teardrops and Tracedrops - Overview
You can add teardrops to component pads and tracedrops to traces for improved manufacturing.

Teardrops and Tracedrops . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 302

Generating Teardrops Automatically  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 304

Generating Teardrops for T-junctions and Neckdowns  . . . . . . . . . . . . . . . . . . . . . . . . . 306

Placing Teardrops Interactively . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 307

Changing the Shape of Teardrops . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 308

Creating Custom Curved Teardrops . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 308

Generating Tracedrops Automatically  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311

Placing Tracedrops Interactively . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313

Fixing and Locking Teardrops and Tracedrops. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 313

Deleting Teardrops and Tracedrops  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 314

Teardrops and Tracedrops
Teardrops and tracedrops are special connection patterns that optimize the trace-to-pad 
connection and improve the manufacturability of the PCB.

Teardrops taper the entry of a trace into a pad. Use teardrops where the connections may need to 
be enlarged because of concerns about hole breakout with minimum annular rings or other 
manufacturing concerns.

Figure 12-6. Example of Teardrops 
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Figure 12-7. Teardrop Attached to a Pad 

Tracedrops widen a trace as it enters a pad. (Unlike teardrops, tracedrops are a constant width 
and are not tapered.) Use tracedrops mainly for designing flex circuits where you need to 
reinforce the transition between traces and pads for improved stress relief.

Example 12-1. Example of Tracedrops 

Figure 12-8. Tracedrop Attached to a Pad 

You can add teardrops or tracedrops to all of the pads in the design automatically (see 
“Generating Teardrops Automatically” on page 304 and “Generating Tracedrops 
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Automatically” on page 311) or you can add them to individual pads interactively (see “Placing 
Teardrops Interactively” on page 307 and “Placing Tracedrops Interactively” on page 313). 

The properties that define the teardrops and tracedrops are attached to the pads (Route > 
Teardrops & Tracedrops > Teardrops, Pad Teardrops tab and Edit > Review > Padstack 
Properties).

Note: Unless you fix or lock the teardrop or tracedrop (see “Fixing and Locking Teardrops and 
Tracedrops” on page 313), the teardrop or tracedrop is deleted:

• If you delete or move the trace segment that enters the teardrop or tracedrop. 

• If you shorten the trace segment that enters the pad to less than the specified length for 
the teardrop or tracedrop.

Related Topics

Generating Teardrops Automatically

Placing Teardrops Interactively

Changing the Shape of Teardrops

Generating Tracedrops Automatically

Placing Tracedrops Interactively

Fixing and Locking Teardrops and Tracedrops

Deleting Teardrops and Tracedrops

Teardrops Dialog Box - Pad Teardrops Tab [Layout Operations and Reference Guide]

Padstack Properties Dialog Box [Layout Operations and Reference Guide]

Generating Teardrops Automatically
You can generate teardrops for all pads in the design or for selected pads.

Procedure

1. Open the Teardrops Dialog Box, Pad Teardrops tab (Route > Teardrops & 
Tracedrops > Teardrops) and select the Pad Teardrops tab.

a. Enter appropriate values for the Pad to trace and Pad to pad definitions, and check 
the appropriate options.

b. From the Process dropdown list, choose how you want to apply the pad teardrop 
generation process.

2. (Optional) Open the Teardrops Dialog Box, Multiple Via Teardrops tab (Route > 
Teardrops & Tracedrops > Teardrops) and select the Multiple Via Teardrops tab.
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a. Enter appropriate values for the Multiple Via to Multiple Via, Multiple Via to Via, 
and Multiple Via to SMD pad definitions and check the appropriate options.

b. From the Process dropdown list, choose how you want to apply the multiple via 
teardrop generation process.

3. Click OK. 

Results

Once they are generated, fix or lock the teardrops (see “Fixing and Locking Teardrops and 
Tracedrops” on page 313) to keep them in place while you route other connections. 

Tip
If the system fails to generate the teardrops because of DRC violations, you may need to 
change the teardrop properties in the Teardrops Dialog Box, Pad Teardrops tab. You can 

check for missing teardrops or tracedrops in the Review Hazards Dialog Box (Analysis > 
Review Hazards). Alternately, place the teardrops interactively if necessary (see “Placing 
Teardrops Interactively” on page 307).

Related Topics

Teardrops and Tracedrops

Deleting Teardrops and Tracedrops

Teardrops Dialog Box - Pad Teardrops Tab [Layout Operations and Reference Guide]

Teardrops Dialog Box - Multiple Via Teardrops Tab [Layout Operations and Reference Guide]

Teardrops / Tracedrops Hazards [Layout Verification Guide]
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Generating Teardrops for T-junctions and 
Neckdowns

You can generate teardrop shapes for the T-junctions of traces or where traces neck down to 
narrower widths. 

Teardrops at these junctions strengthen the trace-to-trace connection and improve the 
manufacturability of the PCB.

Figure 12-9. Example of Teardrops for T-junctions and Neckdowns 

The following conditions may prevent teardrop generation for T-junctions or neckdowns:

• The trace segments are not long enough to support the teardrop.

• The trace segments do not meet at 90 degree angles.

• Adding the teardrop may cause a clearance violation.

Procedure

1. Open the Teardrops Dialog Box, Trace Teardrops tab (Route > Teardrops & 
Tracedrops > Teardrops) and select the Trace Teardrops tab.

2. Enter appropriate values for the T-junction ratio and Neck Down ratio definitions.
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3. Choose how you want to apply the teardrop generation process from the Process 
pulldown list.

4. Click OK. 

5. (Optional) Fix or lock the teardrops to protect them from being edited accidentally later 
(see “Fixing and Locking Teardrops and Tracedrops” on page 313).

6. (Optional) If the system cannot generate teardrops for the T-junctions or neckdowns, 
you can check for the missing teardrops in the Review Hazards dialog box (Analysis > 
Review Hazards).

Results

The teardrop property attaches to the trace segments of T-junctions and neckdowns. The 
teardrop shapes you define are generated automatically and acquire the fixed/locked attributes 
of the traces or pads.

Related Topics

Teardrops and Tracedrops

Placing Teardrops Interactively

Teardrops Dialog Box, Trace Teardrops Tab [Layout Operations and Reference Guide]

Placing Teardrops Interactively
You can place a single teardrop on a selected pad. 

This is useful if you want to add a teardrop to a pad where the automatic teardrop function failed 
because of DRC violations or other limitations.

Prerequisites

• Open the Teardrops dialog box (Route > Teardrops & Tracedrops > Teardrops), 
select the Pad Teardrops tab, and verify that the teardrop settings are correct.

Procedure

1. Route the trace to the target pad (or reroute the existing trace to eliminate DRC issues 
around the target pad that prevent the placement of the teardrop).

2. Select the target pad and choose Add Teardrop from the popup menu.

Related Topics

Teardrops and Tracedrops

Generating Teardrops Automatically

Changing the Shape of Teardrops

Deleting Teardrops and Tracedrops
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Teardrops Dialog Box - Pad Teardrops Tab [Layout Operations and Reference Guide]

Changing the Shape of Teardrops
You can change the shape and size of individual teardrops to customize them for special 
situations.

This enables you to create a greater clearance around densely routed areas or match a custom 
pad shape more closely.

Procedure

1. Select the teardrop you want to modify.

The boundary of the teardrop is highlighted and the editing handles become visible. 

2. Drag the handle for a side or a vertex to a new location.

Note: Certain movements of the sides or vertices may be restricted due to the need to 
maintain continuous connectivity to the pad or trace.

Related Topics

Teardrops and Tracedrops

Generating Teardrops Automatically

Placing Teardrops Interactively

Creating Custom Curved Teardrops 
You can create non-uniform curved teardrops to accommodate special connection requirements.
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Video

Procedure

1. Choose the Route > Teardrops & Tracedrops > Curved Teardrops menu item. 

2. In the Curved Teardrops dialog box, select the desired parameters and define the Radius, 

then click the Interactive Place Curved Teardrops button . 

The Interactive Place Curved Teardrops mode becomes active.

Tip
Use the Curved Teardrops dialog box to automatically generate curved teardrops on 
selected pads and traces, or on all pads and traces in the design. The system 

generates uniform curved teardrops based on the parameters you define.

3. In the design, select the origin trace for the curved teardrops.

Note
You can create custom curved teardrops on fixed/locked traces and pads.

4. Select the target pad or trace for the curved teardrops. (Use Shift-click to select multiple 
target objects.)

5. Click anywhere in the empty workspace to confirm the selections.

Prototype images of the curved teardrops appear.

https://support.mentor.com/video/bc0ad35a-d9e5-437f-b867-fb2730a3f11d
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6. Select one of the prototype teardrops. (Or, Shift-click to select both teardrops, then click 
anywhere in the empty workspace.) 

The system creates curved teardrops where you inidicated, based on the parameters in 
the Curved Teardrops dialog box.

7. (Optional) You cannot edit curved teardrops. If you want to change existing curved 
teardrops, do the following: 

a. Click the Route Mode  toolbar button to switch to Route Mode. 

b. Select the existing teardrops, then click the Clear button in the Curved Teardrops 
dialog box to remove them. 

a. Repeat Steps 2 - 6 to recreate the curved teardrops with different parameters.
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Examples

You can create a single curved teardrop on only one side of a trace: 

You can create two curved teardrops, each with a different radius: 

You can create curved teardrops (aka tracedrops) on the junction of two traces: 

Related Topics

Generating Teardrops Automatically

Teardrops and Tracedrops

Curved Teardrops Dialog Box [Layout Operations and Reference Guide]

Generating Tracedrops Automatically
You can generate tracedrops for all pads in the design or for selected pads.

Procedure

1. Open the Tracedrops dialog box (Route > Teardrops & Tracedrops > Tracedrops).

2. Enter appropriate values for the Width and Length definitions.
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3. Check the check boxes for the component, via, and SMD pads that should have 
tracedrops, then click Apply Default Parameters to Width & Length Fields of 
Selected Pads Below.

The pads you checked are updated with the correct calculated Width and Length values 
for the tracedrops.

4. From the Process dropdown list, choose how you want to apply the tracedrop generation 
process.

5. Click OK. 

Results

Once they are generated, fix or lock the tracedrops (see “Fixing and Locking Teardrops and 
Tracedrops” on page 313) to keep them in place while you route other connections. 

Tip
If the system fails to generate the tracedrops because of DRC violations, you may need to 
change the tracedrop properties in the Tracedrops dialog box. You can check for missing 

tracedrops in the Review Hazards dialog box (Analysis > Review Hazards). Alternately, place 
the tracedrops interactively if necessary (see “Placing Tracedrops Interactively” on page 313).

Related Topics

Placing Tracedrops Interactively

Deleting Teardrops and Tracedrops

Tracedrops Dialog Box [Layout Operations and Reference Guide]

Teardrops / Tracedrops Hazards [Layout Verification Guide]
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Placing Tracedrops Interactively
You can place a single tracedrop on a selected pad. 

This is useful if you want to add a tracedrop where the automatic tracedrop function failed 
because of DRC violations or other limitations.

Prerequisites

• Open the Tracedrops dialog box (Route > Teardrops & Tracedrops > Tracedrops) 
and verify that the tracedrop definitions are correct.

Procedure

1. Route the trace to the target pad (or reroute the existing trace to eliminate DRC issues 
around the target pad that prevent the placement of the tracedrop).

2. Select the target pad and choose Add Tracedrop from the popup menu.

Related Topics

Generating Tracedrops Automatically

Deleting Teardrops and Tracedrops

Tracedrops Dialog Box [Layout Operations and Reference Guide]

Fixing and Locking Teardrops and Tracedrops
Fix or lock teardrops to prevent them from being deleted or edited accidentally while you are 
making other changes to the routing.

If you fix or lock the trace and pad, the teardrop or tracedrop is also fixed or locked and appears 
as a fixed or locked element. You can fix or lock teardrops and tracedrops separately from the 
pads and traces. This is useful if you have already placed them for manufacturability, or 
optimized connections. 

If you fix or lock a teardrop or tracedrop, you can move or modify the trace but the segment 
entering the pad remains unmodified.

Procedure

1. Select the teardrop or tracedrop, then right-click and choose either Fix/Lock > Fix or 
Fix/Lock > Lock from the popup menu.

Tip: You can multiple-select several teardrops or tracedrops, or use Edit > Add to 
Select Set to select all teardrops or tracedrops in the design.
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The teardrop or tracedrop shape changes to show that it is either fixed or locked. When 
you hover the cursor over the teardrop or tracedrop, the cursor icon indicates the fixed or 
locked state. 

2. To release the fix or lock property, select the fixed or locked teardrop or tracedrop, then 
choose either Fix/Lock > Unfix or Fix/Lock > Unlock.

Related Topics

Teardrops and Tracedrops

Deleting Teardrops and Tracedrops
Delete teardrops or tracedrops if you no longer want them in the design.

Procedure

1. Select the teardrops or tracedrops you want to delete.

Tip: Use Edit > Add to Select Set > Teardrops to select all teardrops or tracedrops in 
the design. 

2. Choose Delete from the popup menu or press the Delete key.
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Results

The traces remain connected to their target pins with the default trace width.

Related Topics

Teardrops and Tracedrops

Fixing and Locking Teardrops and Tracedrops

Sending a Net to HyperLynx LineSim
If you need to further analyze critical nets, you can send a selected net to HyperLynx LineSim 
to experiment with different trace topologies, termination schemes, and trace widths/lengths to 
optimize signal integrity.

Prerequisites

• The Design Technology is not set to RigidFlex. See “Settings Dialog Box - Design 
Settings” in the PCB Operations and Reference Guide.

Procedure

1. In Layout, select a pin, trace segment, or full net.

2. Choose Setup > Analysis Setup > Coupling Settings to adjust the settings for what is 
exported to LineSim. See “Export to LineSim Coupling Settings Dialog Box” in the 
PCB Operations and Reference Guide.

3. Right click and select Send to HyperLynx LineSim. 

Results

The Send to HyperLinx Linesim operation creates a .ffs file in <ProjectDir>/HighSpeed/
HyperLynx/PostLayoutLineSim, and invokes HyperLynx, if HyperLynx is available. 

Swapping Nets 
You can swap the net assignments for a pair of floating traces or vias (traces or vias not 
physically connected to a component pin) to optimize the netline patterns and improve routing 
success.

For example, in package designs, you can pre-place an array of vias (via farms) to transition 
between layers before routing. Use the Swap Nets function to unravel the netline patterns to 
pairs of floating vias in a via farm.

Swapping nets also enables you to optimize the netline patterns to the pins of a high density 
component when you need to manually complete the connections for a trunk-routed Sketch 
Plan.
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Note
When you use the Swap Nets function, you only change which nets are assigned to selected 
floating traces or vias. You do not change the connectivity defined in the netlist. Therefore, 

you do not need to back annotate to the schematic because the original logic does not change.

Restrictions and Limitations

• You can only swap net assignments for floating traces or vias. If you select a trace or via 
that is physically connected to a component pin, Swap Nets is not allowed and you 
receive a warning message. This prevents unintended changes to the netlist.

Video

Procedure

1. Choose the Route > Swap > Nets menu item. 

2. Select the first trace or via (not the netline) you want to swap.

Tip
Alternately, you can select the first trace or via you want to swap, then choose the 
Route > Swap > Nets menu item.

3. Select the second trace or via (not the netline) you want to swap with the first.

4. Click anywhere in the empty workspace to confirm the swap.

The nets assigned to the selected traces and vias are swapped. The netline patterns adjust 
automatically to reflect the new net assignments.

5. (Optional) Repeat Steps 2 - 4 to swap the net assignments for other trace or via pairs.

6. Right-click anywhere in the empty workspace (or press ESC) to exit the Swap Nets 
mode.

https://support.mentor.com/video/34e067ad-cd9a-46a2-8a3b-0c730ab00c29
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Examples

Before swapping nets

After swapping nets

Related Topics

Routing a Sketch Plan
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Stitch Vias - Overview
You can automatically generate and place groupings of vias that stitch layers together to meet 
special shielding or RF design requirements.

Stitch vias form shielding “walls” that pass through multiple layers of the PCB and serve as 
barriers to EMI radiation or protect against potential cross-talk problems.

You can create multiple rows of stitch vias that surround planes, traces, or RF meanders. You 
can also generate stitch via patterns that fill the interiors of planes.

Creating Stitch Vias Around Shapes and Traces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 318

Creating Stitch Vias Inside Shapes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 323

Creating Stitch Vias Around Shapes and Traces
You can create one or more rows of vias around the boundary of a shape, trace, or meander to 
meet shielding or RF design requirements.

Prerequisites

• At least one conductive shape or plane shape must exist in the design. A routed trace or 
RF meander must exist for interactive stitching.
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Video

Procedure

1. Choose the Route > Add Via menu item, then select the Stitch Contour tab.

2. Define the parameters that determine how the stitch via rows are created and located 
around the shape, trace, or meander. See Add Via Dialog Box - Stitch Contour Tab.

3. Do one of the following:

If you want to... Do the following...

Create stitch vias 
automatically around a 
conductive shape or plane 
shape

1. Choose the Triangulation-1, Triangulation-2, or 
Stagger algorithm.

Note: The Triangulation-1, Triangulation-2, 
and Stagger algorithms apply only to 

conductive shapes or plane shapes. 

Tip: Choose Triangulation-1 for most 
applications. Choose Triangulation-2 for 

situations that involve three or more rows where 
you want to maximize the number of vias. 
Choose Stagger to improve the placement of vias 
around corners and curves.

2. Click Route Mode  to select a shape.

3. Select a conductive shape or plane shape for the 
stitch vias.

4. Click Apply.

https://support.mentor.com/video/239bb1a2-f7a0-4fac-8c24-acc37ccf8475
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Rows of stitch vias are placed along the boundary of the selected shape, trace, or 
meander according to the parameters you define.

4. (Optional) If the stitch via pattern is not satisfactory, click Undo and change the 
parameters by repeating Steps 2 - 3.

Examples

The following illustrations show the different results for each algorithm.

Create stitch vias 
interactively around a 
trace or meander

1. Choose the Interactive Start/End algorithm.

2. Click Route Mode  to select a trace or RF 
meander.

Note: The Interactive Start/End algorithm 
applies only to traces or RF meanders.

3. Select a trace or RF meander for the stitch vias.
4. (Optional) Choose the desired Net name for the 

vias. (By default, this is set to the net assigned to 
the selected trace or meander.)

5. Click Apply.
6. Click next to the trace or meander where you 

want the first row of vias to start.

Ghost lines appear along the sides of the trace or 
meander to indicate the valid positions for the 
end point.

7. Click again on a ghost line next to the trace or 
meander where you want the first row of vias to 
end.

If you want to... Do the following...
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Triangulation-1:

Triangulation-2:
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Stagger:

Interactive Start/End:

Related Topics

Creating Stitch Vias Inside Shapes

Add Via Dialog Box - Stitch Contour Tab [Layout Operations and Reference Guide]
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Creating Stitch Vias Inside Shapes
You can fill the interior of a conductive shape or a plane shape with rows of vias to meet 
shielding or RF design requirements.

Prerequisites

• At least one conductive shape or plane shape must exist in the design.

Video

Procedure

1. Choose the Route > Add Via menu item, then select the Stitch Shape tab.

2. Define the parameters that determine how the stitch via rows are created and located 
inside the shape. See Add Via Dialog Box - Stitch Shape Tab.

3. Click Route Mode  to select a shape.

4. Select a conductive shape or plane shape for the stitch vias.

5. (Optional) Choose the desired Net name for the vias. (By default, this is set 
automatically to the net assigned to the selected shape. If you check “Same as shape”, 
then you cannot edit the Net name.)

6. Click Apply.

Examples

The following illustrations show typical via patterns generated using different options.

https://support.mentor.com/video/aeac5ef3-52ed-4a5c-975b-a1dd62f5a164
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Normal pattern, with Distance = <negative value>:

Normal pattern, with Distance = 0:
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Staggered pattern:

Varied pattern:

Related Topics

Creating Stitch Vias Around Shapes and Traces

Add Via Dialog Box - Stitch Shape Tab [Layout Operations and Reference Guide]

Creating Radial Via Patterns
You can place vias in a semi-circular pattern automatically to meet shielding or RF design 
requirements.
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Video

Procedure

1. Choose the Route > Add Via menu item, then select the Radial tab.

2. Define the parameters that determine how the via pattern is created. See Add Via Dialog 
Box - Radial Tab.

3. Do one of the following to mark the Location of the center of the placement arc:

• Enter the X,Y coordinate location.

• Click Pick reference , then click anywhere in the workspace.

4. Click Apply.

Examples

The following illustrations show typical radial via patterns generated using different angles. 
Note how the via spacing adjusts to accommodate the smaller circumference with Start angle = 
45.

Radial via pattern with Start angle = 0:

https://support.mentor.com/video/d0c1ae4f-bf56-496b-b5c9-a97c072312de
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Radial via pattern with Start angle = 45:

Related Topics

Creating Rectangular Via Arrays

Add Via Dialog Box - Radial Tab [Layout Operations and Reference Guide]

Creating Rectangular Via Arrays
You can place a rectangular array of vias automatically to meet shielding or RF design 
requirements.

Video

Procedure

1. Choose the Route > Add Via menu item, then select the Array tab.

2. Define the parameters that determine how the via pattern is created. See Add Via Dialog 
Box - Array Tab.

3. Do one of the following to mark the Location of the lower left via in the array:

• Enter the X,Y coordinate location.

• Click Pick reference , then click anywhere in the workspace.

https://support.mentor.com/video/84e5ace3-a157-43ae-b358-c5ec84401686


Layout Routing Solutions Guide, X-ENTP VX.2.5328

Special Routing Tasks
Creating Rectangular Via Arrays

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

4. Click Apply.

Examples

The following illustrations show typical via arrays generated using different options.

Normal array pattern:

Staggered array pattern:

Angled array pattern:

Related Topics

Creating Radial Via Patterns

Add Via Dialog Box - Array Tab [Layout Operations and Reference Guide]
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Complex Vias - Overview
You can create custom complex vias that consist of multiple vias, conductive shapes, and 
obstructs to meet special design requirements.

Complex Vias . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329

Creating Complex Vias . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 331

Creating the Elements of Complex Vias  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332

Creating Component Groups for Complex Vias  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334

Creating a ComplexViaShieldingNets.dat File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 335

ComplexViaShieldingNets.dat File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 336

Creating a Pattern File for Complex Vias . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 337

ComplexViaPatterns.dat File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 339

Complex Vias
A complex via is a user-defined custom via pattern used for special routing conditions.

Specifically, a complex via is a general non-component group that must have at least one signal 
via and includes other objects to provide special electrical conditions for routing signals 
(differential pair signals) between layers. A complex via group can contain non-signal objects, 
signal objects, and shielding signal objects:

• Non-signal objects include all types of obstructs and a part outline.

• Signal objects (for one or two signals in the case of differential pairs) include traces, vias 
(or via farms), conductive shapes, and custom trace entries (connection points).

• Shielding signal objects, like signal objects, include traces, vias (or via farms), 
conductive shapes, and custom trace entries (connection points). For shielding signal 
objects, however, the number of shielding signals is unlimited.

Complex vias enable you to create layer transitions that require special handling, such as the 
following types of vias: custom RF, shielding, HDI crankshaft, custom Multiple Via Objects 
(MVOs), or special differential pair.

Examples of Complex Vias

The following images illustrate a few types of complex vias and their possible uses.
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Figure 12-10. Complex Via with Multiple Shielding Vias

Figure 12-11. Complex Via with Shielding for Diff Pair Routing

Figure 12-12. Complex Via for Via Farm

Creation of Complex Vias

Note
To create Complex Vias, you must acquire either the Xpedition Layout 201 or 301 license.

Creating a complex via pattern involves several steps (see Creating Complex Vias). The 
definitions for complex vias are saved in an HKP format ASCII file ComplexViaPatterns.dat 
which is located in the .../PCB/Config directory. Each time you open a design in Layout, the 
system reads this file and loads the complex via patterns for use in the design.



Special Routing Tasks
Creating Complex Vias

Layout Routing Solutions Guide, X-ENTP VX.2.5 331

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Via definitions and via rules must exist in the design in which you are loading a 
ComplexViaPatterns.dat file.

For more information, see “ComplexViaPatterns.dat File” on page 339.

Placement of Complex Vias

You place a complex via in either of two ways:

• During the interactive routing process, by using the regular via placement methods and 
choosing a complex via pattern from the popup menu. See “Adding Complex Vias 
During Interactive Routing” on page 168.

• By means of the Add Via dialog box. See Add Via Dialog Box - Interactive Tab.

Manipulation of Complex Vias

Once you place a complex via, you can move it or rotate it like a frozen group. You must be in 
the Select Mode or Place Mode to manipulate a placed complex via. In Route Mode, you can 
rotate a complex via while you are placing it. When you move or rotate a complex via, all of the 
DRC rules apply.

You can unfreeze the component group that makes up a complex via and then edit the separate 
objects independently. If you unfreeze a complex via, you can still manipulate it as a single 
object if you select it using the group outline. If you dissolve the complex via group, you can no 
longer manipulate it as a group.

Connections to Complex Vias

You connect complex vias the same way you route normal connections, using the Plow 
interactive routing functions. Typically, you define one or more trace entry points (connection 
points such as regular vias or route targets) in the complex via so you can connect to it. For 
example, you can plow a connection to an unassigned via (a via assigned to Net(0)) within the 
complex via. Alternately, you can also route to an unassigned trace (a trace assigned to Net(0)) 
within a complex via and complete the connection to the trace instead of to a via or route target. 
Once you make the connection, the via or trace within the complex via adopts the net 
assignment of the connection you route to it.

Related Topics

Adding Complex Vias During Interactive Routing

Creating Complex Vias
You define complex via patterns manually by creating their various design elements and then 
grouping those in a definition file.
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The definitions for complex vias are saved in an HKP format ComplexViaPatterns.dat ASCII 
file, which is located in the PCB/Config directory. Each time you open a design in Layout, the 
system reads this file and loads the complex via patterns for use in the design.

Prerequisites

• The Xpedition Layout 201 or 301 license has been activated in the Available Licenses 
dialog box when you opened the design database.

Procedure

1. Create a custom shape for the complex via. See “Creating the Elements of Complex 
Vias” on page 332.

2. Create a component group for the complex via shape and map the elements of the shape 
to the group. See “Creating Component Groups for Complex Vias” on page 334.

3. (Optional) Create a ComplexViaShieldingNets.dat file to define the shielding 
information for the complex via. See “Creating a ComplexViaShieldingNets.dat File” 
on page 335.

Note
Creating a ComplexViaShieldingNets.dat file is not mandatory; however, if you do 
not create this file, unassigned nets display with a value of “net0” in the 

ComplexViaPatterns.dat file after you run the cvp Keyin Command. You can create this 
file anytime in the complex via creation process.

4. Generate or modify a ComplexViaPatterns.dat file. See “Creating a Pattern File for 
Complex Vias” on page 337.

5. Define connection points for the complex via structure in the ComplexViaPatterns.dat 
file. See “ComplexViaPatterns.dat File” on page 339.

Creating the Elements of Complex Vias
You can use obstructs, vias, and conductive shapes to create custom shapes for complex vias.

Procedure

1. Choose the View > Toolbars menu item to display the Draw Create, Draw Edit, and 
Snap toolbars.

2. Choose a shape from the Draw Create toolbar.

The Properties dialog box opens.

3. Choose a Conductive Shape or Obstruct Type from the dropdown list and define the 
properties of the element.
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Note
You can also open the properties dialog box first, choose a Type, then draw your 
own shape.

4. Draw a shape on the workspace.

5. Repeat steps 2 through 4 to draw a second shape.

6. Position the shapes so they intersect, then do any of the following to create the custom 
shape you want.

Tip
Hover over the toolbar button to see a video demonstration of the draw and snap 
processes.

7. Choose the Place > Add Via menu item to open the Add Via dialog box and include 
vias in the custom shape.

8. Using the Draw Create toolbar, create route obstructs, keepouts, trace obstructs and any 
traces to finalize the complex via.

If you want to... Do the following...

Merge two shapes together 1. Select the first shape to define the base area.
2. Click Merge  on the Draw Edit toolbar.

3. Select the second shape to merge with the first shape.

Remove one shape from 
another

1. Select the first shape to define the area to remain.
2. Click Subtract  on the Draw Edit toolbar.

3. Select the second shape to define the area to remove.

Copy and stack shapes on 
different layers

1. Open the Properties dialog box on a selected shape.
2. Press Ctrl + C to copy the shape.
3. In the Properties dialog box, change the layer to where you 

want to place the copy.
4. Press Ctrl + V to paste the copy over the original shape.
5. In Display Control, uncheck the layer to view the original 

shape.
6. Repeat Steps 2 - 4 for each layer.
7. In Display Control make all the layers that have a copy of 

the shape visible again.
Tip: Use the Snap functions on the Snap toolbar to align 
stacked shapes. View the shape in 3D to see the stack.
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Results

You can now assign the elements of the shape to a component group. See “Creating Component 
Groups for Complex Vias” on page 334.

Creating Component Groups for Complex Vias
Create component groups to assign the elements of the complex via custom shape to signal or 
shielding sub-groups.

Prerequisites

• A custom shape has been created for a complex via. See “Creating the Elements of 
Complex Vias” on page 332

Procedure

1. Choose the Place > Component Explorer menu item to open Component Explorer.

2. In the Navigation pane, select the top level of the design, then click New  to create a 
component group for the elements.

3. Rename the group using one of the following required conventions:

• For a single net complex via, use the prefix “Single_”.

• For a diff pair complex via, use the prefix “Diffpair_”.

Note
If you do not use the correct prefix, the file will not generate.

4. Map the elements in the shape to the group as follows:

a. Right-click the group, then choose Set to Active Group from the popup menu.

b. In the workspace, select the route obstructs and keepouts, then choose Selection > 
Add Selected to Active Group from the popup menu.

c. Create sub-level groups “Signaln” and “Shieldingn” for the other elements.

Note
You can have only one signal group for a single net or two signal groups for a 
diffpair complex via. (Signal1 for one half of the diffpair, Signal2 for the other 

half of the diffpair.) You can have multiple shield layers.

d. Select a sub-group to make Active, then select the elements from the shape to 
include in that group. Repeat until all the elements are assigned to their respective 
groups.
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Tip
Use Display Control to display active layers to make it easier to select specific 
elements on each layer.

Results

You are now ready to create the pattern file that defines the complex vias in the design. See 
“Creating a Pattern File for Complex Vias” on page 337.

Creating a ComplexViaShieldingNets.dat File 
The ComplexViaShieldingNets.dat file contains net assignments for shielding elements in a 
complex via. The information in the file is also used by the ComplexViaPatterns.dat file to 
define nets for specific complex via patterns.

Note
Creating a ComplexViaShieldingNets.dat file is not mandatory; however, if you do not 
create this file, unassigned nets display with a value of “net0” in the 

ComplexViaPatterns.dat file after you run the cvp Keyin Command. 

Procedure

1. Open a text editor.

2. Type the required information for the shielding net assignments. See the 
“ComplexViaShieldingNets.dat File” on page 336 reference topic for the syntax to use.

3. Save the file to the Config directory of the design. 

Examples

An example of the ComplexViaShieldingNets.dat file format. 

.FILETYPECOMPLEX_VIA_SHIELDING_ASSIGNMENT

.VERSION "01.00"

.DEFAULT

..NETNAME "1,GND"

..NETNAME "2,VCC

.PATTERN "diffpair_cv"

..NETNAME "2,VDD"

Related Topics

ComplexViaShieldingNets.dat File
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ComplexViaShieldingNets.dat File
Use a text editor to create a file that contains shielding information.

The ComplexViaShieldingNets.dat file contains net assignments for shielding elements in a 
complex via. The information in the file is used by the ComplexViaPatterns.dat file to define 
nets for specific complex via patterns.

Format

The ComplexViaShieldingNets.dat file consists of a Header section and a body section.

• Header section — This section identifies the name and version number of the 
ComplexViaPatterns.dat file.

• Body section — This section contains sub-sections that describe the net assignments for 
patterns in the complex via.

Parameters

• .FILETYPE COMPLEX_VIA_SHIELDING_ASSIGNMENT

Defines the side file as a shielding rules file.

• .VERSION “xx.xx.xx”

Defines the version number of the side file within quotes. This is not the version number of 
the Layout software.

• .DEFAULT

Describes the default net assignment for patterns if patterns are not specifically defined in 
the file. This section is optional.

o ..NETNAME “<virtual net index>,<real net name>”

Defines the virtual net to real net assignment.

• .PATTERN “<pattern_name>”

Describes the net assignment override for the named complex via pattern.

o ..NETNAME “<virtual net index>,<real net name>”

Defines the virtual net to real net assignment. This value overrides the default 
NETNAME for the same net.

Note
If you want to assign a virtual net to “net0”, omit “NETNAME” for the virtual 
net.
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Examples

Example of ComplexViaShieldingNets.dat file

Related Topics

Creating a ComplexViaShieldingNets.dat File

Creating a Pattern File for Complex Vias
Use keyin commands to create the ComplexViaPatterns.dat file, then edit it to define the 
connection points.

The ComplexViaPatterns.dat file contains information that defines the complex vias and 
enables you to use those complex vias in the design.

Prerequisites

• A custom shape has been created for a complex via. See “Creating the Elements of 
Complex Vias” on page 332.

• Complex via elements have been mapped to sub-groups under the complex via 
component group. See “Creating Component Groups for Complex Vias” on page 334

Procedure

1. In the Component Explorer navigation pane, right-click the top-level group for the 
complex via and choose Set to Active Group from the popup menu.

2. On the workspace, select the group of complex via elements and type the following 
command:

cvp -c [-noDrc] <pattern_name>

The Keyin Command dialog box opens automatically when you begin typing.

Note
-noDrc is optional. It tells Batch DRC not to validate clearances between the objects 
in the Complex Via structure. See the cvp command description under Keyins.
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3. Press Enter to generate the ComplexViaPatterns.dat file, or add to an existing file.

The ComplexViaPatterns.dat file is generated in the Config directory of the design.

Tip
Check for errors in the format by running cvp -l to list the valid complex vias in the 
design. If nothing shows up, you can assume there are format errors.

4. Define connection points for each element that requires a connection point and add other 
information, as needed.

a. Using a text editor, open the ComplexViaPatterns.dat file.

b. Type the required information for the elements. See the “ComplexViaPatterns.dat 
File” on page 339 reference topic for the syntax to use.

5. Save and close the ComplexViaPatterns.dat file.

Results

If there are no errors in the format, the complex via pattern is available for use when you open 
the design. You can run the cvp -l command to see a list of available complex via patterns.

If there are errors in the format, you are notified of parsing errors when you open the design. 
You can open the ComplexViaParserErr.txt log file in File Viewer to view the errors.

Related Topics

ComplexViaPatterns.dat File
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ComplexViaPatterns.dat File
Generated when you run the cvp -c [-noDrc] <pattern_name> keyin command.

The ComplexViaPatterns.dat file contains information for all the defined complex vias and 
enables you to use those complex vias in the design.

Format

The ComplexViaPatterns.dat file consists of a Header section and a body section.

• Header section — This section identifies the side file and specifies certain global 
parameters in the design (version, units).

• Body section — This section contains pattern definitions for each complex via in the 
design. Each pattern contains information on the individual objects or elements that 
make up the complex via. The information that is not provided in the file when it is 
generated must be entered manually.

Parameters

• .FILETYPE COMPLEX_VIA_PATTERNS

Defines the side file as a complex via rules file.

• .VERSION “xx.xx.xx”

Defines the version number of the side file within quotes. This is not the version number of 
the Layout software. 

Note
The version number does not increment nor does the value change with 
modifications to the file. The only indicator of changes are the timestamps for the 

Pattern. See TEXT “MGC_COMPLEX_VIA_TIME_STAMP”.

• .UNITS xx

Specifies the units of measure used in the design file: th, in, cm, mm, um, nm. The UNITS 
value must match the units setting in the design.

• .PATTERN

Designates the start of a complex via pattern definition.

• ..PATTERNNAME “<pattern name>”

Defines a unique name for the pattern. The pattern name is not case-sensitive.

• ..PATTERNTYPE <type>

Identifies the type of complex via: SINGLE or DIFFPAIR.

• ..TEXT “$MGC_COMPLEX_VIA_TIME_STAMP” “timestamp”

Indicates that the complex via has been modified and the cvp -c command has been rerun to 
regenerate the via. The timestamp is displayed in EPOCH time format.
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• ..PATTERNREFPT (<x>,<y>)

(Optional) Defines the reference point of the pattern, which serves as the origin for Move 
commands. For example, it can be the center point for rotate actions or the point to snap a 
complex via to the Via grid when placing a via farm. 

Note
If this line is absent, a reference point is assigned automatically to vias that have one 
signal in a complex via or to the center of a complex via that clips a rectangle.

• ..<OBJECT>

Specifies the name of the object or element in the complex via. (OBSTRUCT, 
PLACEMENT_KEEPOUT, TRACE, VIA, CONDUCTIVE_AREA).

Obstructs

o ..<OBSTRUCT_TYPE>

Allowed types are:

..OBSTRUCT TRACE_VIA

..OBSTRUCT TRACE

..OBSTRUCT VIA

..OBSTRUCT TUNING

..OBSTRUCT TESTPOINT

..OBSTRUCT PLANE

..PLANE_NOCONNECT

o ...ROUTE_LYR LYR_n

n=1 for OBSTRUCT TESTPOINT on Top; n>1 for OBSTRUCT TESTPOINT on 
Bottom. Omit this argument if the layer = <All>.

o ...<GEOMETRY>

See “GEOMETRY definitions” on page 343.

o ...TEXT “$MGC_COMPLEX_VIA_NET” “n”

....TEXT_TYPE PROPERTY_PAIR

Positive numbers identify signal nets. The value of n for a single signal net is “1". 
The values of n for diffpair signal nets are "1" and "2". You cannot have any other 
positive numbers for signal nets. Negative numbers for n identify shielding nets (for 
example, -1, -2, and so on).

The value “ALL” for n identifies all nets in the design. “ALL” is the only setting 
allowed for routing obstructs (TRACE, VIA, TRACE_VIA types). In the “ALL” 



Special Routing Tasks
ComplexViaPatterns.dat File

Layout Routing Solutions Guide, X-ENTP VX.2.5 341

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

case, the obstruct does not affect all active signal nets assigned to complex vias (“1” 
for single signal nets, “2” for diffpair signal nets). For shielding nets, the obstruct 
works as an obstruct every time.

Defines the signal nets to ignore for TRACE, VIA, TRACE_VIA types. For 
example:

...TEXT "$MGC_COMPLEX_VIA_NET" "ALL"

....TEXT_TYPE PROPERTY_PAIR

Defines the virtual nets to ignore for PLANE type, separated by comma. For 
example:

...TEXT "$MGC_COMPLEX_VIA_NET" "-1,-2"

....TEXT_TYPE PROPERTY_PAIR

Use “ALL” for all signal virtual nets, “ALL_SHLD” for all signal and shielding 
virtual nets. For example:

...TEXT "$MGC_COMPLEX_VIA_NET" "ALL"

....TEXT_TYPE PROPERTY_PAIR

...TEXT "$MGC_COMPLEX_VIA_NET" "ALL,ALL_SHLD"

....TEXT_TYPE PROPERTY_PAIR

Placement Keepouts

o ..PLACEMENT_KEEPOUT

o ...ROUTE_LYR LYR_n

Use n=1 for keepout on Top; n>1 for keepout on Bottom.

o ...HEIGHT_height

o ...<GEOMETRY>

See “GEOMETRY definitions” on page 343.

Vias

o ..VIA

o ...XY (x,y)

Defines the via coordinates.

o PADSTACK “padstack_name”

Defines the name of the padstack in quotes.

o LAYER_PAIR LYR_n LYR_m

Defines the via span (n-m). You must be able to read the via span in the Setup 
Parameters dialog box, Via Definitions tab.
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Note
If you define a span as n-m, then you can still place the via in a stackup “nd-md”, 
where “m>md” with span “n-md”.

For example, if you load a ComplexViaPatterns.dat file into a 4 layer design, but the 
.dat file has a definition for a 6 layer board, the code adjusts to match the layer 
stackup of the 4 layer design. In this case, a complex via with a span 1-6 loads 
successfully into a 4 layer design and adjusts to span 1-4; a complex via with a span 
2-6 adjusts to span 2-4.

o VIA_OPTIONS <option>

The option is NONE, FIXED, or LOCKED.

o ...TEXT “$MGC_COMPLEX_VIA_NET”

....TEXT_TYPE PROPERTY_PAIR

Note
Positive numbers identify signal nets. The value for a single signal net is “1". 
The values for diffpair signal nets are "1" and "2". You cannot have any other 

positive numbers for signal nets. Negative numbers identify shielding nets (for 
example, -1, -2, and so on).

Defines the virtual signal. 

...TEXT "$MGC_COMPLEX_VIA_NET" "1”

....TEXT_TYPE PROPERTY_PAIR

o ...ROTATION 

By default, the rotation value is zero so the parameter is not written to the 
ComplexViaPatterns.dat file. It appears only if there is a non-round via that has been 
placed in a non-zero rotation.

Traces

o ..TRACE

o ...ROUTE_LYR LYR_n

n=layer number.

o ...<GEOMETRY>

See “GEOMETRY definitions” on page 343.

o ...TEXT “$MGC_COMPLEX_VIA_NET”

....TEXT_TYPE PROPERTY_PAIR
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Note
Positive numbers identify signal nets. The value for a single signal net is “1". 
The values for diffpair signal nets are "1" and "2". You cannot have any other 

positive numbers for signal nets. Negative numbers identify shielding nets (for 
example, -1, -2, and so on).

Defines the virtual signal. 

...TEXT "$MGC_COMPLEX_VIA_NET" "1”

....TEXT_TYPE PROPERTY_PAIR

Conductive Shapes

o ..CONDUCTIVE_AREA

o ...TEXT “$MGC_COMPLEX_VIA_NET”

....TEXT_TYPE PROPERTY_PAIR

Note
Positive numbers identify signal nets. The value for a single signal net is “1". 
The values for diffpair signal nets are "1" and "2". You cannot have any other 

positive numbers for signal nets. Negative numbers identify shielding nets (for 
example, -1, -2, and so on).

Defines the virtual signal. 

...TEXT "$MGC_COMPLEX_VIA_NET" "1”

....TEXT_TYPE PROPERTY_PAIR

o ...TEXT “PLANE_ID” “n”

....TEXT_TYPE PROPERTY_PAIR

Defines a unique identifier for a plane shape. (The software generates the 
“PLANE_ID” “n” entry when you run the cvp -c command.)

Note
Do not add or modify the “PLANE_ID” “n” descriptor.

o ...ROUTE_LYR LYR_n

n=layer number.

o ...<GEOMETRY>

See “GEOMETRY definitions” on page 343.

• GEOMETRY definitions

o CIRCLE_PATH — A circle that is a path. You can specify the width of the path, 
the style of the path (SOLIDLINE, DASHLINE, DOTLINE, DASHDOTLINE, 
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DASHDOTDOTLINE), the xy center of the circle, the radius, and the displayed 
width of the path. 

.CIRCLE_PATH

..WIDTH n

..STYLE style

..XY (x,y)

..RADIUS n
[..DISPLAY_WIDTH n]

o CIRCLE_SHAPE — A circle that is a shape. You can specify the shape option 
when displayed (NOT_FILLED, FILLED), the xy center of the circle, the radius, the 
displayed width of the periphery, and cutouts.

.CIRCLE_SHAPE

..SHAPE_OPTIONS k (k=NOT_FILLED or FILLED)

..XY (x,y)

..RADIUS n
[..DISPLAY_WIDTH n]
[..CUTOUTS n]

o RECT_PATH — An rectangle that is a path. You can specify the width of the path, 
the style of the path (SOLIDLINE, DASHLINE, DOTLINE, DASHDOTLINE, 
DASHDOTDOTLINE), the low xy and high xy corners of the rectangle, and the 
displayed width of the path.

.RECT_PATH

..WIDTH n

..STYLE style

..XY (x,y) (x,y)
[..DISPLAY_WIDTH n]

o RECT_SHAPE — An rectangle that is a shape. You can specify the shape option 
when displayed (NOT_FILLED, FILLED), the low xy and high xy corners of the 
rectangle, the displayed width of the periphery, and cutouts.

.RECT_SHAPE

..SHAPE_OPTIONS k (k=NOT_FILLED or FILLED)

..XY (x,y) (x,y)
[..DISPLAY_WIDTH n]
[..CUTOUTS n]

o POLYLINE_PATH — A progression of line segments that form a path. You can 
specify the width of the path, the style of the path (SOLIDLINE, DASHLINE, 
DOTLINE, DASHDOTLINE, DASHDOTDOTLINE), the xy list, and the displayed 
width of the path.

.POLYLINE_PATH

..WIDTH n

..STYLE style (style=SOLIDLINE, DASHLINE, DOTLINE, DASHDOTLINE, 
or DASHDOTDOTLINE)
..XY (x,y)
[..DISPLAY_WIDTH n]
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o POLYLINE_SHAPE — A progression of line segments that form a shape. You can 
specify the shape option when displayed (NOT_FILLED, FILLED), the xy list, the 
displayed width of the periphery, and cutouts.

.POLYLINE_SHAPE

..SHAPE_OPTIONS k (k=NOT_FILLED or FILLED)

..XY (x,y)
[..DISPLAY_WIDTH n]
[..CUTOUTS n]

o POLYARC_PATH — A progression of line segments or arc segments that form a 
path. You can specify the width of the path, the style of the path (SOLIDLINE, 
DASHLINE, DOTLINE, DASHDOTLINE, DASHDOTDOTLINE), the xyr list 
where r = the radius of the arc (if r = 0 then x,y is the start of a line segment to the 
next point), and the displayed width of the path.

.POLYLINE_PATH

..WIDTH n

..STYLE style (style=SOLIDLINE, DASHLINE, DOTLINE, DASHDOTLINE, 
or DASHDOTDOTLINE)
..XYR (x,y)
[..DISPLAY_WIDTH n]

o POLYARC_SHAPE — A progression of line segments or arc segments that form a 
shape. You can specify the shape option when displayed (NOT_FILLED, FILLED), 
the xyr list where r = the radius of the arc (if r = 0 then x,y is the start of a line 
segment to the next point), the displayed width of the periphery, and cutouts.

.POLYARC_SHAPE

..SHAPE_OPTIONS k (k=NOT_FILLED or FILLED)

..XYR (x,y,r)
[..DISPLAY_WIDTH n]
[..CUTOUTS]

o CUTOUTS — Cutout shapes within other shapes. Supported only in 
PLACEMENT_OUTLINE, PLACEMENT_KEEPOUT, and 
CONDUCTIVE_AREA type plane.

[..CIRCLE_SHAPE]
[..RECT_SHAPE]
[..POLYLINE_SHAPE]
[..POLYARC_SHAPE]
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Examples

Syntax examples for different objects in a complex via pattern:

• Example for obstruct that blocks all except the specific net:

..OBSTRUCT TRACE_VIA

...TEXT "$MGC_COMPLEX_VIA_NET" "ALL"

....TEXT_TYPE PROPERTY_PAIR

...RECT_SHAPE

....SHAPE_OPTIONS FILLED

....XY (1216.625236220473, 644.779566929134) (1266.625236220473, 
744.779566929134)

• Example for obstruct that blocks a specific net:

..OBSTRUCT TRACE_VIA

...TEXT "$MGC_COMPLEX_VIA_NET" "ALL"

....TEXT_TYPE PROPERTY_PAIR

...RECT_SHAPE 

....SHAPE_OPTIONS FILLED

....XY (1216.625236220473, 644.779566929134) (1266.625236220473, 
744.779566929134)

• Example for traces

..TRACE

...ROUTE_LYR LYR_1

...TRACE_OPTIONS NONE

...TEXT "$MGC_COMPLEX_VIA_NET" "2"

....TEXT_TYPE PROPERTY_PAIR

...TEXT "$MGC_COMPLEX_VIA_CPNT" "BO(1238.118818897638, 
754.983267716535)"
....TEXT_TYPE PROPERTY_PAIR
...POLYLINE_PATH
....WIDTH 13.000000000000
....XY (1238.118818897638, 725.483267716535)       
(1238.118818897638, 754.983267716535)

• Example for Vias

..VIA

...XY (1238.118818897638, 672.336732283465)

...PADSTACK "026VIA"

...LAYER_PAIR LYR_3 LYR_8

...VIA_OPTIONS NONE

...TEXT "$MGC_COMPLEX_VIA_NET" "2"

....TEXT_TYPE PROPERTY_PAIR

...TEXT "$MGC_COMPLEX_VIA_CPNT" "BT 3"

....TEXT_TYPE PROPERTY_PAIR

...ROTATION 180

• Example for Conductive areas
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..CONDUCTIVE_AREA

...TEXT "$MGC_COMPLEX_VIA_NET" "-1"

....TEXT_TYPE PROPERTY_PAIR

...TEXT "PLANE_ID" "2"

....TEXT_TYPE PROPERTY_PAIR

...ROUTE_LYR LYR_1

...CONDUCTIVE_AREA_OPTIONS CONDUCTIVE_SHAPE NONE

...POLYLINE_SHAPE

....SHAPE_OPTIONS FILLED

....XY (1378.611811023622, 679.906023622047)
       (1328.611811023622, 679.906023622047)
       (1328.611811023622, 629.906023622047)
       (1203.611811023622, 629.906023622047)
       (1203.611811023622, 679.906023622047)
       (1153.611811023622, 679.906023622047)
       (1153.611811023622, 579.906023622047)
       (1378.611811023622, 579.906023622047)

A connection point that has defined coordinates is represented as follows:

...TEXT "$MGC_COMPLEX_VIA_CPNT" "BT (-300.15,-600.1743)"

....TEXT_TYPE PROPERTY_PAIR

A connection point at the center of a conductive shape is represented as follows:

...TEXT "$MGC_COMPLEX_VIA_CPNT" "TB"

....TEXT_TYPE PROPERTY_PAIR

Graphic examples to show how complex via elements appear in the file:

• The highlighted section in the file shows the addition of a connection point to the end of 
the trace. The graphic shows the trace end in the via. The arrows point to the XY 
coordinate.
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• The highlighting shows that the shielding net parameter must be added to a conductive 
shape.

• Not all traces require a connection point. If you do not want to connect to a trace that is 
part of a complex via, a connection point is not required. The graphic shows where you 
should not add a parameter.

For a placed complex via, there is no specific limitation for connections to any part of 
the complex via like there is for a general group. Use the connection point property 
($MGC_COMPLEX_VIA_CPNT) in a complex via pattern definition only when you 
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place a complex via while in Plow mode. You should define connection points for both 
the start and end layers if you want to connect to them in Plow mode.

• You must add parameters for shielding vias. The keyin command does not automatically 
add the parameter.
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Example of pattern file.
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Related Topics

Creating a Pattern File for Complex Vias
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Chapter 13
Test Point Techniques

You can define and modify test points as you route the design. 

Test Workflows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 353

Defining Test Clearance Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 356

Creating a Test Fixture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357

Creating a Test Point Obstruct. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357

Creating a Test Area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 358

Setting Up Test Point Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 359

Placing Test Points Interactively  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360

Importing the Number of Test Points Per Net  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360

Adding Test Points to Nets Automatically. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 361

Displaying Test Point Items in the Design . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 362

Test Point File Formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 364

Creating Test Probes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 366

Assigning Test Probes to Test Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 367

Placing Test Probes and Test Points  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368

Verifying Test Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 370

Creating Test Outputs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 371

Test Workflows
Layout provides two Design for Test (DFT) workflows: a basic test point workflow and a more 
comprehensive test probe/test point workflow.
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Figure 13-1. Test Point Workflow

With a Design for Test license, your design can include test probe definitions. The test probes 
include their physical dimensions and clearance rules. 
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Figure 13-2. Test Probes and Test Points Workflow
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Defining Test Clearance Rules 
You should set up the clearance rules for test point elements prior to beginning test point 
placement. 

You should enable Online DRC so that placement is checked automatically while you place or 
move test points. Interactive placement uses the Online DRC mode set in the Editor Control, 
Place tab. Set the Online Placement DRC mode to Preventative to disable placements of test 
points that violate a clearance rule. 

Automatic placement procedures are always correct by construction based on the defined 
clearance rules.

Procedure

1. Set clearance rules for test points with one or more of the following methods:

2. Set up Online DRC for placing test points interactively.

a. Open the Editor Control ( Setup > Editor Control) and click the Place tab. 

b. Expand the General options section and check Preventative in the Online 2D 
Placement DRC field. 

c. Expand the Common Settings section and check Interactive Place/Route DRC. 

3. Set up Batch DRC for incremental and final batch checks.

a. Open Batch DRC dialog box ( Analysis > Batch DRC) and click the DRC Settings 
tab. 

b. Check Connectivity and special rules. 

c. If you have defined test probes, check Test Probe clearances and rules. 

d. If you need to define rules for test point elements to other elements (for example, 
cavities or the board outline), click Advanced Element to Element Rules. 

If you want to... Refer to... 

Set the default clearance rule for test 
point center to test point center.

“Specifying General Clearance Rules” in 
the Constraint Manager User’s Manual.

Set clearance rules between test 
points and other conductive objects 
(for example, traces and vias). 

Note: test points use SMD pad rules. 

”Physical Rule Definition” in the 
Constraint Manager User’s Manual.

Set test probe specific rules. 
(Requires a Design for Test license.)

“Creating Test Probes” on page 366 
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e. In the Element to Element dialog box, enter clearances for the test point elements to 
other elements and then click OK. 

f. In the Batch DRC dialog box, set up other options as required by your design.

Related Topics

Setting Online Checking for Placement [Layout Verification Guide]

Batch DRC [Layout Verification Guide]

Batch DRC Dialog Box - DRC Settings Tab [Layout Verification Guide]

Element to Element Dialog Box [Layout Verification Guide]

Physical Rule Definition [Constraint Manager User's Manual]

Setting Up and Running Batch DRC [Layout Verification Guide]

Creating a Test Fixture
Include the test fixture outline in your design to better understand what features to add to the 
board for testing.

The test fixture outline represents the physical area of a test fixture.

Procedure

1. Choose Rectangle from the Draw Create toolbar.

2. In the Properties dialog box, set Type to Test Fixture Outline.

3. Draw the area that defines the test fixture in the design workspace.

4. If you cannot see the test fixture, see “Displaying Test Point Items in the Design” on 
page 362.

Tip
You may need to add unplated mounting holes to your board to help align the PCB 
with test fixture.

Related Topics

Test Fixture Outline [Layout Operations and Reference Guide]

Adding Mechanical Features [Layout Operations and Reference Guide]

Creating a Test Point Obstruct
Create test point obstructs (keepouts) to prohibit placement of test points in certain areas of the 
board. 
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You can add multiple test point obstructs on the board.

If you place the test points automatically, you might be able to take advantage of options 
already available.

• The Setup Parameters dialog box, General tab (Setup > Setup Parameters) provides an 
option to use the assembly outline of cells as test point obstructs.

• The Test Probe Setup and Assignment dialog box, Test Probe Placement tab (Place > 
Test Points > Test Probe Setup and Assignment) provides options to use the 
placement outline and the assembly outline of cells as test point obstructs. 

You can also add test point obstructs to cells. See “Adding Obstructs” in the Cell Editor User’s 
Guide. 

Procedure

1. Choose a closed shape (Polygon, Rectangle, or Circle) from the Draw Create toolbar.

2. In the Properties dialog box, set Type to Test Point Obstruct.

3. Choose the layer(s) on which to place the obstruct. Select (All) for both the top and 
bottom of the board.

4. Draw the area that defines the obstruct in the design workspace.

5. If you cannot see the test point obstructs, see “Displaying Test Point Items in the 
Design” on page 362.

Related Topics

Test Point Obstruct [Layout Operations and Reference Guide]

Creating a Test Area
Create test point rule areas so you can assign specific test point sizes and clearance rules to 
certain areas of the board. 

This enables you to define denser test areas, for example to test a fine-pitch device such as a 
BGA.

Procedure

1. Choose Draw > Rule Area.

The Properties dialog box appears, with Type set to Rule Area.

2. Select a closed shape (Rectangle or Polygon) from the Draw Create toolbar.

3. In the design workspace, draw the test area.



Test Point Techniques
Setting Up Test Point Parameters

Layout Routing Solutions Guide, X-ENTP VX.2.5 359

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Tip
You can create a rule area from any existing element by selecting the element and 
creating a copy (Ctrl+Double-click), then changing the Draw Object to a Rule Area 

in the Properties dialog box.

4. In the Properties dialog box, set the following properties:

• Layer — Select the layer(s) on which to place the test area. Typically this is the 
bottom or the top.

• DFT Area — Check to indicate this area as a test area. 

• DFT Area Name — Enter a unique name.

• Test Point Cell — Choose the allowed test points from the dropdown list. Choose 
(Any) to allow all test points. 

5. If you cannot see the rule area, see “Displaying Test Point Items in the Design” on 
page 362.

Related Topics

Rule Area [Layout Operations and Reference Guide]

Setting Up Test Point Parameters
Define the test point parameters before you begin placing test points in the design.

The parameters include the default test point, the reference designator prefix, and the sides of 
the board on which to place test points.

Prerequisites

• Test points cells must exist in the design.

Procedure

1. Open the Setup Parameters dialog box (Setup > Setup Parameters) and click the 
General tab.

2. In the Test point settings section, set the following options:

a. Choose a default test point cell.

b. Enter a test point grid value or choose (None).

Note: You can also define the test point grid in the Grids tab of the Editor Control 
dialog box.

c. Choose the side(s) on which to place test points.

d. Enter a prefix for the test point reference designators. (You must specify a prefix.)



Layout Routing Solutions Guide, X-ENTP VX.2.5360

Test Point Techniques
Placing Test Points Interactively

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

e. Click OK.

Related Topics

Setup Parameters Dialog Box - General Tab [Layout Operations and Reference Guide]

Creating a Testpoint Cell [Cell Editor User's Guide]

Placing Test Points Interactively
You can place test points manually on selected nets in your design.

You can place them directly on a pin, via, or trace, or in other unconnected locations.

Prerequisites

• Test points cells must exist in the design. See “Creating a Testpoint Cell” in the Cell 
Editor User’s Guide.

• You must have set up test point parameters in the Setup Parameters dialog box, General 
tab. See “Setting Up Test Point Parameters” on page 359.

Procedure

1. Select a net.

2. Choose Place > Test Points > Place.

The test point attaches to the cursor with a netline to a nearby connection point on the 
net.

3. If you require a different test point, choose a new test point from the popup menu.

4. Click to place the test point.

5. (Optional) You can modify the test point with options in the popup menu. For example, 
pushing to the opposite side of the board or snapping to a specific location.

6. If you did not place the test point to directly connect it to the net, interactively route the 
test point using Plow (F3). 

Note: You can delete test points by selecting them and choosing Delete from the popup 
menu.

Related Topics

Displaying Test Point Items in the Design

Importing the Number of Test Points Per Net
You can import a file that specifies the number of test points per net name.
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After importing the file, use interactive or automatic test point placement methods to place the 
test points.

Prerequisites

• You must have an ASCII file that contains the net names and the number of test points 
per net. See “Test Point File Formats” on page 364.

Procedure

1. Open the Test Points from File dialog box (Place > Test Points > Test Points from 
File).

2. Select the file that contains the number of testpoints per net for the design. Click OK.

3. If you have a Design for Test license, the number of test points populates the Test Probe 
Setup and Assignment dialog box, Test Probe Placement tab. 

4. If you do not have a Design for Test license, the number of test points populates the Test 
Point Assignment dialog box. Place the test points using “Adding Test Points to Nets 
Automatically” on page 361. 

Note
If you add more test points than required, use Place > Test Points > Remove Extra 
Test Points to remove the extras.

Related Topics

Displaying Test Point Items in the Design

Adding Test Points to Nets Automatically
You can specify the number of test points per net and have the system add them to the nets 
automatically using a prioritized list of test point locations.

Prerequisites

• Test points cells must exist in the design. See “Creating a Testpoint Cell” and 
“Importing Cells to the Design” in the Cell Editor User’s Guide.

• You must have set up test point parameters in the Setup Parameters dialog box, General 
tab. See “Setting Up Test Point Parameters” on page 359.

Procedure

1. Open the Test Point Assignment dialog box (Place > Test Points > Auto Assign).

2. For each net that requires testing, enter the number of test points required in the 
Required column.
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Tip
You can optionally import the number of test points using a file format. See 
“Importing the Number of Test Points Per Net” on page 360.

3. Select and prioritize the locations where test points are allowed:

a. In the Locations in priority order field (lower right corner of the dialog box), 
uncheck locations where test points are not allowed.

b. Prioritize the allowed locations using the up and down arrows. 

The top location gets the highest priority.

4. If you want test points fixed after they are automatically placed, check Place test points 
fixed. 

5. Click Place to automatically add the test points.

The number of placed test points is updated in the dialog box.

6. Check Display only nets needing test points to determine if any nets require additional 
test points.

7. Add test points to any remaining nets that require test points:

a. Double-click the Net Name of a net.

In the workspace, a default test point automatically attaches to the cursor near a 
connection point of the net.

b. Place the test point interactively using the steps in “Placing Test Points 
Interactively” on page 360.

Related Topics

Displaying Test Point Items in the Design

Test Point Assignment Dialog Box [Layout Operations and Reference Guide]

Displaying Test Point Items in the Design
Set up the Display Control to view (and select) test point elements such as test points, obstructs, 
test areas, and the test fixture outline. 

Procedure

1. Open the Display Control (View > Display Control).
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2. Use one or more of the following methods to display test point elements: 

3. Check or uncheck other sections as required. 

4. Save the Display Control settings as a scheme, for example, “loc: View TP Data”.

Related Topics

Saving, Modifying, and Reusing Settings and Assignments With Schemes [Layout Operations 
and Reference Guide]

If you want to... Do the following... 

Display and select test point 
obstructs

1. Click the Objects tab.
2. Check and expand the Place section and check Test 

Point Obstructs. 
3. Click the Edit tab, expand the Global View & 

Interactive Selection section.
4. Check and expand the Route Objects section, check 

Route Obstructs. Check Visibility as required.

Display and select test points 1. Click the Objects tab.
2. Check and expand the Pins section and check Test 

Point - Top and Test Point - Bottom. 
3. Click the Edit tab, expand the Global View & 

Interactive Selection section.
4. Check and expand the Route Objects section, check 

Pins, Test Point - Top and Test Point - Bottom. 
Check Visibility and Selection as required.

Display and select test probe 
graphics

1. Click the Fab tab.
2. Check and expand the Fabrication Objects section.
3. Check and expand Test Point Items.
4. Check Probe Graphics.

Display and select test areas 1. Click the Objects tab.
2. Check and expand the Route Areas section.
3. Check Rule Areas.

Display and select the test fixture 
outline

1. Click the Fab tab.
2. Check and expand the Board Objects section.
3. Check and expand the Board Elements section.
4. Check Test Fixture Outline.
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Test Point File Formats
You can use an ASCII input file to automatically place test points.

The file has different formats depending on licensing options and the intended function.

File format for required number of test points per net

Generated by: End-user

Read by: Test Points from File dialog box

Each line specifies the net name and the required number of test points for the net. 

• If you have a Design for Test license - The software populates the Test Probe & 
Assignment dialog box with the required number of test points per net when you read 
the file with the Test Points from File dialog box.

• If you do not have a Design for Test license - The software populates the Test Point 
Assignment dialog box with the required number of test points per net when you read 
the file with the Test Points from File dialog box.

Example

• Prefix comment lines with an exclamation mark (!).

Function File Format License

Import number of test points per 
specified net.

“File format for required 
number of test points per 
net” on page 364 

Design for Test 
(DFT) or None

Import test point locations and 
automatically place them using the 
default test point.

“File format for test point 
locations” on page 365 

None

Import test point locations, 
designate a specific test point cell, 
and automatically place the test 
points.

“File format for specifying 
test point cells and 
locations” on page 365

Design for Test 
(DFT)

!NetName ReqdNoOfTestPoints

VCC 24

OUT(1) 2

CLKAA 2
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File format for test point locations

Generated by: End-user

Read by: Test Points from File dialog box

Each line specifies a net and the location to place a test point. When you import the file, the 
software automatically places the test points. If DRC placement violations result, the test point 
placement fails and an error is written to the TestPtPlacement.txt log file. 

Example

• Rotation, Side, and Fix/Lock are optional fields. If not specified, Rotation is 0, Side is 
Top, and Fix/Lock status is None.

• Rotation specifies the rotation of the REFDES in degrees. The test point cell and 
REFDES prefix are defined in the General tab of the Setup Parameters dialog box. The 
REFDES value is the next available number.

• Prefix comment lines with an exclamation mark (!).

File format for specifying test point cells and locations

Generated by: Export Test Point Placement dialog box

Read by: Import Test Point Placement dialog box

Each line specifies the test point cell and the location to place the test point. When you import 
the file, the software automatically places the test points. If DRC violations result, the test point 
placement fails and an error is written to the TestPointImport.txt log file.

Note
You must define the number of test points per net in the Test Probe and Assignments dialog 
box prior to importing this file.

Example:

.units th

!Net xlocation ylocation [Rotation] [Side] [Fix/Lock]

XSIGo1007
4

3922.5 175 90 Top

CLKAA 985 3115 90 Bottom

OUT(1) 3275 275 90 Top

.units th
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• REFDES is ignored on import.

• Rotation specifies the rotation of the REFDES in degrees. 

• Fix/lock flags are 0= None, 2=Fixed, 3=Locked.

• The REFDES prefix is defined in the Test Probe Placement tab of the Test Probe Setup 
and Assignments dialog box. The REFDES value is the next available number.

• Prefix comment lines with an exclamation mark (!).

Related Topics

Importing the Number of Test Points Per Net

Creating Test Probes
Create test probes by specifying their dimensions and clearances.

Prerequisites

• You must have acquired an Xpedition FabLink license when you opened Layout. You 
must also choose the Setup > Settings > Design Settings Test Points menu item to 
open the Settings dialog box - Test Points pane, then select the “Define test probe and 
test point rules” option.

Procedure

1. Choose the Place > Test Points > Test Probe Setup and Assignment menu item to 
open the Test Probe Setup and Assignment dialog box, then click the Test Probe Setup 
tab.

2. Define the design units (lower-left corner of the dialog box).

3. Add a probe by clicking  and renaming the probe as required. (Use descriptive 
naming conventions that include the diameter of the tip and its pitch).

4. Enter the dimensions for the body diameter (BD) and the tip diameter (TD) of the probe.

Note
The graphic in the dialog box highlights as you click in each table cell. This helps 
you see the element you are defining.

!cell xlocation ylocation side net name Rotation Fix/Lock [REFDE
S]

TP 1500 3100 Bottom DGND 90 0 TP28

TP 985 2960 Top VREF_D
DR

0 0 TP29
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5. Enter the probe clearance rules using the clearance definitions and the graphic in the 
dialog box.

6. Create additional probes by repeating Steps 3-5.

7. Specify the default probe by checking Set default probe and then selecting the radio 
button next to the probe name.

8. If your design has tall components, you can add additional clearance for the probe body:

a. In the Override for height range field, click . 

b. Enter the range for the component height and the corresponding probe body to 
component clearance rule. Repeat for each component height range.

c. If the height minimum and maximum values overlap, use the up and down arrows to 
prioritize the clearance value to use. Values at the top of the list have the highest 
priority.

9. To reuse the dialog box settings, including the probe definitions, save them as a scheme.

The scheme does not save design-specific settings (for example, number of test points 
per net or test points). 

Results

You are now ready to assign test probes to test points. See “Assigning Test Probes to Test 
Points” on page 367.

Related Topics

Test Probe Setup and Assignment Dialog Box - Test Probe Setup Tab [Layout Operations and 
Reference Guide]

Saving, Modifying, and Reusing Settings and Assignments With Schemes [Layout Operations 
and Reference Guide]

Assigning Test Probes to Test Points
You can assign a test probe to a test point, or assign the same test probe to multiple test points. 

After assignment, you can import the test points and their associated test probes back into your 
library. This enables you to reuse test point/ test probe assignments in other designs.

Prerequisites

• Test points cells must exist in the design. See “Creating a Testpoint Cell” and 
“Importing Cells to the Design” in the Cell Editor User’s Guide.

• You must have acquired an Xpedition FabLink license when you opened Layout. You 
must also choose the Setup > Settings > Design Settings Test Points menu item to 
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open the Settings dialog box - Test Points pane, then select the “Define test probe and 
test point rules” option.

Procedure

1. Choose the Place > Test Points > Test Probe Setup and Assignment menu item to 
open the Test Probe Setup and Assignment dialog box, then click the Test Probe 
Assignment tab.

2. Select a test probe for each test point in your design.

The graphic shows the test probe body diameter (green outer circle) and the tip diameter 
(green inner circle) that is currently assigned to the selected test point (red).

Tip
If you want to save the test probe to test point association to reuse in other designs, 
import the test points into the Central Library with Library Services. The test probe 

information is stored with the test points. See “Library Services Dialog Box - Cells Tab” 
in the Common Library Editors User’s Guide.

Results

You are now ready to place test points. See “Placing Test Probes and Test Points” on page 368.

Related Topics

Test Probe Setup and Assignment Dialog Box - Test Probe Setup Tab [Layout Operations and 
Reference Guide]

Placing Test Probes and Test Points
You can place test points and test probes automatically. 

You can place by area with location prioritization and test point prioritization. You can split the 
process into passes so you can place one side before placing the opposite side.

Prerequisites

• You must have acquired an Xpedition FabLink license when you opened Layout. You 
must also choose the Setup > Settings > Design Settings Test Points menu item to 
open the Settings dialog box - Test Points pane, then select the “Define test probe and 
test point rules” option.

Procedure

1. If you want to enable push and shove during test point placement:

a. Open the Editor Control (Setup > Editor Control) and click the Route tab.

b. Expand the Edit & Route Controls section and check the required options in the 
Push & Shove section. 
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2. Choose the Place > Test Points > Test Probe Setup and Assignment menu item to 
open the Test Probe Setup and Assignment dialog box, then click the Test Probe 
Placement tab.

3. Enter the number of test points required for each signal net and for each power net. 

Note: If you are placing test points on both sides of the board, you may need to enter the 
number of test points for one side, complete this procedure, enter the number of test 
points for the opposite side, then complete this procedure a second time.

Tip: You can also import the number of test points required on each net from a file. See 
“Importing the Number of Test Points Per Net” on page 360.

4. Set up the test point options:

a. In the Options section, set the test point grid if a grid is required, otherwise choose 
(None).

b. Enter the Ref Des prefix. You must specify a prefix.

c. Choose the test side(s).

d. If test points should be fixed after placement, check Place test points fixed.

e. Check other options as required.

5. Set up the priority order for test point locations by checking and prioritizing them with 
the up and down arrows.

6. Set up the allowed test points by checking and prioritizing them with the up and down 
arrows.

Tip: For best results, place the larger test points first, followed by smaller test points.

7. If you are only placing test points in a specific test area, check Place within DFT area 
only and check the required test area(s).

8. Click Auto Place to automatically place the test probes and test points.

The number of placed test points is updated in the dialog box.

9. Check Display only nets needing test points to determine if any nets require additional 
test points.

10. Add test points to any remaining nets that require test points:

a. Double-click the Net Name of a net.

In the workspace, a default test point automatically attaches to the cursor near a 
connection point of the net. 

b. Place the test point interactively using the steps in “Placing Test Points 
Interactively” on page 360.
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11. If you need to add test points to the other side of the board, change the Test side option 
and repeat Steps 3 - 10.

12. To reuse the dialog box settings including the placement options and location priorities, 
save them as a scheme.

The scheme does not save design specific settings, for example, number of test points 
per net or test points. 

Results

After you have placed all test points, you can create reports and verify the test points with Batch 
DRC. See “Creating Test Outputs” on page 371 and “Verifying Test Data” on page 370.

Related Topics

Test Probe Setup and Assignment Dialog Box - Test Probe Placement Tab [Layout Operations 
and Reference Guide]

Saving, Modifying, and Reusing Settings and Assignments With Schemes [Layout Operations 
and Reference Guide]

Editor Control Dialog Box - Route Tab [Layout Operations and Reference Guide]

Verifying Test Data
You can verify that you have not introduced errors during test point placement by checking for 
both Online and Batch Hazards.

Prerequisites

• You must have set up clearance rules. See “Defining Test Clearance Rules” on 
page 356.

Procedure

1. Review Online violations that occur during interactive placement with the Online menu 
in the Review Hazards dialog box.

2. Run Batch DRC and check for violations periodically and when you believe your design 
is complete:

a. Run Batch DRC.

b. Review and correct violations found during Batch DRC with the Batch menu in the 
Review Hazards dialog box.

Results

You are now ready to generate test output. See “Creating Test Outputs” on page 371.



Test Point Techniques
Creating Test Outputs

Layout Routing Solutions Guide, X-ENTP VX.2.5 371

Note - Viewing PDF files within a web browser causes some links not to function. Use HTML for full navigation.

Related Topics

Batch DRC [Layout Verification Guide]

Reviewing Hazards [Layout Verification Guide]

Setting Up and Running Batch DRC [Layout Verification Guide]

Creating Test Outputs
After you complete test point assignments and satisfy design rule checks, you can generate 
output reports and data. 

Test output includes:

• Test Summary — (testptsum##.txt) Lists added test points including location and side, 
total test points per side, and required/remaining list.

• ECO Report — (testpteco##.txt) Lists test point changes between the design state at the 
beginning of the design session and the current state of the design.

• Generic ATE — Exports test point data in an ASCII file that you can edit for a specific 
testing requirement.

• Mitron GenCad — Export test point data that is compatible with CIMBridge.

• Test Probe Placement Data — Exports Test probe data in a ASCII format that you can 
reuse in other variants or revisions of the design. 

• Neutral File Format — Exports test point data, including net, location, side, and 
reference designator in an ASCII format that you can send to testing software. Most 
testing software reads the Mentor Graphics Neutral File Format.

Procedure

Create test point outputs in any of the following ways: 

If you want to... See... 

Report the current status of test 
point placement 

“Test Point Assignment Dialog Box” in the 
PCB Operations and Reference Guide, Test 
Summary option

Report the current status of test 
point placement and test probe 
definitions

(Xpedition FabLink license and 
“Define test probe and test point 
rules” option set)

“Test Probe Setup and Assignment Dialog 
Box - Test Probe Placement Tab” in the PCB 
Operations and Reference Guide, Test 
Summary option
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Related Topics

Verifying Test Data

Report the test point changes for 
the current design session.

“Test Point Assignment Dialog Box” in the 
PCB Operations and Reference Guide, ECO 
Report option

Report the test point and test 
probe changes for the current 
design session.

(Xpedition FabLink license and 
“Define test probe and test point 
rules” option set)

“Test Probe Setup and Assignment Dialog 
Box - Test Probe Placement Tab” in the PCB 
Operations and Reference Guide, ECO 
Report option

Export test point and test probe 
data in Neutral File Format.

“Create XE Neutral File Dialog Box” in the 
Manufacturing Inputs and Outputs Guide

Export Generic ATE or Mitron 
GenCad formats.

“General Interfaces Dialog Box” in the 
Manufacturing Inputs and Outputs Guide

Export test point and test probe 
data.

(Xpedition FabLink license and 
“Define test probe and test point 
rules” option set)

“Export Test Point Placement Dialog Box” in 
the PCB Operations and Reference Guide

and

“Test Point File Formats” on page 364

Import test point and test probe 
data.

(Xpedition FabLink license and 
“Define test probe and test point 
rules” option set)

“Import Test Point Placement Dialog Box” in 
the PCB Operations and Reference Guide

and

“Test Point File Formats” on page 364

If you want to... See... 
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End-User License Agreement

The latest version of the End-User License Agreement is available on-line at:
www.mentor.com/eula

END-USER LICENSE AGREEMENT (“Agreement”)

This is a legal agreement concerning the use of Software (as defined in Section 2) and hardware (collectively “Products”)
between the company acquiring the Products (“Customer”), and the Mentor Graphics entity that issued the corresponding
quotation or, if no quotation was issued, the applicable local Mentor Graphics entity (“Mentor Graphics”). Except for license
agreements related to the subject matter of this license agreement which are physically signed by Customer and an authorized
representative of Mentor Graphics, this Agreement and the applicable quotation contain the parties’ entire understanding
relating to the subject matter and supersede all prior or contemporaneous agreements. If Customer does not agree to these
terms and conditions, promptly return or, in the case of Software received electronically, certify destruction of Software and all
accompanying items within five days after receipt of Software and receive a full refund of any license fee paid.

1. ORDERS, FEES AND PAYMENT. 

1.1. To the extent Customer (or if agreed by Mentor Graphics, Customer’s appointed third party buying agent) places and Mentor
Graphics accepts purchase orders pursuant to this Agreement (each an “Order”), each Order will constitute a contract between
Customer and Mentor Graphics, which shall be governed solely and exclusively by the terms and conditions of this Agreement,
any applicable addenda and the applicable quotation, whether or not those documents are referenced on the Order. Any
additional or conflicting terms and conditions appearing on an Order or presented in any electronic portal or automated order
management system, whether or not required to be electronically accepted, will not be effective unless agreed in writing and
physically signed by an authorized representative of Customer and Mentor Graphics.

1.2. Amounts invoiced will be paid, in the currency specified on the applicable invoice, within 30 days from the date of such invoice.
Any past due invoices will be subject to the imposition of interest charges in the amount of one and one-half percent per month
or the applicable legal rate currently in effect, whichever is lower. Prices do not include freight, insurance, customs duties, taxes
or other similar charges, which Mentor Graphics will state separately in the applicable invoice. Unless timely provided with a
valid certificate of exemption or other evidence that items are not taxable, Mentor Graphics will invoice Customer for all
applicable taxes including, but not limited to, VAT, GST, sales tax, consumption tax and service tax. Customer will make all
payments free and clear of, and without reduction for, any withholding or other taxes; any such taxes imposed on payments by
Customer hereunder will be Customer’s sole responsibility. If Customer appoints a third party to place purchase orders and/or
make payments on Customer’s behalf, Customer shall be liable for payment under Orders placed by such third party in the event
of default.

1.3. All Products are delivered FCA factory (Incoterms 2010), freight prepaid and invoiced to Customer, except Software delivered
electronically, which shall be deemed delivered when made available to Customer for download. Mentor Graphics retains a
security interest in all Products delivered under this Agreement, to secure payment of the purchase price of such Products, and
Customer agrees to sign any documents that Mentor Graphics determines to be necessary or convenient for use in filing or
perfecting such security interest. Mentor Graphics’ delivery of Software by electronic means is subject to Customer’s provision
of both a primary and an alternate e-mail address.

2. GRANT OF LICENSE. The software installed, downloaded, or otherwise acquired by Customer under this Agreement, including any
updates, modifications, revisions, copies, documentation, setup files and design data (“Software”) are copyrighted, trade secret and
confidential information of Mentor Graphics or its licensors, who maintain exclusive title to all Software and retain all rights not
expressly granted by this Agreement. Except for Software that is embeddable (“Embedded Software”), which is licensed pursuant to
separate embedded software terms or an embedded software supplement, Mentor Graphics grants to Customer, subject to payment of
applicable license fees, a nontransferable, nonexclusive license to use Software solely: (a) in machine-readable, object-code form
(except as provided in Subsection 4.2); (b) for Customer’s internal business purposes; (c) for the term of the license; and (d) on the
computer hardware and at the site authorized by Mentor Graphics. A site is restricted to a one-half mile (800 meter) radius. Customer
may have Software temporarily used by an employee for telecommuting purposes from locations other than a Customer office, such as
the employee’s residence, an airport or hotel, provided that such employee’s primary place of employment is the site where the
Software is authorized for use. Mentor Graphics’ standard policies and programs, which vary depending on Software, license fees paid
or services purchased, apply to the following: (a) relocation of Software; (b) use of Software, which may be limited, for example, to
execution of a single session by a single user on the authorized hardware or for a restricted period of time (such limitations may be
technically implemented through the use of authorization codes or similar devices); and (c) support services provided, including
eligibility to receive telephone support, updates, modifications, and revisions. For the avoidance of doubt, if Customer provides any
feedback or requests any change or enhancement to Products, whether in the course of receiving support or consulting services,
evaluating Products, performing beta testing or otherwise, any inventions, product improvements, modifications or developments made
by Mentor Graphics (at Mentor Graphics’ sole discretion) will be the exclusive property of Mentor Graphics.

 IMPORTANT INFORMATION 

USE OF ALL SOFTWARE IS SUBJECT TO LICENSE RESTRICTIONS. CAREFULLY READ THIS LICENSE 
AGREEMENT BEFORE USING THE PRODUCTS. USE OF SOFTWARE INDICATES CUSTOMER’S COMPLETE 
AND UNCONDITIONAL ACCEPTANCE OF THE TERMS AND CONDITIONS SET FORTH IN THIS AGREEMENT. 

ANY ADDITIONAL OR DIFFERENT PURCHASE ORDER TERMS AND CONDITIONS SHALL NOT APPLY.

http://www.mentor.com/eula


3. BETA CODE. 

3.1. Portions or all of certain Software may contain code for experimental testing and evaluation (which may be either alpha or beta,
collectively “Beta Code”), which may not be used without Mentor Graphics’ explicit authorization. Upon Mentor Graphics’
authorization, Mentor Graphics grants to Customer a temporary, nontransferable, nonexclusive license for experimental use to
test and evaluate the Beta Code without charge for a limited period of time specified by Mentor Graphics. Mentor Graphics may
choose, at its sole discretion, not to release Beta Code commercially in any form.

3.2. If Mentor Graphics authorizes Customer to use the Beta Code, Customer agrees to evaluate and test the Beta Code under normal
conditions as directed by Mentor Graphics. Customer will contact Mentor Graphics periodically during Customer’s use of the
Beta Code to discuss any malfunctions or suggested improvements. Upon completion of Customer’s evaluation and testing,
Customer will send to Mentor Graphics a written evaluation of the Beta Code, including its strengths, weaknesses and
recommended improvements.

3.3. Customer agrees to maintain Beta Code in confidence and shall restrict access to the Beta Code, including the methods and
concepts utilized therein, solely to those employees and Customer location(s) authorized by Mentor Graphics to perform beta
testing. Customer agrees that any written evaluations and all inventions, product improvements, modifications or developments
that Mentor Graphics conceived or made during or subsequent to this Agreement, including those based partly or wholly on
Customer’s feedback, will be the exclusive property of Mentor Graphics. Mentor Graphics will have exclusive rights, title and
interest in all such property. The provisions of this Subsection 3.3 shall survive termination of this Agreement.

4. RESTRICTIONS ON USE. 

4.1. Customer may copy Software only as reasonably necessary to support the authorized use. Each copy must include all notices
and legends embedded in Software and affixed to its medium and container as received from Mentor Graphics. All copies shall
remain the property of Mentor Graphics or its licensors. Except for Embedded Software that has been embedded in executable
code form in Customer’s product(s), Customer shall maintain a record of the number and primary location of all copies of
Software, including copies merged with other software, and shall make those records available to Mentor Graphics upon
request. Customer shall not make Products available in any form to any person other than Customer’s employees and on-site
contractors, excluding Mentor Graphics competitors, whose job performance requires access and who are under obligations of
confidentiality. Customer shall take appropriate action to protect the confidentiality of Products and ensure that any person
permitted access does not disclose or use Products except as permitted by this Agreement. Customer shall give Mentor Graphics
written notice of any unauthorized disclosure or use of the Products as soon as Customer becomes aware of such unauthorized
disclosure or use. Customer acknowledges that Software provided hereunder may contain source code which is proprietary and
its confidentiality is of the highest importance and value to Mentor Graphics. Customer acknowledges that Mentor Graphics
may be seriously harmed if such source code is disclosed in violation of this Agreement. Except as otherwise permitted for
purposes of interoperability as specified by applicable and mandatory local law, Customer shall not reverse-assemble,
disassemble, reverse-compile, or reverse-engineer any Product, or in any way derive any source code from Software that is not
provided to Customer in source code form. Log files, data files, rule files and script files generated by or for the Software
(collectively “Files”), including without limitation files containing Standard Verification Rule Format (“SVRF”) and Tcl
Verification Format (“TVF”) which are Mentor Graphics’ trade secret and proprietary syntaxes for expressing process rules,
constitute or include confidential information of Mentor Graphics. Customer may share Files with third parties, excluding
Mentor Graphics competitors, provided that the confidentiality of such Files is protected by written agreement at least as well as
Customer protects other information of a similar nature or importance, but in any case with at least reasonable care. Customer
may use Files containing SVRF or TVF only with Mentor Graphics products. Under no circumstances shall Customer use
Products or Files or allow their use for the purpose of developing, enhancing or marketing any product that is in any way
competitive with Products, or disclose to any third party the results of, or information pertaining to, any benchmark.

4.2. If any Software or portions thereof are provided in source code form, Customer will use the source code only to correct software
errors and enhance or modify the Software for the authorized use, or as permitted for Embedded Software under separate
embedded software terms or an embedded software supplement. Customer shall not disclose or permit disclosure of source
code, in whole or in part, including any of its methods or concepts, to anyone except Customer’s employees or on-site
contractors, excluding Mentor Graphics competitors, with a need to know. Customer shall not copy or compile source code in
any manner except to support this authorized use.

4.3. Customer agrees that it will not subject any Product to any open source software (“OSS”) license that conflicts with this
Agreement or that does not otherwise apply to such Product.

4.4. Customer may not assign this Agreement or the rights and duties under it, or relocate, sublicense, or otherwise transfer the
Products, whether by operation of law or otherwise (“Attempted Transfer”), without Mentor Graphics’ prior written consent and
payment of Mentor Graphics’ then-current applicable relocation and/or transfer fees. Any Attempted Transfer without Mentor
Graphics’ prior written consent shall be a material breach of this Agreement and may, at Mentor Graphics’ option, result in the
immediate termination of the Agreement and/or the licenses granted under this Agreement. The terms of this Agreement,
including without limitation the licensing and assignment provisions, shall be binding upon Customer’s permitted successors in
interest and assigns.

4.5. The provisions of this Section 4 shall survive the termination of this Agreement.

5. SUPPORT SERVICES. To the extent Customer purchases support services, Mentor Graphics will provide Customer with updates and
technical support for the Products, at the Customer site(s) for which support is purchased, in accordance with Mentor Graphics’ then
current End-User Support Terms located at http://supportnet.mentor.com/supportterms.

6. OPEN SOURCE SOFTWARE. Products may contain OSS or code distributed under a proprietary third party license agreement, to
which additional rights or obligations (“Third Party Terms”) may apply. Please see the applicable Product documentation (including
license files, header files, read-me files or source code) for details. In the event of conflict between the terms of this Agreement

http://supportnet.mentor.com/supportterms


(including any addenda) and the Third Party Terms, the Third Party Terms will control solely with respect to the OSS or third party
code. The provisions of this Section 6 shall survive the termination of this Agreement.

7. LIMITED WARRANTY. 

7.1. Mentor Graphics warrants that during the warranty period its standard, generally supported Products, when properly installed,
will substantially conform to the functional specifications set forth in the applicable user manual. Mentor Graphics does not
warrant that Products will meet Customer’s requirements or that operation of Products will be uninterrupted or error free. The
warranty period is 90 days starting on the 15th day after delivery or upon installation, whichever first occurs. Customer must
notify Mentor Graphics in writing of any nonconformity within the warranty period. For the avoidance of doubt, this warranty
applies only to the initial shipment of Software under an Order and does not renew or reset, for example, with the delivery of (a)
Software updates or (b) authorization codes or alternate Software under a transaction involving Software re-mix. This warranty
shall not be valid if Products have been subject to misuse, unauthorized modification, improper installation or Customer is not in
compliance with this Agreement. MENTOR GRAPHICS’ ENTIRE LIABILITY AND CUSTOMER’S EXCLUSIVE
REMEDY SHALL BE, AT MENTOR GRAPHICS’ OPTION, EITHER (A) REFUND OF THE PRICE PAID UPON
RETURN OF THE PRODUCTS TO MENTOR GRAPHICS OR (B) MODIFICATION OR REPLACEMENT OF THE
PRODUCTS THAT DO NOT MEET THIS LIMITED WARRANTY. MENTOR GRAPHICS MAKES NO WARRANTIES
WITH RESPECT TO: (A) SERVICES; (B) PRODUCTS PROVIDED AT NO CHARGE; OR (C) BETA CODE; ALL OF
WHICH ARE PROVIDED “AS IS.”

7.2. THE WARRANTIES SET FORTH IN THIS SECTION 7 ARE EXCLUSIVE. NEITHER MENTOR GRAPHICS NOR ITS
LICENSORS MAKE ANY OTHER WARRANTIES EXPRESS, IMPLIED OR STATUTORY, WITH RESPECT TO
PRODUCTS PROVIDED UNDER THIS AGREEMENT. MENTOR GRAPHICS AND ITS LICENSORS SPECIFICALLY
DISCLAIM ALL IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NON-INFRINGEMENT OF INTELLECTUAL PROPERTY.

8. LIMITATION OF LIABILITY. TO THE EXTENT PERMITTED UNDER APPLICABLE LAW, IN NO EVENT SHALL
MENTOR GRAPHICS OR ITS LICENSORS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES (INCLUDING LOST PROFITS OR SAVINGS) WHETHER BASED ON CONTRACT, TORT OR ANY OTHER
LEGAL THEORY, EVEN IF MENTOR GRAPHICS OR ITS LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. IN NO EVENT SHALL MENTOR GRAPHICS’ OR ITS LICENSORS’ LIABILITY UNDER THIS
AGREEMENT EXCEED THE AMOUNT RECEIVED FROM CUSTOMER FOR THE HARDWARE, SOFTWARE LICENSE OR
SERVICE GIVING RISE TO THE CLAIM. IN THE CASE WHERE NO AMOUNT WAS PAID, MENTOR GRAPHICS AND ITS
LICENSORS SHALL HAVE NO LIABILITY FOR ANY DAMAGES WHATSOEVER. THE PROVISIONS OF THIS SECTION 8
SHALL SURVIVE THE TERMINATION OF THIS AGREEMENT.

9. THIRD PARTY CLAIMS. 

9.1. Customer acknowledges that Mentor Graphics has no control over the testing of Customer’s products, or the specific
applications and use of Products. Mentor Graphics and its licensors shall not be liable for any claim or demand made against
Customer by any third party, except to the extent such claim is covered under Section 10.

9.2. In the event that a third party makes a claim against Mentor Graphics arising out of the use of Customer’s products, Mentor
Graphics will give Customer prompt notice of such claim. At Customer’s option and expense, Customer may take sole control
of the defense and any settlement of such claim. Customer WILL reimburse and hold harmless Mentor Graphics for any
LIABILITY, damages, settlement amounts, costs and expenses, including reasonable attorney’s fees, incurred by or awarded
against Mentor Graphics or its licensors in connection with such claims.

9.3. The provisions of this Section 9 shall survive any expiration or termination of this Agreement.

10. INFRINGEMENT. 

10.1. Mentor Graphics will defend or settle, at its option and expense, any action brought against Customer in the United States,
Canada, Japan, or member state of the European Union which alleges that any standard, generally supported Product acquired
by Customer hereunder infringes a patent or copyright or misappropriates a trade secret in such jurisdiction. Mentor Graphics
will pay costs and damages finally awarded against Customer that are attributable to such action. Customer understands and
agrees that as conditions to Mentor Graphics’ obligations under this section Customer must: (a) notify Mentor Graphics
promptly in writing of the action; (b) provide Mentor Graphics all reasonable information and assistance to settle or defend the
action; and (c) grant Mentor Graphics sole authority and control of the defense or settlement of the action.

10.2. If a claim is made under Subsection 10.1 Mentor Graphics may, at its option and expense: (a) replace or modify the Product so
that it becomes noninfringing; (b) procure for Customer the right to continue using the Product; or (c) require the return of the
Product and refund to Customer any purchase price or license fee paid, less a reasonable allowance for use.

10.3. Mentor Graphics has no liability to Customer if the action is based upon: (a) the combination of Software or hardware with any
product not furnished by Mentor Graphics; (b) the modification of the Product other than by Mentor Graphics; (c) the use of
other than a current unaltered release of Software; (d) the use of the Product as part of an infringing process; (e) a product that
Customer makes, uses, or sells; (f) any Beta Code or Product provided at no charge; (g) any software provided by Mentor
Graphics’ licensors who do not provide such indemnification to Mentor Graphics’ customers; (h) OSS, except to the extent that
the infringement is directly caused by Mentor Graphics’ modifications to such OSS; or (i) infringement by Customer that is
deemed willful. In the case of (i), Customer shall reimburse Mentor Graphics for its reasonable attorney fees and other costs
related to the action.

10.4. THIS SECTION 10 IS SUBJECT TO SECTION 8 ABOVE AND STATES THE ENTIRE LIABILITY OF MENTOR
GRAPHICS AND ITS LICENSORS, AND CUSTOMER’S SOLE AND EXCLUSIVE REMEDY, FOR DEFENSE,



SETTLEMENT AND DAMAGES, WITH RESPECT TO ANY ALLEGED PATENT OR COPYRIGHT INFRINGEMENT
OR TRADE SECRET MISAPPROPRIATION BY ANY PRODUCT PROVIDED UNDER THIS AGREEMENT.

11. TERMINATION AND EFFECT OF TERMINATION. 

11.1. If a Software license was provided for limited term use, such license will automatically terminate at the end of the authorized
term. Mentor Graphics may terminate this Agreement and/or any license granted under this Agreement immediately upon
written notice if Customer: (a) exceeds the scope of the license or otherwise fails to comply with the licensing or confidentiality
provisions of this Agreement, or (b) becomes insolvent, files a bankruptcy petition, institutes proceedings for liquidation or
winding up or enters into an agreement to assign its assets for the benefit of creditors. For any other material breach of any
provision of this Agreement, Mentor Graphics may terminate this Agreement and/or any license granted under this Agreement
upon 30 days written notice if Customer fails to cure the breach within the 30 day notice period. Termination of this Agreement
or any license granted hereunder will not affect Customer’s obligation to pay for Products shipped or licenses granted prior to
the termination, which amounts shall be payable immediately upon the date of termination.

11.2. Upon termination of this Agreement, the rights and obligations of the parties shall cease except as expressly set forth in this
Agreement. Upon termination of this Agreement and/or any license granted under this Agreement, Customer shall ensure that
all use of the affected Products ceases, and shall return hardware and either return to Mentor Graphics or destroy Software in
Customer’s possession, including all copies and documentation, and certify in writing to Mentor Graphics within ten business
days of the termination date that Customer no longer possesses any of the affected Products or copies of Software in any form.

12. EXPORT. The Products provided hereunder are subject to regulation by local laws and European Union (“E.U.”) and United States
(“U.S.”) government agencies, which prohibit export, re-export or diversion of certain products, information about the products, and
direct or indirect products thereof, to certain countries and certain persons. Customer agrees that it will not export or re-export Products
in any manner without first obtaining all necessary approval from appropriate local, E.U. and U.S. government agencies. If Customer
wishes to disclose any information to Mentor Graphics that is subject to any E.U., U.S. or other applicable export restrictions, including
without limitation the U.S. International Traffic in Arms Regulations (ITAR) or special controls under the Export Administration
Regulations (EAR), Customer will notify Mentor Graphics personnel, in advance of each instance of disclosure, that such information
is subject to such export restrictions.

13. U.S. GOVERNMENT LICENSE RIGHTS. Software was developed entirely at private expense. The parties agree that all Software is
commercial computer software within the meaning of the applicable acquisition regulations. Accordingly, pursuant to U.S. FAR 48
CFR 12.212 and DFAR 48 CFR 227.7202, use, duplication and disclosure of the Software by or for the U.S. government or a U.S.
government subcontractor is subject solely to the terms and conditions set forth in this Agreement, which shall supersede any
conflicting terms or conditions in any government order document, except for provisions which are contrary to applicable mandatory
federal laws.

14. THIRD PARTY BENEFICIARY. Mentor Graphics Corporation, Mentor Graphics (Ireland) Limited, Microsoft Corporation and
other licensors may be third party beneficiaries of this Agreement with the right to enforce the obligations set forth herein.

15. REVIEW OF LICENSE USAGE. Customer will monitor the access to and use of Software. With prior written notice and during
Customer’s normal business hours, Mentor Graphics may engage an internationally recognized accounting firm to review Customer’s
software monitoring system and records deemed relevant by the internationally recognized accounting firm to confirm Customer’s
compliance with the terms of this Agreement or U.S. or other local export laws. Such review may include FlexNet (or successor
product) report log files that Customer shall capture and provide at Mentor Graphics’ request. Customer shall make records available in
electronic format and shall fully cooperate with data gathering to support the license review. Mentor Graphics shall bear the expense of
any such review unless a material non-compliance is revealed. Mentor Graphics shall treat as confidential information all information
gained as a result of any request or review and shall only use or disclose such information as required by law or to enforce its rights
under this Agreement. The provisions of this Section 15 shall survive the termination of this Agreement.

16. CONTROLLING LAW, JURISDICTION AND DISPUTE RESOLUTION. The owners of certain Mentor Graphics intellectual
property licensed under this Agreement are located in Ireland and the U.S. To promote consistency around the world, disputes shall be
resolved as follows: excluding conflict of laws rules, this Agreement shall be governed by and construed under the laws of the State of
Oregon, U.S., if Customer is located in North or South America, and the laws of Ireland if Customer is located outside of North or
South America or Japan, and the laws of Japan if Customer is located in Japan. All disputes arising out of or in relation to this
Agreement shall be submitted to the exclusive jurisdiction of the courts of Portland, Oregon when the laws of Oregon apply, or Dublin,
Ireland when the laws of Ireland apply, or the Tokyo District Court when the laws of Japan apply. Notwithstanding the foregoing, all
disputes in Asia (excluding Japan) arising out of or in relation to this Agreement shall be resolved by arbitration in Singapore before a
single arbitrator to be appointed by the chairman of the Singapore International Arbitration Centre (“SIAC”) to be conducted in the
English language, in accordance with the Arbitration Rules of the SIAC in effect at the time of the dispute, which rules are deemed to be
incorporated by reference in this section. Nothing in this section shall restrict Mentor Graphics’ right to bring an action (including for
example a motion for injunctive relief) against Customer in the jurisdiction where Customer’s place of business is located. The United
Nations Convention on Contracts for the International Sale of Goods does not apply to this Agreement.

17. SEVERABILITY. If any provision of this Agreement is held by a court of competent jurisdiction to be void, invalid, unenforceable or
illegal, such provision shall be severed from this Agreement and the remaining provisions will remain in full force and effect.

18. MISCELLANEOUS. This Agreement contains the parties’ entire understanding relating to its subject matter and supersedes all prior
or contemporaneous agreements. Any translation of this Agreement is provided to comply with local legal requirements only. In the
event of a dispute between the English and any non-English versions, the English version of this Agreement shall govern to the extent
not prohibited by local law in the applicable jurisdiction. This Agreement may only be modified in writing, signed by an authorized
representative of each party. Waiver of terms or excuse of breach must be in writing and shall not constitute subsequent consent, waiver
or excuse.
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